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About This Document

This documentation describes how you can use the BEA E-Business Control CenterTM 
to create personalized Web sites for your valued e-business customers. The features of 
the E-Business Control Center that are available to you (as well as the corresponding 
help topics for these features) are determined at run time by the type of license you 
purchased. For details, please see “About the E-Business Control Center” on page 1-2.

This document includes the following topics:

n Chapter 1, “Introduction to the BEA E-Business Control Center,” introduces you 
to the capabilities of the E-Business Control Center and highlights some 
important points about its use. It provides information about the specific 
e-business roles and responsibilities this tool is intended to support, and indicates 
the recommended method for traversing the rest of the documentation.

n Chapter 2, “Building Conditions and Queries in the BEA E-Business Control 
Center,” is a central point of reference for information about building conditions 
and queries in the E-Business Control Center. The sections in this topic are not 
meant to be read in sequence, but rather, are pieces of information or 
instructions that you will use in the context of other tasks.

n Chapter 3, “Creating and Managing Property Sets,” describes how to better 
personalize content by setting up properties in the E-Business Control Center.

n Chapter 4, “Using Customer Segments to Target High-Value Markets,” contains 
basic information about customer segments as they are used in the E-Business 
Control Center, including a conceptual description, an explanation about how 
you might want to use customer segments, and step-by-step instructions for 
creating new customer segments.

n Chapter 5, “Retrieving Documents with Content Selectors,” describes how you 
can use content selectors to specify the conditions under which WebLogic 
Personalization Server retrieves one or more documents from your content 
management system.



xvi Guide to Using the BEA E-Business Control Center

n Chapter 6, “Displaying Ads,” explains how you can use ad placeholders to 
display ads and to manage and evaluate the effectiveness of your advertising 
strategy.

n Chapter 7, “Defining Stand-Alone or Campaign Discounts,” contains basic 
information about discounts as they are used in the E-Business Control Center. 
This information includes a conceptual description of a discount, an explanation 
about how you might want to use discounts, and step-by-step instructions for 
defining a new discount or modifying existing discounts within the E-Business 
Control Center.

n Chapter 8, “Discount Examples,” is a supplement to the previous chapter. It 
contains real-world examples in discounts, ranging from the simple to the 
complex.

n Chapter 9, “Roadmap for Creating Promotional Campaigns,” describes the 
high-level process or roadmap you should follow when creating a new 
promotional campaign in the E-Business Control Center.

n Chapter 10, “Creating and Managing Promotional Campaigns,”” contains 
step-by-step information for defining a new campaign or modifying existing 
campaigns within the E-Business Control Center.

n Chapter 11, “Webflow Components and Concepts,” provides an overview of 
Webflow concepts and describes components used in Webflow.

n Chapter 12, “Using the Webflow and Pipeline Editors,” provides procedures for 
using the Webflow and Pipeline editors in the E-Business Control Center.

n Chapter 13, “Using the E-Business Control Center Portal Tool,” describes how 
to configure your portals and portlets, and determine which users have access to 
specific portal content.
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What You Need to Know

This help is intended for use by business analysts or marketing professionals who use 
the E-Business Control Center to personalize their e-business Web site, and for 
business engineers who provide the infrastructure to support the E-Business Control 
Center. For more information on each of these roles, see “Roles and Responsibilities” 
on page 1-8.

e-docs Web Site

BEA product documentation is available on the BEA corporate Web site. From the 
BEA Home page, click on Product Documentation or go directly to the “e-docs” 
Product Documentation page at http://e-docs.bea.com.

Note: The contents of this document as provided on the “e-docs” Web site may be 
updated periodically with new information or corrections that may not yet be 
available in the corresponding online help system.

How to Print the Document

You can print a copy of this document from a Web browser, one file at a time, by using 
the File→Print option on your Web browser.

A PDF version of this document is available on the WebLogic Portal documentation 
Home page on the e-docs Web site. A PDF version of this document is also available 
in the documentation kit on the product CD. Or you can download the documentation 
kit from the WebLogic Portal portion of the BEA Download site. You can open the 
PDF in Adobe Acrobat Reader and print the entire document (or a portion of it) in book 
format. To access the PDFs, open the E-Business Control Center documentation Home 
page, click the PDF files button and select the document you want to print.
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If you do not have the Adobe Acrobat Reader, you can get it for free from the Adobe 
Web site at http://www.adobe.com.

Related Information

For more information about the technical tasks involved in maintaining the E-Business 
Control Center infrastructure, see the Developing Campaign Infrastructure 
documentation at http://edocs.bea.com/wlp/docs40/campdev/index.htm.

For information about how the E-Business Control Center works with a Web site to 
personalize the customer experience, see the following documentation:

n Strategies for Developing E-Business Web Sites at 
http://edocs.bea.com/wlp/docs40/strategs/index.htm.

n Personalization Examples at 
http://edocs.bea.com/wlp/docs40/interm/p13nexam.htm.

n JSP Commerce and Campaign Tour at 
http://edocs.bea.com/wlp/docs40/cstour/index.htm.

n Guide to Events and Behavior Tracking at 
http://edocs.bea.com/wlp/docs40/events/index.htm.

n Guide to Managing Presentation and Business Logic: Using Webflow and 
Pipeline at http://edocs.bea.com/wlp/docs40/wflopipe/index.htm.

n Guide to Building Personalized Applications at 
http://edocs.bea.com/wlp/docs40/p13ndev/index.htm.

n Guide to Building a Product Catalog at 
http://edocs.bea.com/wlp/docs40/catalog/index.htm.
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Contact Us!

Your feedback on the BEA E-Business Control Center documentation is important to 
us. Send us e-mail at docsupport@bea.com if you have questions or comments. Your 
comments will be reviewed directly by the BEA professionals who create and update 
the E-Business Control Center documentation.

In your e-mail message, please indicate that you are using the documentation for the 
BEA E-Business Control Center 4.0 release.

If you have any questions about this version of BEA E-Business Control Center, or if 
you have problems installing and running BEA E-Business Control Center, contact 
BEA Customer Support through BEA WebSUPPORT at www.bea.com. You can also 
contact Customer Support by using the contact information provided on the Customer 
Support Card, which is included in the product package.

When contacting Customer Support, be prepared to provide the following information:

n Your name, e-mail address, phone number, and fax number

n Your company name and company address

n Your machine type and authorization codes

n The name and version of the product you are using

n A description of the problem and the content of pertinent error messages

Documentation Conventions

The following documentation conventions are used throughout this document.

Convention Item

boldface text Indicates terms defined in the glossary.

Ctrl+Tab Indicates that you must press two or more keys simultaneously.
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italics Indicates emphasis or book titles.

monospace 
text

Indicates code samples, commands and their options, data structures and 
their members, data types, directories, and filenames and their extensions. 
Monospace text also indicates text that you must enter from the keyboard.

Examples:

#include <iostream.h> void main ( ) the pointer psz

chmod u+w *

\tux\data\ap

.doc

tux.doc

BITMAP

float

monospace 
boldface 
text

Identifies significant words in code.

Example:

void commit ( )

monospace 
italic 
text

Identifies variables in code.

Example:

String expr

UPPERCASE 
TEXT

Indicates device names, environment variables, and logical operators.

Examples:

LPT1

SIGNON

OR

{ } Indicates a set of choices in a syntax line. The braces themselves should 
never be typed.

[ ] Indicates optional items in a syntax line. The brackets themselves should 
never be typed.

Example:

buildobjclient [-v] [-o name ] [-f file-list]... 
[-l file-list]...

Convention Item
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| Separates mutually exclusive choices in a syntax line. The symbol itself 
should never be typed.

... Indicates one of the following in a command line: 

n That an argument can be repeated several times in a command line

n That the statement omits additional optional arguments

n That you can enter additional parameters, values, or other information

The ellipsis itself should never be typed.

Example:

buildobjclient [-v] [-o name ] [-f file-list]... 
[-l file-list]...

.

.

.

Indicates the omission of items from a code example or from a syntax line. 
The vertical ellipsis itself should never be typed.

Convention Item
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CHAPTER

1 Introduction to the BEA 
E-Business Control 
Center

The BEA E-Business Control Center is a tool designed to simplify the tasks that are 
necessary to create and maintain a truly personalized Web site. Building upon the 
functionality of the WebLogic Portal server and the WebLogic Personalization Server 
products that may already support your e-business, the E-Business Control Center can 
make business analysts and marketing professionals in your organization more 
self-sufficient, thereby minimizing the need for collaboration with busy technical 
resources. And even when collaboration is required for more specialized or advanced 
tasks, this collaboration may take significantly less time and be more efficient overall.

To meet this objective, the E-Business Control Center guides users through a variety 
of tasks, ensuring that both business and technical staff members can focus on the 
aspects of e-business management that are relevant to their role in the organization. 
The E-Business Control Center’s intuitive graphical user interface empowers people 
in these diverse roles, allowing them to provide exceptional value to their online 
customers and to effectively nurture customer relationships.

This topic is intended to introduce you to the capabilities of the E-Business Control 
Center and highlight some important points about its use. It provides information about 
the specific e-business roles and responsibilities this tool is intended to support. This 
topic includes the following sections:

n About the E-Business Control Center

l About the E-Business Control Center Interface

l What the E-Business Control Center Provides
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l Roles and Responsibilities

l Establishing Organizational Policies

l Recommended Reading

l Additional Resources

n Using the E-Business Control Center

l Starting the E-Business Control Center

l Working with Application Data

l Connecting to the Server

l Modifying Connections

l Advanced Connection Settings

l Working with Files

l Working with E-Business Control Center Windows

l Synchronizing Application Data

l Error Logs

The variable EBCC_HOME refers to your E-Business Control Center directory. By 
default on installation, this directory is called ebcc4.0.

Note: If you are viewing this guide in the online help system for the E-Business 
Control Center, only the help topics of the tools for which you are licensed are 
included. For the full version of this guide, go to the BEA e-docs Web site: 
http://e-docs.bea.com/wlp/docs40.

Links in the online help system that are not underlined launch a browser to 
jump to documents on BEA’s e-docs Web site.

About the E-Business Control Center

As shown in Figure 1-1, the E-Business Control Center is an e-business tool built upon 
the BEA products your organization’s technical professionals know and trust to 
support their e-commerce Web development efforts. Whether your company uses 
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WebLogic Personalization Server or WebLogic Portal, the E-Business Control Center 
can make expanding and maintaining your online customer relationships easier and 
less time consuming.

Figure 1-1   WebLogic Portal Features

In the Personalization-only configuration, the E-Business Control Center exists in a 
simplified form, while still providing you with the utilities needed to display 
customized content and control Webflow. The WebLogic Portal product gives you 
access to even more features in the E-Business Control Center, such as portal and 
portlet configuration, discounts, and promotional campaigns. The information 
provided in the following section will help you to understand what features are 
available in each version of the E-Business Control Center, and how these features can 
help you achieve your e-business goals.

The E-Business Control Center is a tool for just about everyone in the enterprise 
application development process, from the business analyst creating customer 
characteristics to the developer working with portals and Webflow. For more details 
about roles, see “Roles and Responsibilities” on page 1-8.

Note: For more information about WebLogic Personalization Server and WebLogic 
Portal, see the Strategies for Developing E-Business Web Sites at 
http://edocs.bea.com/wlp/docs40/strategs/index.htm.
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About the E-Business Control Center Interface

Figure 1-2 shows the different parts of the E-Business Control Center.

Figure 1-2   The E-Business Control Center

The tools available in the E-Business Control Center appear in the Explorer window. 
Tools are separated by the three tabs at the bottom of the window. The Editor window 
appears when you open a file.

For more information on applications that are valid for deployment, see 
“Synchronizing Application Data” on page 1-33.
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Icons that Show Status

File icons in the Explorer window can take on different appearances depending on the 
status of the files. Table 1-1 shows and describes the variations you might see on the 
standard icons.

What the E-Business Control Center Provides

No matter which version of the E-Business Control Center your organization uses, the 
E-Business Control Center’s rich feature set is sure to provide you with the tools you 
need to effectively personalize your e-business. This section will help you understand 
which E-Business Control Center features are available in your version of the product, 
and describes some of the E-Business Control Center features that are available in all 
versions of the tool to help you get started.

Table 1-1  Icons that show status

Icon Description

File icons with a crossed-out pencil next to them are set to read-only 
on your file system.

File icons with a half-filled square next to them signify files that are 
missing data.

Deactivated campaign.

Discount marked as Finalized. This discount cannot be modified to 
change the terms of the discount customer have already been given.

Deactivated discount marked as Finalized.

Pre-defined event shipped with the E-Business Control Center. 
These events cannot be modified, because other areas of the 
E-Business Control Center rely on those pre-defined events.
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WebLogic Personalization Server 4.0 Customers

WebLogic Personalization Server customers can:

n Control Webflow. The Webflow tool lets you specify the order in which pages 
are displayed to your Web site’s visitors, and it calls predefined, specialized 
components to execute back-end business logic.

n Track customer behavior (events). Understanding your customers is the first 
step to providing them with a truly personalized Web experience. The 
E-Business Control Center makes use of behind-the-scenes behavior tracking 
functionality, allowing you to leverage customers’ most frequent interactions 
with your e-business Web site when determining how to personalize site content. 
Customer behaviors, or events, that are tracked range from viewing content to 
clicking through hyperlinks. Your technical staff can also help you add your own 
custom events.

n Define customer segments. Although an e-business audience may be diverse, 
there are often many similarities among customers that you can leverage to more 
effectively customize your Web site. The E-Business Control Center allows you 
to organize customers into groups, or customer segments, based on common 
characteristics. Customer segments may then be used to support your 
organization’s strategic e-business goals.

n Create placeholders for ad display. To satisfy your customers’ diverse needs, 
you may want to change single pieces of content on your Web sites, such as ad 
banners, on a regular basis. In the past, even a simple modification like changing 
an ad banner required the assistance of a Web developer. Now, with WebLogic 
Personalization Server or WebLogic Portal, you can add what is called a 
“placeholder” to a specific region on a Web page. In the E-Business Control 
Center, you add queries to a placeholder that automatically retrieve, choose, and 
display a single, targeted piece of content in that region of the Web page. Each 
time visitors view a page containing a placeholder, they may see a different 
piece of targeted content in the placeholder, depending on the priorities you have 
set on the queries and the ads. You don’t need any specialized Web development 
knowledge to create placeholders. Placeholders also provide the important 
e-commerce capability of letting you capture the number of times ads are 
displayed by a placeholder (ad impressions) and the number of times visitors 
click ads displayed by a placeholder (clickthroughs).

n Target customers with personalized content. Even after you have collected 
some information about your customers, analyzed the data, created placeholders 
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in your Web pages, and organized customers into segments, you may decide that 
frequent manual updates to your Web site content based on these factors is not 
enough. Content selectors in the E-Business Control Center let you dynamically 
match Web content to customers in real time, based on events that occur when 
someone visits a Web site, customer characteristics that are most often stored in 
user profiles, or dates and times. Once the content selectors are set up in the 
E-Business Control Center and your JSP developer writes the code that 
determines how the content will be displayed in the Web page, your Web site 
will automatically target customers with personalized content.

WebLogic Portal 4.0 Customers

In addition to the Personalization Server features, WebLogic Portal customers can:

n Configure Portals, Portlets, and Entitlement Segments. The portal, portlet, 
and entitlement segment tools let you configure your portals and determine 
which users have access to specific portal content. The portal tool lets you 
determine elements such as layout, skins, pages used in the portal, and the 
portlets that are part of the portal. The portlet tool lets you specify URLs to 
content, select Webflow, and configure other aspects of portlets. The entitlement 
segments tool lets you determine which users or groups see specific portal 
content.

n Define stand-alone discounts. As part of a marketing effort, you might want to 
temporarily give all your customers a discount on particular items in your 
product catalog. Using the E-Business Control Center, you can define 
stand-alone discounts by specifying the percentage or dollar amount off, whether 
the discount applies on a per-item, set-based, or per-order basis, the products to 
which the discount applies, and so on. If a customer purchases multiple items 
and is likely to qualify for more than one discount, the priority you associate 
with each discount can help resolve any conflicts and ensure that customers 
receive the discount(s) you intend.

n Define campaign discounts. Campaign discounts, which are available only if 
you use WebLogic Portal, are similar to stand-alone discounts with one 
exception: They are specifically designed for use within promotional campaigns. 
In other words, campaign discounts are discounts that are not offered to all your 
e-business customers, but only those who belong to a particular customer 
segment, who exhibit particular browsing behaviors, or meet other predefined 
criteria. With the E-Business Control Center, you can define campaign discounts 
and apply them in various ways to meet your targeted marketing objectives.
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n Execute and manage promotional campaigns. Using predefined customer 
segments, tracked customer behaviors, and previously established campaign 
discounts, you can create, execute, and maintain powerful promotional 
campaigns with the E-Business Control Center. Display an ad in a highly visible 
placeholder on your home page to customers who show interest in new products, 
or send a promotional e-mail with a special discount to entice browsing visitors 
to buy. You can execute these actions based on the segment to which a customer 
belongs, based on the customer’s behavior on your Web site, or on a number of 
other conditions. Alternatively, there may be times when you want to select 
customers at random to pilot test a new marketing strategy. With the E-Business 
Control Center, you can combine these campaign-specific features to meet all 
your promotional needs.

n Monitor and report campaign results. While your promotions are in action, 
use Events and Behavior Tracking to monitor and qualify promotional campaign 
results. After your campaign has ended, produce reports that allow you to share 
the success of your e-business strategies with other interested parties in your 
organization.

Roles and Responsibilities

The E-Business Control Center was designed specifically to help business analysts, 
marketing professionals, and other non-technical professionals implement customized 
e-business strategies that will capture and maintain sizable online audiences. Because 
a business analyst’s strength is in conceiving effective models for e-business, the tools 
you use should allow you to execute these strategies easily, without worrying about 
technical details or becoming overly dependent on technical resources.

The E-Business Control Center does not require you to have intricate knowledge about 
how a Web site is implemented. Rather, the E-Business Control Center allows you to 
remain in control of all your e-business efforts, including the creation and modification 
of promotional campaigns, through an intuitive graphical interface.

Although a business analyst’s reliance on technical resources is greatly reduced when 
using the E-Business Control Center, some degree of collaboration with your 
organization’s technical staff may still be necessary to fully personalize your 
customers’ experience. The E-Business Control Center provides many out-of-the-box 
components that you can use to meet your business objectives. However, you may 
develop a new e-business strategy that leverages the power of BEA technology but 
does not surface in the E-Business Control Center tool. It is during these times that you 
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may need to work with a technical resource in your organization to establish a 
supporting infrastructure. Once this is done, however, you can reuse the new 
components like you would any other in the E-Business Control Center.

Business Analysts will most likely collaborate with more technical resources who 
may:

n Manage the operations of major pieces of the Web site, or the entire site itself.

n Coordinate major and minor change processes.

n Be an active participant in overall business effectiveness monitoring and system 
performance monitoring.

n Be responsible for major, structural updates to an e-business Web site, for 
management of user profiles, user permissions, and so on.

n Perform many behind-the-scenes programming tasks that keep a Web site 
functioning.

Therefore, when you require additional support for the E-Business Control Center, you 
would typically contact a person (or a group of people) who fill the business engineer 
role described previously.

For more detailed information about how a business engineer accomplishes 
campaign-related programming tasks, see the Guide to Developing Campaign 
Infrastructure.

Establishing Organizational Policies

Much of the data in the E-Business Control Center is stored in XML files and modified 
on individual client systems. When synchronized to your server, that data determines 
the rules and behavior of your enterprise application.

Warning: When multiple developers work concurrently on a single set of source 
files and business documents, they can overwrite each others’ work or 
create sets of changes that are incompatible and difficult to debug when 
they synchronize their data to the WebLogic Portal server.

We highly recommend using content management or version control software to 
control user access to files and provide a file revision history. Also, since such software 
usually stores data on a single server, your system administrator can back up that data. 
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There are many issues involved with authoring and deploying your enterprise 
application to go live. To help save you time, effort, and money, and to help prevent 
you from making mistakes that negatively affect your Web presence, read about these 
issues in the Deployment Guide.

To facilitate concurrent development, we recommend the following model:

n Use a content management or source-control system to synchronize the separate 
development environments, control access to files, and maintain a history of 
changes.

n Organize your development tasks into discrete units. For example, one task is 
creating a promotional campaign and another is modifying the flow of data 
through the Web site (Webflow).

n Use a separate installation of the E-Business Control Center for each 
development task.

n For each installation of the E-Business Control Center, deploy an instance of 
your enterprise application under a unique name.

It is extremely important that your organization develop some policies about who owns 
objects like customer segments, placeholders, events, campaigns, and so on. 
Ownership of objects is critical when it comes to modifying information that may be 
in broad use. For example, if a customer segment is created by one user, it is very 
possible that other users may begin to use the segment (perhaps unbeknownst to the 
original author). If the author later changes the segment definition, many people are 
going to be affected. So, it is also highly recommended that your organizational 
policies identify which objects others can use, which are more proprietary or “use at 
your own risk,” and so on.

Recommended Reading

After you have reviewed this introduction, you can take a number of paths through the 
documentation, depending upon your goals. 
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WebLogic Portal 4.0 Customers

If you are a WebLogic Portal customer, review the conceptual explanations in all 
chapters of this guide. If you are going to develop campaigns, pay particular attention 
to the “Roadmap for Creating Promotional Campaigns” before getting started. This 
topic should contain all the information you need to know before moving on to the 
step-by-step instructions that will guide you through campaign implementation.

Note: The importance of planning can never be overstated, so resist skipping the 
Roadmap discussion! Carefully thinking about and designing a detailed 
marketing strategy ensures that you have (at the very minimum) the 
information you will need to begin implementing your campaigns in the 
E-Business Control Center. In addition, up-front planning can help you 
identify areas where your strategy may be unclear, possibly preventing you 
from running into problems down the road that require both time and effort to 
resolve. Naturally, such problems can delay the release of a promotional 
campaign, thus affecting your ability to provide the valuable services your 
online customers expect.

WebLogic Personalization Server 4.0 Customers

If you have the Personalization-only version of the E-Business Control Center, you 
should review at least the conceptual explanations in the following chapters:

n “Creating and Managing Property Sets”

n “Using Customer Segments to Target High-Value Markets”

n “Retrieving Documents with Content Selectors”

n “Displaying Ads”

n “Webflow Components and Concepts”

n “Using the Webflow and Pipeline Editors”

Additional Resources

In addition to this guide, the following resources will also help you understand and use 
the E-Business Control Center.
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BEA E-Marketing Fieldbook

The goal of the BEA E-Marketing Fieldbook is to help you architect a strategy for 
e-business success. This document weaves together a breadth of fundamental 
e-business best practices with practical recommendations for how to implement your 
BEA customer management platform and other technologies to achieve maximum 
value from your customer relationships.

The Fieldbook contains content ranging from Marketing 101 concepts to leading-edge, 
technology driven marketing strategies. By covering a range of topics, the Fieldbook 
addresses the diverse needs of organizations with varied levels of marketing 
sophistication, while also conveying the importance of building e-business success 
through a solid foundation of marketing basics. 

Fieldbook topics center around traditional functional marketing roles to enable 
individual contributors within your organization to quickly find the content that 
applies to their responsibilities. Although written for marketers and business 
managers, the Fieldbook still covers an array of technical issues, focusing on 
utilization of technology to drive business objectives.

The BEA E-Marketing Fieldbook is available on the BEA e-docs product 
documentation Web site: http://e-docs.bea.com/wlp/docs40/interm/pdf.htm.

Sample Applications and Product Tours

To help you understand the interactions taking place between the E-Business Control 
Center tool and your Web site or Portal, the documentation also contains two tours that 
walk you through the features highlighted in the sample applications:

n The Personalization Examples demonstrate the personalization services provided 
by the WebLogic Personalization Server.

n The JSP Commerce and Campaign Tour leads you through many of the Web 
pages provided as part of the sample storefront application, demonstrating how 
these templates work and illustrating the scope of campaign-related features that 
are available.

For more information about these product tours, see the BEA e-docs product 
documentation Web site: http://edocs.bea.com/wlp/docs40/index.html.
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Online Help

At any time, you can access the E-Business Control Center’s built-in online help 
system to select from a list of available topics or to search for a particular topic. The 
help system contains both step-by-step directions and specific recommendations about 
how to get the most out of the E-Business Control Center’s capabilities for your 
e-business efforts.

The contents of this help system are also provided on the BEA e-docs product 
documentation Web site: http://e-docs.bea.com/wlp/docs40 (in both HTML and PDF 
formats), and is updated as new information is added or corrections are made.

Tip: If the online help text runs past the right side of the help window,

Using the E-Business Control Center

This section provides an overview of the E-Business Control Center and shows you 
how to perform tasks that are common to all tools in the E-Business Control Center.

Note: While the E-Business Control Center may run successfully at lower monitor 
resolutions, we recommend a monitor resolution setting of 1024 by 768.

Starting the E-Business Control Center

If you feel comfortable with the materials previously described, you are ready to use 
the E-Business Control Center. To start the E-Business Control Center:

Windows: Selecting Start → Programs → BEA WebLogic E-Business Platform → 
BEA E-Business Control Center 4.0 → E-Business Control Center.

For a full view of the E-Business Control Center, see Figure 1-2.

If you don’t see the Explorer window along the left side of the E-Business Control 
Center, click the Open Explorer button in the main toolbar, as shown in Figure 1-3.
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Figure 1-3   Opening the Explorer Window

Working with Application Data

The E-Business Control Center lets you develop the data that controls the behavior of 
your enterprise applications. In the E-Business Control Center, data files for an 
enterprise application are stored in a specific directory structure. This structure, for 
example, contains directories for storing the Segments, Placeholders, Webflow, and so 
on, that an enterprise application will use when the data is synchronized to the server.

There are many issues involved in creating and maintaining application data, 
especially if multiple developers will work on a single application, or the data files will 
be stored in a content management or version control system (which we recommend). 
For more information about the issues involved with maintaining application data, see 
“Establishing Organizational Policies” on page 1-9 and the Deployment Guide.

The following sections provide tasks for and information about working with 
application data in the E-Business Control Center.

Creating an Application Structure for E-Business Control Center Data

The data files in the E-Business Control Center must reside in a specific directory 
structure. This procedure shows you how to create that structure for an application in 
the E-Business Control Center.

If you want to view an existing application before creating a new one, you can open 
the sample application that comes with the E-Business Control Center. See “Opening 
Application Data.”

To create an application structure for E-Business Control Center data:

1. Choose File → New Application in the menu.
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2. In the New Application window, select the folder under which you want to create 
the application structure.

For example, to make the application a subfolder of the 
EBCC_HOME\applications folder, select the EBCC_HOME\applications folder.

You can create the application structure anywhere you like.

3. In the New Directory field at the bottom of the window, enter the name of the 
application.

Note: Even though the application structure supports a specific enterprise 
application, you can name the E-Business Control Center application 
directory whatever you like. This directory name simply serves as a 
container for the structured subfolders that are automatically created in this 
procedure. The way the data in this application structure is ultimately sent 
to its enterprise application is determined by the connection settings to the 
server. See “Connecting to the Server” on page 1-19.

4. Click Create.

The application structure is built automatically, and you can begin using the 
E-Business Control Center to configure the enterprise application.

Note: When you create a new application structure, a default 
webflow-extensions.wfx file is placed in the application’s 
default\webflow subfolder. This file contains the default Webflow 
extensions that will be used for any Web application you add to the 
application’s structure (see “Creating a Web Application Folder for an 
Enterprise Application” on page 1-18).

If you customize the webflow-extensions.wfx file in the 
default\webflow subfolder, any Web application folder you add afterwards 
will contain the customized Webflow extensions.

Opening Application Data

To begin using the E-Business Control Center, you must open application data. When 
you open application data, all of that application’s data is loaded into the E-Business 
Control Center, where you can modify, add to, remove, or synchronize that data.
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Note: The E-Business Control Center is installed with the following sample 
applications, located in the EBCC_HOME\applications folder: p13nApp, 
petflowApp, portal, and wlcsApp. Each contains different types of data.

To open an application:

1. If you are using a content management or version control system, check out the 
files for the application you want to open.

2. In the menu, choose File → Open Application.

3. In the Open Application window, locate and single-click the application folder.

For example, to open the wlcsApp sample application, single-click the 
EBCC_HOME\applications\wlcsApp folder.

4. Click Open.

Data for the application is loaded into the E-Business Control Center.

When an application is loaded, you can select a tool icon in the Explorer window and 
see its files, as shown in Figure 1-4.

Figure 1-4   With an application open, click a tool icon to see its files

Each time you launch the E-Business Control Center, the last application you had open 
is loaded automatically.
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Directory Structure of an Application

A valid application—one you can open in the E-Business Control Center—has a 
specific directory structure with specific directory names, as shown in Figure 1-5.

Figure 1-5   Directory structure for a valid application

You can name the application (wlcsApp in this example), the webapps (tools, and 
wlcs in this example), and the subfolders of layouts and skins whatever you like 
(subject to standard naming restrictions). The directory structure and the rest of the 
directory names must match Figure 1-5 for you to be able to open the application in the 
E-Business Control Center.

The default\webflow folder contains a file called webflow-extensions.wfx that 
you can use to customize your default extensions for Webflow. For more information, 
see “Creating a Web Application Folder for an Enterprise Application” on page 1-18.

To ensure that you create the correct directory structure for an application, see 
“Creating an Application Structure for E-Business Control Center Data” on page 1-14.
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About the Sample Applications

The sample applications that come with the E-Business Control Center, located in the 
EBCC_HOME\applications folder, contain files for each tool in the E-Business 
Control Center. You can open these files to get a better idea of how each tool works. 
See “Opening Files” on page 1-30 for more information.

Detailed information for working with each of the tools in the E-Business Control 
Center is contained throughout this guide.

Creating a Web Application Folder for an Enterprise Application

The Webflows/Pipelines tool in the E-Business Control Center is associated with 
specific Web applications within an enterprise application. Use this procedure to add 
a Web application directory to the structure of the enterprise application in the 
E-Business Control Center.

1. In the E-Business Control Center, open the application to which you want to add 
the Web application folder.

2. Choose File → New → Web Application in the menu.

3. In the New Web Application window, enter the exact name of a Web application 
that will either exist or that already exists on the server.

4. Click OK. The Web application folder is added as a subfolder of the webapps 
folder in the application directory structure (see Figure 1-5).

The webflow-extensions.wfx file in the application’s default\webflow 
subfolder is also copied to the new Web application folder.

Creating a Web Application Folder for Portal

For information on creating a Web application folder for Portal, see “Introducing 
WebLogic Portal” in the Getting Started with Portals and Portlets.
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Connecting to the Server

Although the majority of E-Business Control Center functionality does not require 
users to log in to a running WebLogic Portal server, some areas of the E-Business 
Control Center require you to log in to the server to view or use certain data. You must 
log in to the server to:

n Search for or preview ads in various windows

n Access property sets in various windows

n Use the Catalog Browser in various windows to select items in a catalog

n Select and preview e-mail content that will be sent out automatically as part of a 
promotional campaign

n Synchronize your application data to the server

The connection settings determine which enterprise application on the server the 
E-Business Control Center will be synchronized to. The E-Business Control Center 
Connection Settings tool makes it easy to set the necessary connections to the 
WebLogic Portal server. You only need to know a few pieces of information to set up 
connections: the name of your enterprise application, the name of the server running 
WebLogic Portal server, the port number, and the username and password. You can 
get this information from your system administrator.

If your organization uses more than one server—for purposes of backup or failover, or 
to store different types of data on different servers—you can set up a connection for 
each server.

Connections you set up are available for all applications you open in the E-Business 
Control Center.

To set up connections to the server:

When you first access a feature in the E-Business Control Center that requires a server 
connection, the Connection Setup window appears (Figure 1-6). (If you choose Tools 
→ Synchronize, the window is called Synchronization Setup.)
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Figure 1-6   The Connection Setup Window

To create a server connection to access the data:

1. In the Display Name field, type a new connection name.

2. In the Application Name field, enter the exact name of your enterprise 
application. The name is case sensitive. This is the enterprise application to 
which you will synchronize your E-Business Control Center data.

You can get the application name from your system administrator. Your system 
administrator can also provide your enterprise application name(s) in the 
Application Name drop-down list, and set a default application name to appear 
in that field automatically. See “Adding Application Names to the Application 
Name Drop-Down List” on page 1-26.

You can also select one of the sample application names from the drop-down list 
if you are working with and synchronizing to one of the sample applications.

3. In the Server field, enter http://<servername>:<port>, where <servername> 
is the name of the server that WebLogic Portal is running on, and the <port> is 
the server’s port number, such as 7501.

You can get this information from your system administrator.

4. Enter your username and password.
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The default username is system, and the default password is the password that 
was set during WebLogic Server installation. The username and password are set 
up and maintained in the Administration Tools. Users assigned to the 
Administrators group can use their own username and password. You only need 
to enter your username and password once per session.

5. Click Connect.

You are given access to the server-side data you are requesting, and the 
connection is added to the Connection Settings, described in “Modifying 
Connections,” where you can edit, delete, or select it for accessing data on the 
server.

When you create a connection to server-side data for the first time, the connection you 
establish is used for all data on the server listed at the beginning of this procedure. You 
will therefore be given automatic access to all other types of server-side data based on 
that connection.

If you want to use different connections for different types of data—for example, if you 
store campaign e-mail and ad content on a different server than other data, you can add 
connections with the Connection Settings tool and individually assign those 
connections to different types of server-side data. For more information, see 
“Modifying Connections.”

Modifying Connections

After you have established connections in the Connection Setup window when you 
access server-side data in the E-Business Control Center, you can modify those 
settings with the Connection Settings tool.

To modify existing connections:

1. In the E-Business Control Center, choose Tools → Connection Settings.

2. In the Connection Settings window, shown in Figure 1-7, click the Connections 
tab.
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Figure 1-7   Setting Connections to the Server

3. Select the connection you want to modify, and click Edit. If you want to create a 
new connection, click New.

4. In the Connection Details window (Figure 1-8), enter a name for the connection 
in the Display Name field.

Figure 1-8   Connection Details Window

5. In the Application Name field, enter the exact name of your enterprise 
application. The name is case sensitive. This is the enterprise application to 
which you will synchronize your E-Business Control Center data.

You can get the application name from your system administrator. Your system 
administrator can also provide your enterprise application name(s) in the 
Application Name drop-down list, and set a default application name to appear 
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in that field automatically. See “Adding Application Names to the Application 
Name Drop-Down List” on page 1-26.

You can also select one of the sample application names from the drop-down list 
if you are working with and synchronizing to one of the sample applications.

6. In the Server field, enter http://<servername>:<port>, where <servername> 
is the name of the server that WebLogic Portal is running on, and the <port> is 
the server’s port number, such as 7501.

You can get this information from your system administrator.

7. You should not have to click the Advanced button to modify the Uniform 
Resource Identifier (URI) paths to the server. Your system administrator should 
notify you if you ever need to modify these settings.

Note: For convenience, the name you enter/select in the Application Name field 
is automatically put at the beginning of each URI in the Advanced section 
of the window.

8. Click OK. The Connection Details window closes.

9. Create any remaining connections you need. Each connection can point to a 
different application, server, and port.

10. When you are finished creating connection, click the Associations tab in the 
Connection Settings window.

11. The connection selected in the All-Purpose Connection drop-down list is the 
single connection you will use to access the relevant data on the server from the 
E-Business Control Center (the types of data listed at the beginning of this 
procedure).

If you want to use different connections for different types of data, select the 
“Use independent connections for each task” option, and for each type of data 
listed in the window, select the appropriate connection.

For example, if your organization stores ad content and e-mail content on a 
separate server or port from the main development server or main port, you 
could select that connection in the Content Preview and E-mail Content fields, 
and select the development connection for the remaining fields.

12. Click OK.

After you set up your connections, you are prompted for your username and password. 
You only need to enter your username and password once per session.
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The default username is system, and the default password is the password that was set 
during WebLogic Server installation. The username and password are set up and 
maintained in the Administration Tools. Users assigned to the Administrators group 
can use their own username and password.

If for some reason you are ever presented with the Connection Setup window again, 
select an existing connection from the Display Name field, enter your username and 
password if necessary, and click Connect.

Advanced Connection Settings

The following sections provide instructions for system administrators to help make the 
connection-setting process easier and more error-free for E-Business Control Center 
users.

Changing the Default Connection Setting URIs

When users set up connection settings to access server-side data and to synchronize 
E-Business Control Center data to the server, they use the Connection Settings and 
Connection Details windows, shown in Figure 1-7 and Figure 1-8.

In the Connection Details window, there is an Advanced button that displays the URIs 
to the enterprise application selected in the Application Name field, as shown in 
Figure 1-9.
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Figure 1-9   Connection URIs

If your organization has modified the default locations of the server-side data, your 
system administrator can modify the URIs that automatically appear in the Connection 
Details window so that users do not have to modify these settings. To change the 
default URIs, follow this procedure.

1. Make a backup of the config.xml file, located in the EBCC_HOME\bin directory, 
in case you need to revert to the original after you modify it.

2. Open the config.xml file.

3. There are five services you can override. The names of these services appear as 
attributes in the <connection> element.

The services are: adsearch, catalogbrowser, datasync, emailcontent, and 
propertyset.

4. To override any of these default settings, add them as attributes to the 
<DefaultSupportServiceURIs/> element.

For example, to override the adsearch service so that the E-Business Control 
Center points to ad data for a summer campaign, modify the 
<DefaultSupportServiceURIs/> element so it looks like this:

<DefaultSupportServiceURIs
 adsearch="CampaignTool/SummerCampaignWS” />

Note: The new URI you create is always automatically prepended by the name 
of the application selected in the Application Name field. For example, 
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using the previous example change 
(adsearch="CampaignTool/SummerCampaignWS”), if a user has 
selected portal in the Application Name field of the Connection Details 
window, the following URI will be displayed in Ad Search field in the 
Advanced section of the Connection details window:

/portalCampaignTool/SummerCampaignWS

5. Save and close the config.xml file.

If you do not close the file, users will not be able to access the updated URIs.

6. Tell your E-Business Control Center users to restart the E-Business Control 
Center edit each connection by clicking the Restore Defaults button in the 
Advanced section of the Connection Details window (Figure 1-9).

To remove your URI overrides, remove any or all of the attributes you added to the 
<DefaultSupportServiceURIs/> element, and have your users modify their 
connection settings by clicking the Restore Defaults button in the Advanced section of 
the Connection Details window.

Adding Application Names to the Application Name Drop-Down List

When E-Business Control Center users set up connections to the WebLogic Portal 
server, as described in “Connecting to the Server” on page 1-19, there is an Application 
Name field in which they enter the name of the enterprise application they are working 
with.

The system administrator can add application names to the Application Name 
drop-down list so that users can select them rather than typing them. This functionality 
eliminates two potential problems: it eliminates typing mistakes that result in server 
connection failures (because the name, which is case-sensitive, must exactly match the 
name of the enterprise application); and it eliminates support calls that the system 
administrator must field when typing mistakes cause server connection failures.

Figure 1-10 shows the Application Name drop-down list to which the system 
administrator can add application names.
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Figure 1-10   Application Name Drop-Down List

To add application names to the Application Name drop-down list:

1. Make a backup of the config.xml file, located in the EBCC_HOME\bin directory, 
in case you need to revert to the original after you modify it.

2. Open the config.xml file.

3. Within the <EnterpriseApps> element, add an <application> element that 
contains a name attribute whose value is the application name you want to appear 
in the drop-down list. You can also make an application name the default name 
that appears in the drop-down list by adding the attribute and value 
default=“true”.

The following example shows how you would add an enterprise application 
called “gromit” to the drop-down list and make it the default name.

<EnterpriseApps>

    <application name="gromit" default="true"/>

</EnterpriseApps>

4. Save and close the config.xml file.

If you do not close the file, users will not be able to see the new application in 
the drop-down list.

5. Have users restart the E-Business Control Center to see the new application name 
in the drop-down list.
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Working with Files

When you are working with tools in the E-Business Control Center (Portals, 
Campaigns, Placeholders, Webflows/Pipelines, and so on), all of your work is stored 
in XML files. When you have created all your E-Business Control Center files, you 
must synchronize those files to the WebLogic Portal server for those files to affect your 
enterprise application.

Files are stored in the application structure illustrated in Figure 1-5.

It is important to use a content management or version control system to store and 
maintain your E-Business Control Center data files, and it is important to have 
organizational policies for maintaining and synchronizing data. For more information, 
see “Establishing Organizational Policies” on page 1-9.

The following procedures show you how to create and maintain E-Business Control 
Center files.

Creating Files (Other than Webflow/Pipeline)

Use this procedure to create E-Business Control Center files of any type other than 
Webflow/Pipeline files. For instructions on creating Webflow/Pipeline files, see 
“Creating Webflow/Pipeline Files” on page 1-29.

1. In the Explorer window, select the tab containing the tool for which you want to 
create a new file.

2. In the Explorer toolbar, click the New button, and select the type of file you want 
to create.

If you are creating a Portal, select a Web application in the Select Web 
Application dialog box, and click OK.

The new files opens in an Editor window.

3. Edit the file.

The remainder of this guide contains details for working with each type of file.

4. Click the Save button in the main toolbar.

5. In the Save As window, name the file and click Save.
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The length of the filename can be between 1 and 64 characters. The name must 
start with either a letter or an underscore character (_). The only characters 
allowed in the rest of the name are letters, numbers, underscores, periods, and 
hyphens.

If you receive an error trying to save a file, make sure the file name contains valid 
characters, and make sure your directory structure is correct, as described in “Directory 
Structure of an Application” on page 1-17.

Creating a File by Duplicating an Existing File

To save editing steps required to create a file, you can create a file by duplicating an 
existing file. To do this:

1. Open the file you want to duplicate.

2. Choose File → Save As in the menu.

3. In the Save As window, enter the name of the new file, and click Save.

Creating Webflow/Pipeline Files

Use this procedure to create Webflow/Pipeline files in the E-Business Control Center. 
To create all other types of files in the E-Business Control Center, see “Creating Files 
(Other than Webflow/Pipeline)” on page 1-28.

1. In the Explorer window, select the Site Infrastructure tab, and click the 
Webflows/Pipelines icon.

2. In the Explorer toolbar, click the New button, and select Webflow/Pipeline.

3. In the dialog box that appears (see Figure 1-11), select the New Webflow option 
to create a new Webflow namespace or the New Pipeline option to create a new 
Pipeline.

a. If you select the New Webflow option, select the Web application to which you 
want to add a Webflow namespace, and enter a name for that namespace in the 
Namespace field.

b. If you select the New Pipeline option, select an existing namespace in the 
Namespace field, or type the name of a new namespace; then enter the name for 
the new Pipeline in the Pipeline Name field.
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The length of the filename can be between 1 and 64 characters. The name 
must start with either a letter or an underscore character (_). The only 
characters allowed in the rest of the name are letters, numbers, underscores, 
periods, and hyphens.

4. Click OK. The new item is added to the tree in the Explorer window, as shown in 
Figure 1-11, and an Editor window opens with the new file.

Figure 1-11   Where New Webflow Namespace and Pipeline Files Appear in the 
Explorer Window

Note: You must add a new Web application to the E-Business Control Center for the 
Web application to appear in the Webflows/Pipelines Explorer window tree. 
See “Creating a Web Application Folder for an Enterprise Application” on 
page 1-18.

For more information on Webflows and Pipelines, see “Webflow Components and 
Concepts” and “Using the Webflow Editor.”

Opening Files

To open a file, select the tool it belongs to in the Explorer window, and double-click 
the file in the list of files. The file opens in the Editor window.
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Saving Files

After you have created or modified a file, with that file active in the Editor window, 
click the Save button in the main toolbar. If you are saving a newly created file, enter 
the name of the file in the Save As dialog box, and click OK.

If you close the file or the Editor window before saving changes you have made, you 
are prompted to save your changes.

Note: If you receive an error trying to save a file, make sure the file name contains 
valid characters, and make sure your directory structure is correct, as described 
in “Directory Structure of an Application” on page 1-17.

Deleting Files

To delete a file, select it in the Explorer window and click the Delete button in the 
Explorer toolbar.

Renaming Files

You can rename a file by opening it, choosing File → Save As in the menu, and saving 
the file with the new name you want. If you no longer want the old file, delete it.

Filtering Files

You can filter the list of files in the Explorer window to show files with specific name 
characteristics.

1. Select a tool icon to list its files.

2. In the Filter field, enter a portion of a name that represents the names you want to 
view, and click the Filter button, as shown in Figure 1-12.

For example, if you want to list all files starting with the letter “R,” enter R in 
the filter field and press the Filter button. If you want to view campaigns that 
contain “tour” in the name, enter tour in the Filter field.

3. To view the full list again, click the Show All Objects button next to the Filter 
button.
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Figure 1-12   Filtering files

Working with E-Business Control Center Windows

This section provides tips for manipulating the windows in the E-Business Control 
Center.

Tips for Closing Windows and Tabs

Here are a few tips for closing windows and tabs in the E-Business Control Center:

n In the Editor window, clicking the close button in the upper right corner closes 
the entire window, not just the file you are currently viewing. You are prompted 
to save open files that have changed.

n To close an individual file, right-click its tab in the Editor window and choose 
Close.

n When you choose File → Close in the menu, the active tab of the active window 
closes. For example, if the Editor window is active, the active file closes.

n If you inadvertently close an Explorer window tab, restore the Explorer window 
by clicking the Open Explorer icon in the main toolbar.
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Organizing Tabs

You can move Explorer or Editor tabs among different windows by using the docking 
feature. Here is an illustration of one of the more practical uses of this feature: If you 
had four files (tabs) open in the Editor, and two files were related (a discount and the 
campaign that uses the discount, for example), you could dock the discount and 
campaign files into a separate window to better organize your workspace.

To dock a tab to another window:

1. Right-click the tab you want to dock into another window.

2. Choose Dock View Into, then select the type of window you want to dock the tab 
into.

If a file is the only open file in a window, it will not have a tab, and you cannot dock 
it into another window. A window must contain more than one file to display tabs.

Note: To restore the Explorer window to its default state of three tabs, click the Open 
Explorer button on the main toolbar.

Minimizing Windows

When you minimize an Editor window, it becomes an icon at the bottom of the 
E-Business Control Center window. To restore the Editor to full size, click the icon.

Synchronizing Application Data

Synchronizing application involves using the Tools → Synchronize option to move the 
application data files from your local system to your enterprise application server.

Warning: If you and other developers concurrently synchronize data to a single 
enterprise application, it is possible to overwrite each others’ work or 
create sets of changes that are incompatible and difficult to debug. To 
prevent this possibility, synchronize to separate instances of your 
application. For more information on how to set up your development 
environment, see “Milestone 4: Set Up a Development Site” in the 
Strategies for Developing E-Business Web Sites documentation.
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To synchronize, you must be connected to the server. See “Connecting to the Server” 
on page 1-19. Before you synchronize, you can also validate your E-Business Control 
Center data prior to synchronization to see if any files are incomplete (Tools → 
Validate Application). For procedures and information on validating and 
synchronizing data, see “Synchronizing Application Data” in the Deployment Guide.

Note: If files are open in the E-Business Control Center Editor window with unsaved 
changes when you synchronize, those unsaved changes are not synchronized. 
Changes must be saved to be synchronized.

Error Logs

To find out more—albeit cryptic—details about any errors you may have received 
using the E-Business Control Center, you can open two different error logs:

n EBCC_HOME\system\ide.log – shows information and errors related to the 
NetBeans integrated development environment (IDE)

n EBCC_HOME\tools.log – shows E-Business Control Center error messages

You may also be asked to provide these files for any customer support calls you make.

If you do not see the tools.log file in the EBCC_HOME directory, that probably means 
there have been no errors to generate the file.

Warning: The tools.log file only stores errors for the current session. If you start 
the E-Business Control Center, and you have errors in the tools.log file 
from the previous session, the next error you receive in the current session 
will wipe out those previous errors. If you want to save error messages for 
a session, copy and rename the tools.log file so you can access it later.
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CHAPTER

2 Building Conditions 
and Queries in the BEA 
E-Business Control 
Center

This topic is a central point of reference for information about building conditions and 
queries in the BEA E-Business Control Center. The topics in this section are not meant 
to be read in sequence, but rather, are pieces of information or instructions that you will 
use in the context of other tasks. These tasks may be used when defining customer 
segments, running a query for content selectors, or adding scenarios to your 
promotional campaigns. (Queries search your content management system for 
documents based on a set of criteria that you specify.)

This topic includes the following sections:

n Listing of the Available Conditions

l Important Note About Dates and Times

n Using the Select Customer Segments Window

n Using the Properties and Visitor Characteristics Windows

n Using the Select Events Window

n Using the Date/Time Entry Dialog Boxes

n Using the Quantity Selector or Currency Selector Dialog Boxes
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n Using the Select Operator Dialog Box

n Using the Select Product Categories/Items Windows

l Using the Catalog Browser

l Searching a Catalog

n Using the Enter a Range Dialog Box

n Constructing Queries

l Select a Document Property

l Describe Documents by Comparing the Property to a Value or Range of 
Values

l Describe Documents by Comparing the Property with the Properties of Other 
Objects

l Specify How to Handle Multiple Value Phrases and Descriptors

l Adding Property Sets to Drop-Down Lists

l Preview the Query Results

Listing of the Available Conditions

The E-Business Control Center provides you with a number of conditions you can use 
to customize your e-business efforts. Depending on what you are trying to accomplish 
in the E-Business Control Center, you may encounter some or all of the conditions 
described in Table 2-1.

Note: The shopping cart conditions are available only if your license includes 
Commerce services.
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Table 2-1  Descriptions of Conditions

Condition Description

The visitor is a member of a 
predefined customer segment

If the visitor to your Web site belongs to a predefined customer segment, 
execute the specified action.  For example, if the customer is a Gold 
Customer (customer segment), give the customer a 15% discount (action).

The visitor has specific 
characteristics

If a visitor’s characteristics are compared to values you specify and those 
comparisons evaluate to true, execute a specified action.  For example, if the 
customer’s salary (characteristic) is greater than or equal to (comparison) 
$50,000 (value), send the customer an e-mail (action).

The HTTP session has specific 
properties

If the HTTP session’s properties are compared to values you specify and 
those comparisons evaluate to true, execute a specified action. An HTTP 
session is information your organization may want to track about a visitor’s 
browsing session on the Web site. There are no properties for the HTTP 
session in the E-Business Control Center out-of-the-box.

An HTTP request has specific 
properties

If the HTTP request’s properties are compared to values you specify and 
those comparisons evaluate to true, execute a specified action. There are 
properties for the HTTP request in the E-Business Control Center 
out-of-the-box. 

An event has occurred If a specified event occurs, execute the specified action.  For example, if the 
customer has logged in (event), display an ad that matches their interests 
(action).  Events may be selected from a number of predefined event types.

An event has specific 
characteristics

If the event’s characteristics are compared to values you specify, and those 
comparisons evaluate to true, execute a specified action. For example, if a 
customer adds more than 5 items to their shopping cart (event), give the 
customer a 10% discount (action).

The date is If the current date is equal to the one you specify, execute a specified action. 
For example, if the date is equal to July 22, 2001, send customers an e-mail 
about an upcoming sale (action). The current date refers to the date at the 
point that the condition is evaluated for a given user visiting the Web site.

See “Important Note About Dates and Times” on page 2-5.

It is after a given date If the current date is after a date you specify, execute a specified action. For 
example, if the date is after December 18, 2000, offer customers a discount 
(action). The current date refers to the date at the point that the condition is 
evaluated for a given user visiting the Web site.

See “Important Note About Dates and Times” on page 2-5.
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It is after a given date and time If the current date and time is after a date and time you specify, execute a 
specified action. For example, if the date and time is after July 22, 2001 at 
3 p.m., send customers an e-mail about an upcoming sale (action). The 
current date and time refers to the date and time at the point that the 
condition is evaluated for a given user visiting the Web site.

See “Important Note About Dates and Times” on page 2-5.

It is between two times If the current time falls within a range of times you specify, execute a 
specified action. For example, if the time is between 3 p.m. and 5 p.m., offer 
customers a discount (action). The current time refers to the time at the 
point that the condition is evaluated for a given user visiting the Web site.

See “Important Note About Dates and Times” on page 2-5.

It is between two dates If the current date falls within a range of dates you specify, execute the 
specified action. For example, if the date is between December 18, 2000 and 
December 18, 2001, show customers a sale ad (action). The current date 
refers to the date at the point that the condition is evaluated for a given user 
visiting the Web site.

See “Important Note About Dates and Times” on page 2-5.

It is between two dates/times If the current date and time fall within a range of dates and times you 
specify, execute the specified action. For example, if the date and time is 
between July 22, 2000 at 3 p.m. and July 22, 2001 at 3 p.m., show customers 
a sale ad (action). The range of dates is inclusive. The current date and time 
refers to the date and time at the point that the condition is evaluated for a 
given user visiting the Web site.

See “Important Note About Dates and Times” on page 2-5.

There is a specific item in the 
shopping cart

If an item you specify exists in the customer’s shopping cart, execute the 
specified action.  For example, if the customer has an item with a SKU equal 
to T144 in their shopping cart, give the customer a 10% discount (action).

There is an item from a given 
category in the shopping cart

If an item from a product category you specify exists in the customer’s 
shopping cart, execute the specified action.  For example, if the customer 
has an item from Books (product category) in their shopping cart, give the 
customer a 10% discount (action).

Table 2-1  Descriptions of Conditions (Continued)

Condition Description
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Important Note About Dates and Times

When you set date and time conditions in the E-Business Control Center, the 
dates/times you set represent the time in your region. For example, if you are creating 
a campaign action that will be triggered at 8 p.m., that means 8 p.m. in your region. For 
a time zone that is two hours behind you, the action will be triggered at 6 p.m. in that 
time zone.

This also affects dates you set. The date you set becomes effective at midnight in your 
time zone. In a time zone that is six hours ahead of yours, that date becomes effective 
for that time zone at 6 p.m. your time the day before.

Time changes also affect time-triggered actions. For example, say you create a 
campaign that begins October 1 at noon and ends October 31 at noon. If a change to 
standard time (one hour earlier) occurs on October 29, the campaign will actually end 
on October 31 at 11 a.m. So if you want the campaign to end at noon on the new 
standard time, set the end time to 1 p.m.

Because of the different dates and times on which actions will be triggered around the 
country or world, it is important to tell customers that dates and times are effective for 
your time zone. This type of information allows customers to calculate when in their 
time zone they can take advantage of your promotions.

The value of items in the cart is a 
certain amount

If the value of the items in a customer’s shopping cart meets the criteria you 
specify, execute the specified action.  For example, if the customer has $100 
worth (value) of items in their shopping cart, send them a Thank You e-mail 
(action).

A random number falls within a 
given range

When someone visits your Web site, the system assigns him a random 
number from 1 to 100. If the visitor’s random number falls within the 
numeric range you set, execute this action. For example, if you specify a 
range of 1 to 50, the action will be executed for approximately 50% of the 
target visitor population.

Table 2-1  Descriptions of Conditions (Continued)

Condition Description
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Using the Select Customer Segments 
Window

When you create a campaign scenario action or a content selector, select “The visitor 
is a member of a predefined customer segment” condition, and click the [customer 
segment] hyperlink in the Action pane, the Select Customer Segments window opens. 
Figure 2-1 shows the Select Customer Segments window. 

Figure 2-1   Select Customer Segments Window

1. Click a customer segment name shown in the Available Segments list to select it.  
The customer segment is highlighted.

2. Click Add.  The customer segment moves to the Selected Segments list.

3. Repeat steps 1 and 2 for each customer segment you want to add.

Note: If you make a mistake, click a customer segment name shown in the 
Selected Segments list to select it, then click Remove.

4. Click OK. The Select Customer Segments window closes, and the [customer 
segment] hyperlink changes to reflect the customer segment(s) you specified.
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Using the Properties and Visitor 
Characteristics Windows

Many items in the E-Business Control Center can be described by their characteristics 
or properties. For example, visitors to the site, content to be shown to visitors, and 
events that represent visitor behavior can all be described in terms of their properties. 
Related properties are grouped together for convenience into property sets. Objects in 
the E-Business Control Center may have one or more property sets associated with 
them. For example, visitors may have one set of properties pertaining to general 
information, such as their address, and another set of properties pertaining to 
demographic information, such as their gender. 

The windows where you describe E-Business Control Center objects by way of their 
properties are generically referred to as Properties windows. Using the Properties 
windows, and their associated Property Values windows, you can build Descriptors 
that describe an object of interest. The Descriptor is comprised of a property phrase 
and a value phrase. 

For example, you may be interested in targeting an e-mail to customers whose income 
range is $75,000-$99,000. The Descriptor created in an E-Business Control Center 
Properties window would be:

Demographics: Income_Range is equal to “$75,000-$99,000”

Demographics is the property set in which you would find the Income_Range property, 
Is Equal is the comparison, and “$75,000=$99,000” is the value.  Together, the 
property set and property form the following Property Phrase:

Demographics: Income_Range

Together, the comparison and the value form the following Value Phrase:

is equal to “$75,000-$99,000”

When you click the Is Equal To [value] hyperlink, a Properties window opens. 
Figure 2-2 is an example of a Properties window. 
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Figure 2-2   Properties Window

1. Select a property set from the Property Set drop-down list, and a property from the 
Property drop-down list.

Note: The E-Business Control Center includes some values for the Property Set 
and Property lists. However, additional Property Sets and Properties may 
be defined by your organization’s business engineer or other technical 
resource.

2. Click Add. A Property-Values window opens, as shown in Figure 2-3.
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Figure 2-3   Property-Values Window

3. Select a comparison from the Comparison drop-down list, and select or type a 
value in the Value field.

If the property value requires text entry, you can use the contains comparison 
to perform wild card matching. For example, if you want to send an automatic 
e-mail to customers who work at BEA when they log onto your site, you could 
select the Email property in CustomerProperties, select the contains 
comparison, and enter @bea.com.

4. Click Add. The value phrase you specified appears in the Value Phrases list box, 
as shown in Figure 2-4.

Warning: It may be possible to construct value phrases that are not reasonable in 
real world situations. Be sure to select a comparison and value that 
makes sense for the property set and property you previously selected.
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Figure 2-4   Value Phrases List Box

5. If desired, add more value phrases by repeating steps 3 and 4.  If you add 
multiple value phrases, select a Multiple Value Phrases option to specify whether 
you want to match any or all of the value phrases you specify.  If you only 
specify one value phrase, you can skip the Multiple Value Phrases option.

Note: If you need to remove a value phrases, click on the value phrases in the 
Value Phrases list box to select it, then click Remove.

6. Click OK. The Property-Value window closes, and the descriptor(s) appear in the 
Descriptors list box of the Properties window, as shown in Figure 2-5.

Figure 2-5   Descriptors List Box

7. If desired, repeat steps 2 through 6 to specify multiple descriptors.

8. Click OK.  The Properties window closes, and the [characteristics] and/or 
[properties] hyperlinks change to reflect the descriptors you specified.
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Using the Select Events Window

When you are creating a campaign scenario action, select the “An event has occurred 
condition,” and click the [event name] hyperlink in the Action pane, the Select Events 
window opens. Figure 2-6 shows the Select Events window. 

Figure 2-6   Select Events Window

1. Click an event name shown in the Available Events list to select it.  A description 
of the event is shown in the Event Description text area.

2. Click Add.  The event moves to the Selected Events list.

3. Repeat steps 1 and 2 for each event you want to add.

Note: If you make a mistake, click an event name shown in the Selected Events 
list to select it, then click Remove.

4. Click OK.  The Select Events window closes, and the [event name] hyperlink 
changes to reflect the event(s) you specified. 
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Using the Date/Time Entry Dialog Boxes

Before you set date and time conditions in the E-Business Control Center, see 
“Important Note About Dates and Times” on page 2-5.

When you click one of the generic date or time related hyperlinks, one of the date/time 
entry dialog boxes opens. Simply type in the date and/or time in the appropriate field, 
then click OK. When you do so, the date/time entry dialog box closes, and the generic 
hyperlinks change to reflect the dates and/or times you specified.

Tip: For dates, you can either type in the date, or click the drop-down calendar to 
select the date, as shown in Figure 2-7. Just click a date to select it.

Figure 2-7   Date Calendar

Using the Quantity Selector or Currency 
Selector Dialog Boxes

When you click the [n] hyperlink, a Quantity Selector dialog box opens. When you 
click the [monetary amount] hyperlink, a similar dialog box, called Currency Selector 
opens. Figure 2-8 shows the Quantity Selector dialog box.
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Figure 2-8   Quantity Selector Dialog Box

Note: A default value may be shown in the field.

1. If desired, type a new value into the field.

2. Click OK.  The Quantity Selector or Currency Selector dialog box closes, and the 
[n] or [monetary amount] hyperlinks change to reflect the value you specified. 

Using the Select Operator Dialog Box

When you click the Equal To hyperlink, a Select Operator dialog box opens. 
Figure 2-9 shows the Select Operator dialog box.

Figure 2-9   Select Operator Dialog Box

Note: A default value of Is Equal To is highlighted, which is why the hyperlinked 
Equal To text you clicked on to open the dialog box was not enclosed in 
brackets.

1. If desired, click a new value in the Operators list to select it.
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2. Click OK.  The Select Operator dialog box closes, and the hyperlink changes to 
reflect the value you specified.

Using the Select Product Categories/Items 
Windows

When you click the [product category] or [sku] hyperlinks, the Select Product 
Categories/Items window opens, as shown in Figure 2-10. When you add a trigger or 
target to a discount, a Specify Trigger Items or Specify Target Items window appears. 
The procedure for entering SKU numbers or product categories in these windows is 
the same.

Figure 2-10   Select Product Categories Window

1. Enter the SKU number or product category in one of two ways:

l Enter it manually in the Product Category or Product SKU field, or

l Click the Browse Catalog button to choose a category item directly from 
your catalog (see “Using the Catalog Browser,” next).
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2. Click Add.

3. If desired, add multiple SKU numbers or multiple product categories.

4. If you add multiple SKUs or product categories in the Select Product Categories 
window, select a Multiple Product Items option at the bottom of the window. 
That is, specify whether the condition is met if Any or All of the SKU numbers 
(or product categories) exist in the customer’s shopping cart.

So, for example, if you specified SKU number T144 and SKU number D128 and 
you selected the Any option, customers with either of these SKU numbers in 
their shopping cart would meet the conditions. If you selected the All option, 
customers with both of these SKU numbers in their shopping cart would meet 
the conditions.

5. Click OK. The window closes, and the [product category] or [sku] hyperlinks 
change to reflect the value(s) you specified.

The following procedure explains how to use the Catalog Browser feature from step 1.

Using the Catalog Browser

The Catalog Browser allows you to easily find and select items for your campaign or 
discount definition. The following sections provide step-by-step instructions on how 
to use the Catalog Browser.

Browsing a Catalog

The browsing feature of the Catalog Browser allows you to select either categories or 
specific items from your catalog. You can select one or more items.

Note: You must first establish a connection to your catalog server. For more 
information, see “Connecting to the Server” on page 1-19.

1. To open the Catalog Browser, click the Browse Catalog button. The Catalog 
Browser opens, as shown in Figure 2-11.

2. Click the Browse button in the Catalog Browser window.

3. In the left navigation pane, navigate to the category that contains the item or 
product category that you want to add to your discount or campaign definition.
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4. In the right pane, select one or more categories or items.

5. Click OK. The items or categories are added to your discount or campaign 
definition.

Figure 2-11   Catalog Browser

Searching a Catalog

The search feature of the Catalog Browser allows you to find a specific item or 
category from your catalog. You can use a wildcard (*) to help you find items when 
you don’t know the exact SKU.

Note: You must first establish a connection to your catalog server. For more 
information, see “Connecting to the Server” on page 1-19. 

1. To open the Catalog Browser, click the Catalog Browser button.

2. Click the Search button. The Search window opens as shown in Figure 2-12.

3. Enter the Category or SKU in the corresponding field, and then click the Search 
button. Use an asterisk (*) for wildcard searches.
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Note: When searching for a category, only the category field is available.

4. After the search list appears in the left pane, select the desired Category or SKU 
from the left pane.

5. Click OK. The items or categories are added to your discount or campaign 
definition. 

Figure 2-12   Catalog Browser Search

Using the Enter a Range Dialog Box

When you click the [x] hyperlink, the Enter a Range dialog box (shown in Figure 2-13) 
opens.
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Figure 2-13   Enter a Range Dialog Box

1. Enter starting value between 1 and 99.

2. Enter an ending value between 2 and 100.

3. Click OK. The Enter a Range dialog box closes, and the [x] and [y] hyperlinks 
change to reflect the range you specified.

For more information on ranges, see “About Probability-Based Branching” in the 
Roadmap for Creating Promotional Campaigns chapter.

Constructing Queries

The documents that are stored in your content management system have certain 
properties associated with them that describe the documents. For example, all 
documents have system properties such as author, creation date, and modification date. 
You can also add custom properties to documents that more specifically describe the 
documents. For example, for your ad graphics, you can add properties for company 
name and product name. These properties are called metadata.

To create ad placeholders, scenario actions, and content selectors that find and display 
documents, you must construct queries. Queries search your content management 
system and retrieve documents that have the metadata you are looking for. The 
documents are then displayed in your Web pages. You can construct queries in the 
following ways:

n By comparing a document property to a value or range of values.

For example, you want to display ads for ACME mutual funds in an ad 
placeholder. Your content management system uses a property named 
productName to indicate the name of the mutual fund that a document 
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advertises. You construct a query that finds all documents for which the 
productName property contains ACME.

n By comparing a document property with a property of some other object. (This 
type of descriptor is available only for queries that content selectors and scenario 
actions run.) 

For example, you want a content selector to display documents that describe 
investing in mutual funds. Your content management system uses a document 
property called investorRiskLevel to identify whether a document describes 
an investment that is aggressive, moderate, or conservative. Your customer 
profiles also include a property called investorRiskLevel to indicate whether 
a customer prefers aggressive, moderate, or conservative investments. You 
construct a query that finds all documents for which the investorRiskLevel 
property contains a value that is equal to the value of a customer’s 
investorRiskLevel property. 

For content selectors and scenario actions, you can also combine the two types of 
descriptors in a single query. For example, you can create a query for a content selector 
that finds documents that advertise ACME mutual funds and that match a customer’s 
investment-risk profile. 

To construct queries, do the following:

1. Select a Document Property.

2. Do one or more of the following:

l Describe Documents by Comparing the Property to a Value or Range of 
Values

l Describe Documents by Comparing the Property with the Properties of Other 
Objects

3. Specify How to Handle Multiple Value Phrases and Descriptors.

4. Preview the Query Results.

You can search for multiple document properties by repeating steps 1 through 3.
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Select a Document Property

You select document properties in the Ad Search window or the Content Search 
window, depending on whether you are creating an ad placeholder, a scenario action 
for a campaign, or a content selector. The E-Business Control Center displays the 
Ad/Content Search window when you do any of the following:

n When you create or edit an ad search for an ad placeholder.

n In an ad scenario for a campaign, click the hypertext link in “Place the content 
returned by this ad search...” or “...[empty ad search]...” in the Ad Action editor. 
The Ad Search window appears. This feature is available only with BEA 
WebLogic Portal.

n When working with content selectors, click the hypertext link in “Show the 
results of this content search” or “...[empty content search]” under Action in the 
Content Selector window. The Content Search window appears.

In the Ad/Content Search window, do the following:

1. From the Property Set list, select the property set that contains the properties you 
use to describe documents. 

2. From the Property list, select a document property. (See Figure 2-14.) 

For example, you are constructing a query for a campaign ad. Your content 
management system uses a property named author to indicate the name of the 
person who authored the ad. To search for the ad based on the name of the 
author, select author from the Property list. 

Figure 2-14   Select a Property for a Campaign Ad Scenario
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3. Click Add. The Ad/Content Search Values window appears. 

4. Do one or more of the following:

l Describe Documents by Comparing the Property to a Value or Range of 
Values.

l Describe Documents by Comparing the Property with the Properties of Other 
Objects. (This type of comparison is available only for queries that content 
selectors and scenario actions run, not ad placeholders.)

These options are described in the following sections.

To edit the properties of an existing item, select it in the Descriptors list and click Edit.

Describe Documents by Comparing the Property to a 
Value or Range of Values

To find documents by comparing the document property with a value or range of 
values, do the following:

1. From the Ad/Content Search Values window, do one of the following:

l If you are constructing a query for a content selector or a scenario action, 
click the Values tab. (See Figure 2-15.)

l If you are constructing a query for an ad placeholder, the Ad Search Values 
window does not contain tabs. Skip this step and go to step 2.

2. From the Comparison list, choose a comparator.

3. In the Value box, select or enter a value. (Depending on the property that you are 
comparing, the Value box might contain a list of values for you to select.)

If the property value requires text entry, you can use the like comparison with 
wild card characters (* and ?). For example, if you have a set of ads with a 
four-digit number and “ad” as part of the name, you could select the like 
comparison and enter *10??ad*.

Note: If you set up a query based on filename and you are using the like 
comparison, begin the query with an asterisk (*), because path information 
always precedes the filename in the query results.
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4. Click Add. 

5. Do one of the following:

l To compare the document property with additional values, repeat steps 2 
through 4.

l If you are constructing a query for a content selector or a scenario action and 
you want to compare the document property with the properties of other 
objects, go to “Describe Documents by Comparing the Property with the 
Properties of Other Objects” on page 2-22. 

l To select another document property, click OK and go to “Select a Document 
Property” on page 2-20.

l To complete the query construction, go to “Specify How to Handle Multiple 
Value Phrases and Descriptors” on page 2-24.

Figure 2-15   The Values Tab for Ad Search Queries

Describe Documents by Comparing the Property with the 
Properties of Other Objects

If you are constructing a query for a scenario action or a content selector, you can find 
documents by comparing the document property with the properties of other objects. 
To construct such a query, do the following:

1. From the Ad/Content Search Values window, click the Properties tab.

2. From the Comparison list, choose a comparator.
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3. From the Property Set Type list, choose the type of object that you want to 
compare.

If you are constructing a query for a campaign ad action, you can compare the 
document property with a property in one of the following property sets: User 
Profile, Session, Request, Event, or Catalog Structure.

If you are constructing a query for a content selector, you can compare the 
document property with a property in one of the following property sets: User 
Profile, Session, Request, or Catalog Structure.

For example, you created a property set called FinancialDocs that contains a 
document property called investorRiskLevel to identify whether a document 
describes an investment that is aggressive, moderate, or conservative. (See 
“Adding Property Sets to Drop-Down Lists” on page 2-25.) Your customer 
profiles also include a property called investorRiskLevel to indicate whether 
a customer prefers aggressive, moderate, or conservative investments. To create 
a content selector query that matches documents with a customer’s 
investment-risk preference, in the Content Search window, you select the 
investorRiskLevel document property. In the Content Search Values window, 
you click the Properties tab. From the Comparison list, select Is Equal To. Then 
from the Property Set Type list, select User. (See Figure 2-16.)

4. From the Property Set list, choose the property set that contains the properties of 
the object that you want to compare.

For example, if you place the investorRiskLevel user property in a property 
set named InvestmentProfile, then choose InvestmentProfile from the 
Property Set list.

5. From the Property list, choose a property.

6. Click Add. 

7. Do one of the following:

l To compare the document property with additional object properties, repeat 
steps 1 through 6.

l To select another document property, click OK and return to “Select a 
Document Property” on page 2-20.

l To complete the query construction, go to “Specify How to Handle Multiple 
Value Phrases and Descriptors” on page 2-24.
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Figure 2-16   Find Documents by Comparing the Properties of a User

Specify How to Handle Multiple Value Phrases and 
Descriptors

1. If you created multiple comparisons, in the Ad/Content Search Values window, 
under For Multiple Value Phrases, choose one of the following:

l Qualifying Items May Match ANY Value Phrase if the property value phrase 
must match at least one of the value phrases.

l Qualifying Items Must Match ALL Value Phrases if the phrase must match 
each of the value phrases.

2. In the Ad/Content Search Values window, click OK.

3. To create additional comparisons, click Add and return to “Select a Document 
Property” on page 2-20.

4. If you created multiple descriptors, from the Ad/Content Search window, under 
For Multiple Descriptors, choose one of the following:

l “Qualifying items may match ANY descriptor” if the property value phrase 
must match at least one of the descriptors.
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l “Qualifying items must match ALL descriptors” if the phrase must match 
each of the descriptors.

5. In the Ad/Content Search window, do either of the following:

l Preview the Query Results.

l Click OK to finish constructing the query.

Adding Property Sets to Drop-Down Lists

When you select a property set for an Ad or Content search, you will see two default 
choices: Ads and LoadedData. These property sets relate to ad and content documents 
in WebLogic Portal that your query will find.

For most of the ad or content searches you perform (queries you set up) that place 
documents in placeholders on your JSPs, the Ads and LoadedData property sets should 
be sufficient. They contain most of the attributes that are appropriate for finding 
content that can be displayed by a JSP. In particular, these property sets include 
automatic system attributes you can use in your queries—attributes that all files have, 
such as name, size, creation date, and modification date. (See “System Attributes for 
Property Sets” on page 2-28.)

However, you can add more property sets to this list. There are good reasons for doing 
so:

n Custom Properties – When you want to categorize your ad and content 
documents more precisely. For example, you can create a property set called 
FinancialDocs that contains financial properties, such as investor risk level. 
You can add the investorRiskLevel property to the metadata for any mutual 
fund ads you create. Then, when you assign a certain investorRiskLevel 
(such as “aggressive”) to an ad, you can target customers who have identified 
themselves as aggressive investors.

n Organization – If you have diverse types of ads and content, you may want to 
create more property sets to make query-building easier. For example, if you 
have a lot of seasonal clothing ads, you can create a property set called 
Clothing that contains a season attribute with four possible values (summer, 
fall, winter, spring). Building queries becomes easier, because you can 
select the Clothing property set in the drop-down list, select the season 
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property, and set its value to summer. Your query will then return all ads whose 
metadata contains the season attribute with a value set to summer.

If you have only a small number of custom ad attributes you want to use, you 
can add them to the existing Ads or LoadedData property sets instead of creating 
new property sets for them.

Adding a property set to the drop-down list involves creating a simple XML file. You 
can view the XML files for the Ads and LoadedData property sets in the 
PORTAL_HOME\dmsBase\doc-schemas folder. The files are called ad-schema.xml 
(for the Ads property set) and doc-schema.xml (for the LoadedData property set). 

To add a new property set to the drop-down list:

1. Create a new text file and add the following XML data:

<?xml version="1.0" standalone="no"?>

<!DOCTYPE doc-schemas SYSTEM "doc-schemas.dtd">

<doc-schemas>

  <doc-schema name="FinancialDocs">

  </doc-schema>

</doc-schemas>

The text you enter in the <doc-schema> element is the name of the property set 
that will appear in the drop-down list.

2. Add properties inside the <doc-schema> element, using an element called 
<attribute>.

The following example shows two properties that will be available for selection 
in the property set: investorRiskLevel whose values will be selected from a 
drop-down list, and primaryHolding, a text entry field for the property value. 
investorRiskLevel has a default value set, which will appear automatically 
when you select that property for a query.
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<?xml version="1.0" standalone="no"?>

<!DOCTYPE doc-schemas SYSTEM "doc-schemas.dtd">

<doc-schemas>

  <doc-schema name="FinancialDocs">

    <attribute name="investorRiskLevel" default="moderate">

      <value>conservative</value>

      <value>moderate</value>

      <value>aggressive</value>

    </attribute>

    <attribute name="primaryHolding">

      <description>Primary Stock Holding</description>

    </attribute>

  </doc-schema>

</doc-schemas>

3. Save the file in the PORTAL_HOME\dmsBase\doc-schemas folder, making sure 
the filename ends with -schema.xml like the Ads and LoadedData property set 
files.

4. To have WebLogic Portal recognize the new property set, do one of two things:

l Restart WebLogic Portal

or

l Restart the document connection pool for your server in the WebLogic 
Server Administration Console. To do this, make sure your server is the 
active server in the left navigation pane, then go to Applications → 
<application_name> → Service Configuration → Document Connection 
Pool, and click the restart button.

You have to perform either of these restart tasks when you simply add a property 
to an existing property set.

For information on creating ads and loading them into the WebLogic Portal ad 
database, see “Setting up Ads for Campaigns” in the Guide to Developing Campaign 
Infrastructure.
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System Attributes for Property Sets

The following system database attributes are available automatically for your property 
set and store data about your content. Do not add them to your *schema.xml file. Doing 
so will cause an error when you try to access the property set.

These attributes are: author, comments, creationDate, description, 
identifier, lockedBy, modifiedBy, modifiedDate, mimeType, name, size, and 
version.

Preview the Query Results

To run the query and see the documents that it finds, do the following:

1. In the Ad/Content Search window click Preview.

The E-Business Control Center prompts you for a user ID.

2. In the Enter the User ID window, enter the user name of a customer (or a sample 
customer) who represents a specific set of customer properties, and click OK.

For example, you want to see the documents that the query returns for customers 
with a conservative investment profile. The customer profile for Pat Gomes 
specifies a conservative investment profile, so you enter Pat’s user name.

Note: You must enter a user ID, regardless of the type of condition that activates 
a placeholder, scenario action, or content selector.

The E-Business Control Center runs the query and displays the results in your 
default browser. (See Figure 2-17.)

The top pane displays the query and the left pane displays the names of the ads 
that the query finds.

3. To see a document in your browser, click the name of the document in the left 
pane.

The right pane of your browser displays the document.

Note: WebLogic Portal or WebLogic Personalization Server creates a short-lived 
cache that stores the results of a query. If you add or modify documents in 
your content management system and then immediately redo the query 
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preview, you might not see the results of your modifications. If this occurs, 
wait several minutes and then retry the query preview.

Figure 2-17   Query Preview in the Browser

4. In the Ad/Content Search window, you can either modify the query or click OK 
to finish constructing the query.

For information on creating ad content, working with a content management system, 
and adding mime types, see “Setting up Ads for Campaigns” in the Guide to 
Developing Campaign Infrastructure.
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CHAPTER

3  Creating and 
Managing Property 
Sets

Property sets are the schemas for personalization attributes. Using the E-Business 
Control Center, you can create property sets and define the properties that make up 
these property sets.

This topic includes the following sections:

n Overview of Property Sets

l Property Sets Serve as Namespaces for Properties

l Where Property Sets Are Used

l Property Definition Attributes

n Using the E-Business Control Center

l Starting the Property Set Editors

l Using the Property Set Editors
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Overview of Property Sets

A property set is a convenient way to give a name to a group of properties for a spe-
cific purpose. For example, in the sample application you will find a User Profile 
property set named Customer Properties. This property set defines around thirty prop-
erties for an e-commerce customer, such as First Name, Last Name, Home Phone, 
Email, and Customer Type.

Property sets and property definitions are created in the E-Business Control Center, on 
the Site Infrastructure tab. A Property Editor allows you to give a new a property a 
name and a description, assign a data type, a selection mode, and a value range, and 
create a list of possible values for the property.

Although properties are designed in the EBCC, the value assigned to a property is 
created in the application. Properties are generally represented in an application as 
fields on a page. To use the Customer Properties property set to collect information 
about an e-customer, the application will typically present the thirty properties in a list 
or a table, with text boxes provided to fill in specific values for the customer.

Property Sets Serve as Namespaces for Properties

In the most general sense, a property can be considered a name/value pair. Property 
sets serve as namespaces for properties so that properties can be conveniently grouped 
and so that multiple properties with the same name can be defined.

For example, you might create a property set called Demographics to describe user 
profile properties. The Demographics property set contains properties called Age, 
Gender, Income, and so forth. Because property sets create unique namespaces for 
properties, another property set can also have a property called Gender, and the two 
values will be kept separate. 
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Figure 3-1   The Demographics Property Set uses the Gender attribute 

Figure 3-2   The Handiness Property Set also uses the Gender attribute
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Where Property Sets Are Used

For Portal and Personalization Server purposes, property sets are applied to six major 
areas. Of these, five are configured in the E-Business Control Center.

Table 3-1  The Property Set Buttons on the Site Infrastructure Tab

User Profiles
The User Profiles property set type is used for defining the property sets and 
properties that apply to user and group profiles. For example, a property set of this 
type might be created called “CustomerProperties.” Subsequent property retrieval for 
a particular user or group can then be scoped with this property set name to retrieve 
the user’s email address. For an in-depth discussion of how property retrieval works 
for users and groups, see “Creating and Managing Users” in the Guide to Building 
Personalized Applications.

HTTP Requests
An HTTP Request is the information that your browser sends to the server; the server 
sends back an HTTP response.

The Request property set type is used for defining the property sets and properties 
that apply to HTTP requests. A Request property set type might be called 
“myApplicationRequest.” Properties available through this property set can then be 
accessed via the Advisor.

HTTP Sessions

A session contains short-lived, stateful information for the time that a browser is 
interacting with a server. 

The Session property set type is used for defining the property sets and properties that 
apply to HTTP sessions. A “Session” property set type might be called 
“myApplicationSession.” Properties available through this property set can then be 
accessed via the Advisor.

Catalog Structure

The Catalog Structure property set type is used to define custom attributes for product 
items and product categories in the Commerce services catalog. These custom 
attributes can be used in addition to the default attributes provided by Commerce 
services in the catalog database tables. For more information, see the topic “Catalog 
Administration Tasks” in the Guide to Building a Product Catalog.
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Property Definition Attributes

All properties includes the following information:

n Property name—the name of the property, such as Gender. Within a single 
property set, all properties must have a unique name. However, property names 
can be re-used in different property sets.

n Data type—specifies the data type of the property value. The possible values are 
Text, Numeric, Floating-Point number (equivalent to Double in Java), Boolean, 
and Date/Time.

n Selection mode—specifies whether a property is single-valued (has a single 
default value) or multi-valued (has a collection of default values).

n Value range—specifies whether the defaults are restricted to one specific value, 
one or more specific values, or any value.

Optionally, property definitions can also include the following:

n Description—a textual description of the property, perhaps describing the 
purpose of the property.

Events

The Events property set type is used to register a custom event. For the purpose of 
registering an event, you can consider an event property as a name-value pair. During 
the registration of a custom event, you specify the event’s name, description, and one 
or more properties. Each property has a range, type of permissible value, and default 
value. The information you need to register an event should be available from your 
Business Engineer (BE) or Java developer.

Use the tools 
associated with 
your document
 management 

system.

Content Management
The Content Management property set type is used for defining the configuration and 
run-time use of the content management system. Content Management property sets 
cannot be created or manipulated with the Personalization Server Administration 
Tools or the E-Business Control Center. Instead, use the tools associated with your 
document management system. For more complete information on this subject, see 
“Creating and Managing Content” in the Guide to Building Personalized 
Applications.

Table 3-1  The Property Set Buttons on the Site Infrastructure Tab
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n Values—you can assign a list of values from which the user will pick, and you 
can designate which of the values is the default.

The following table lists the property definition attributes and values.

Possible Combinations of Properties

As the previous list suggests, a combination of property values are possible. The 
possible combinations of properties are listed here:

n Boolean: The values for this type of property are either True or False. You can 
choose the default. The default value is displayed only in the Enter Property 
Values Window, not in the Edit Event Property window. When this data type is 
selected, the Selection mode and Value range are unavailable.

n Single, Unrestricted: This type of property has only one value, which is also the 
default value.

Table 3-2  Property Definition Attributes and Values

Property Definition Attribute Attribute Value

Name Text (100 character length maximum)

Description Text (255 character length maximum)

Type n Text 

n Numeric – (equivalent to Long in Java) 

n Float – Floating-Point Number (equivalent to 
Double in Java) 

n Boolean 

n Date/Time (equivalent to
 java.sql.Timestamp)

Selection Mode Single-valued or multi-valued

Value Range Restricted or unrestricted

 Default Value Up to the user — can be null

 Restricted Values Allowable values if the property is restricted
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n Single, Restricted: This type of property has multiple available values and a 
single default value. You can select which value is the default. 

An instance of this property can have only one value assigned. For example, the 
property Favorite_Day_of_the_Week would have seven available values, but an 
instance of the property can have only one value (Saturday).

n Multiple, Restricted: This type of property has multiple available values. You 
can select one or more values as default values. 

An instance of this property can have multiple values assigned. For example, the 
property Favorite_Days_of_the_Week would have seven available values, and 
an instance of the property can have any number of values (Friday, Saturday, 
Sunday).

n Multiple, Unrestricted: This type of property has multiple values. You cannot 
select any defaults; all values are defaults.

Synchronizing Property Sets

Property sets are meant to be used as application code. Just as you would not normally 
deploy new code onto a production server without first testing and staging it, we 
recommend that you do not synchronize updates to the property sets onto a live server 
once the application itself is deployed into production.

Why would synchronizing to a live server be a problem? If you create a property set 
containing a property of a specific type, synchronize it and assign values to that 
property for users, then change the type and re-synchronize it, there will be 
inconsistent property value data in the database. 

Let’s look at an example. Suppose the "Date_of_Birth" property in the Demographics 
property set was originally a String. Users might have put in values in many different 
formats, such as "8/9/1974", "August 9th, 1974", "Aug 9 1974", and so forth. Then you 
decide these are too hard to parse and validate, so you make the "Date_of_Birth" 
property a Date/Time type. You redeploy the property set, but now there are values of 
the wrong type in the database.

It's up to you, the developer, to do the data conversion to make these properties into the 
correct type. Or, if your data is just test or sample data, you can delete the data 
altogether and start over. 
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Using the E-Business Control Center

The E-Business Control Center tools allow you to create and manage sets of typed 
properties. Using the Site Infrastructure tab, property sets can be defined to describe   
properties for User Profiles, Requests, Sessions, Catalog Structures, and Events.

Note:  The Site Infrastructure tab also contains the Webflows/Pipelines tool icon, 
which is used to create and edit new pipelines and webflows. Since webflows 
and pipelines do not use property sets, these topics will not be covered here. 
See the topic “Using the Webflow and Pipeline Editors” in the Guide to Using 
the E-Business Control Center documentation.

Figure 3-3   The Site Infrastructure Tab on the E-Business Control Center
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Creating a property set is a simple task via the E-Business Control Center. A name for 
the set must be provided as well as description, and the type of property set 
(“User/Group”, “Session”, or “Request”) must be chosen.

Once a User/Group property set is created and deployed, property values can be edited 
for a particular user or group via the User Management user and group tools. For 
“Session” and “Request” properties, the only editable values are the default values set 
in the property definitions —run-time values are determined by values in the HTTP 
session or HTTP request, respectively.
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Starting the Property Set Editors

To begin using the Editors, follow these steps:

1. Start the E-Business Control Center (EBCC). For detailed instructions on starting 
the EBCC, see the topic “Starting the E-Business Control Center” in the Guide to 
Using the E-Business Control Center documentation.

2. Create a new Web application or open an existing Web application for which you 
will be creating or editing a property set.

For detailed instructions on performing these tasks, see “Creating an Application 
Structure for E-Business Control Center Data” or “Opening Application Data” in 
the Guide to Using the E-Business Control Center documentation. 

3. Select the Site Infrastructure tab in the EBCC’s Explorer window, then click any 
of the tool icons in the Explorer window (except the Webflows/Pipelines icon.) 

Using the Property Set Editors

The property set editors works the same way for all property sets. For these examples, 
we will be using the E-Business Control Center to create and modify Event properties. 
The examples used here can be used to register a custom event. You can follow the 
same procedures to create and modify property sets for Users and Groups, HTTP 
Requests, HTTP Sessions, and the Catalog Structure. 

To register a custom event, complete the following steps 

1. Start the E-Business Control Center and connect it to a server. The Explorer 
window opens as shown in Figure 3-4.

Note: For more information on connecting the E-Business Control Center to a 
server, see the topic “Connecting to the Server” in the Guide to Using the 
E-Business Control Center.
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Figure 3-4   E-Business Control Center Window

2. Open the Event Editor as follows:

Note: You cannot edit the standard events.

a. In the Explorer window, select the Event icon. A list of events appears in the 
Events field.

b. Click the New Button, and then select Event. The Event Editor window appears 
as shown in Figure 3-5.
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Figure 3-5   Event Editor Window

3. In the Edit Event Editor window, complete these steps:

a. In the Name field, enter a unique name for the event no longer than 100 
characters (required).

b. In the Description field, enter a description for the event no longer than 254 
characters (required).

c. Click the Save button in the E-Business Control Center system toolbar.

d. To create properties for the event, click the New button. The Edit Event 
Property window opens, as shown in Figure 3-6.
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Figure 3-6   Edit Event Property Window

4. In the Edit Event Property window, complete these steps:

a. In the Name field, enter a unique name for the property no longer than 100 
characters (required).

b. In the Description field, enter a description of the property no longer than 254 
characters (required).

c. In the Data type list, select the data type. If you select Boolean as the data type, 
the Selection mode and Value range are no longer available. The default for 
Boolean is Single, Restricted.

d. In the Selection mode list, select either Single or Multiple.

e. In the Value range list, select whether the value is Restricted or Unrestricted.

f. Click the Add/Edit Values button.

The type of window that appears depends on the values selected.

Property Values and Setting the Default Value

Depending on the data type, different steps are required for entering values and setting 
default values. The following property categories are available:

n Properties with Boolean or a Single Value and Single Default.
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n Properties with Multiple Values and Single, Multiple, or All Defaults

n Properties with Date and Time Values

Properties with Boolean or a Single Value and Single Default

To enter the default value for Boolean property or a property with a single value and a 
single default (unrestricted), complete the following steps:

1. In the applicable Enter Property Value window (Figure 3-7 or Figure 3-8), perform 
one of the following:

l For a Boolean property, select either True or False.

l For a Single Value, Single Default property, enter a value.

Figure 3-7   Enter Property Values Window—Boolean

Figure 3-8   Enter Property Values Window—Single Value, Single Default

2. Click the OK button.

3. In the Edit Event Property window, click the OK button.



Using the E-Business Control Center

Guide to Using the BEA E-Business Control Center 3-15

Properties with Multiple Values and Single, Multiple, 
or All Defaults

To enter multiple property values and set one or more defaults (unrestricted), complete 
the following steps:

1. In the applicable Enter Property Values window (Figure 3-9 or Figure 3-10), enter 
a value, and then click the Add button.

Figure 3-9   Enter Property Values—Multiple Values, Single Default

Figure 3-10   Enter Property Values—Multiple Values, Multiple Restricted 
Defaults
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Figure 3-11   Enter Property Values—Multiple Values, Multiple Unrestricted 
Defaults

2. Repeat the previous step until you have entered all values.

3. To select one or more default values, complete one of the following:

l If you do not want to select a default, go to next numbered step.

l For multiple values with a single default, select the value (radio button) that 
you want to set as the default, and then click the OK button.

Note: To remove the default value for a property with multiple values and a 
single default, click the Deselect All button.

l For multiple values with multiple restricted defaults, select the value (check 
boxes) that you want to set as defaults, and then click the OK button.

Note: For multiple values without restrictions (that is, the Value range is 
Unrestricted), you do not need to select any defaults.

4. In the Edit Event Property window, click the OK button.
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Properties with Date and Time Values

Properties with date and time values can use all Selection mode and Value range 
settings. For more information about these settings, see “Properties with Boolean or a 
Single Value and Single Default” and “Properties with Multiple Values and Single, 
Multiple, or All Defaults” on page 3-15.

To enter date and time values and set one or more defaults, complete the following 
steps:

1. In the Enter Property Values window shown in Figure 3-12, click the drop-down 
arrow in the Date list. A calendar appears.

Figure 3-12   Enter Date/Time Values 

2. Select a date from the calendar.

3. In the Time field, enter a time.

4. Click the Add button.

5. To add more dates and times, repeat the first four steps until you have entered all 
the values.

6. To select one or more default values, complete one of the following:

l If the event has a single date and time with a single default (restricted), click 
the OK button.

l If the event has multiple dates and times with a single default (restricted), 
select the value (radio button) that you want to set as the default, and then 
click the OK button.
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l If the event has multiple dates and times with multiple defaults (unrestricted), 
select the values (check boxes) that you want to set as the default, and then 
click the OK button.

7. In the Edit Event Property window, click the OK button.

Updating a Registered Custom Event

Whenever you make changes to a custom event’s code, you should update that event’s 
registration. Updating the registration lets the E-Business Control Center know about 
the changes in the custom event and aids campaign developers using the E-Business 
Control Center to modify any scenario actions that refer to the event.

To update a custom event, complete the following steps.

1. Start the E-Business Control Center and connect it to a Web server. The Explorer 
window opens.

Note: For more information on connecting the E-Business Control Center to a 
server, see “Connecting to the Server” in the Guide to Using the 
E-Business Control Center documentation.

2. In the Explorer window, select the Event icon. A list of events appears in the 
Events field as shown in Figure 3-13.

Note: You cannot edit standard events.
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Figure 3-13   Explorer Window

3. Double-click the custom event that you wish to edit. The Event Editor window 
opens as shown in Figure 3-14. The Event properties field displays a list of 
existing properties.
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Figure 3-14   Event Editor Window

4. In the Event properties field, select the property that you want to edit.

Note: For more information about setting custom event properties, see “Property 
Values and Setting the Default Value” on page 3-13.

5. Click the Edit button. The Edit Event Editor window opens as shown in 
Figure 3-15.

Figure 3-15   Edit Event Property Window
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6. To change the Data type, Selection mode, or Value range, select a setting from 
the appropriate list box.

Note: If you change the property setting Data type, Selection mode, or Value 
range, the associated values will be erased.

7. To add or change values, click the Add/Edit values button. The Enter Property 
Value window opens as shown in Figure 3-16.

Figure 3-16   Enter Property Value Window

a. To remove a value, select the value, and then click the Remove button.

b. To add a value, enter the value, and then click the Add button.

c. To change a value, select the value, remove it, and then add the new value.

d. If required, select the default value or values.

e. To remove the default value for a property with multiple values and a single 
default, click the Deselect All button.

f. Click the OK button. The Enter Property Value window closes.

8. After you have finished updating the properties or values for the event, click the 
OK button in the Edit Event Property window.
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CHAPTER

4 Using Customer 
Segments to Target 
High-Value Markets

This topic contains basic information about customer segments as they are used in the 
BEA E-Business Control Center. This information includes a conceptual description 
of a customer segment, an explanation about how you might want to use customer 
segments, and step-by-step instructions for creating a new customer segment or 
modifying existing customer segments within the E-Business Control Center.

This topic includes the following sections:

n About Customer Segments

l About Customer Profiles

l Creating Customer Segments from Information Stored in Customer Profiles

n Uses of Customer Segments

l Targeting Content to Online Customers

l Displaying Personalized Content Within Promotional Campaigns

l When and When Not to Use Segments

n Creating a Customer Segment

n Modifying a Customer Segment

n Deleting a Customer Segment
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About Customer Segments

To understand what a customer segment is, you must first learn about customer 
profiles.  Therefore, this section contains the following subsections:

n About Customer Profiles

n Creating Customer Segments from Information Stored in Customer Profiles

About Customer Profiles

A customer profile is a collection of information that is gathered, saved, and updated 
as customers visit your Web site, or from other offline sources.  Customer profiles are 
unique to each customer and can contain a variety of information, from product 
preferences to the demographic data customers provide on form pages.  The 
information stored in customer profiles is increasingly seen as the true lifeblood of 
e-business.  Effectively managing, analyzing, and using customer intelligence gives 
you a significant advantage over your competitors, because you can target your 
highest-value markets with your highest-value services, and do it cost-effectively.  

Because the E-Business Control Center works with the BEA WebLogic Portal and 
WebLogic Personalization Server, the E-Business Control Center already supports 
some customer profile information out of the box. However, the system is extremely 
flexible about the customer data it can store, and thus can easily be extended. If you 
believe that extending the E-Business Control Center would be helpful to your 
organization, you will initially need to collaborate with a Business Engineer (BE) or 
other technical resource who can make modifications to the tool. If possible, you 
should initiate this process before starting to use the E-Business Control Center.

Note: For technical information about how a Web site gathers customer profile 
information, see “Creating and Managing Users and Groups” in the Building 
Personalized Applications documentation 
at http://edocs.bea.com/wlp/docs40/p13ndev/users.htm.
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Creating Customer Segments from Information Stored in 
Customer Profiles

The customer profile information you collect can be used to create customer segments 
within the E-Business Control Center. A customer segment is a grouping of customers 
based on common characteristics from their profile, such as product preferences or 
age. Each piece of information stored in a customer’s profile (or any combination of 
that information) can be used to create a customer segment.

Using the sample customer profile information shown in Figure 4-1, there are a few 
customer segments you might create. 

Figure 4-1   Example Customer Profile Information

Based on the Favorite Category profile information, you might create a customer 
segment named Office Supply Junkie, which would include the customers janedoe and 
asmith.  Similarly, a customer segment named Over21 would include the customers 
janedoe and jblack, based on their Date of Birth profile information.

For step-by-step instructions on creating new customer segments in the E-Business 
Control Center, see “Creating a Customer Segment” on page 4-6.

Uses of Customer Segments

This gives you an overview of how you can use customer segments once you create 
them. Since there are two ways to use customer segments, this section contains the 
following subsections:

n Targeting Content to Online Customers

n Displaying Personalized Content Within Promotional Campaigns
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n When and When Not to Use Segments

Note: Depending upon the version of the E-Business Control Center you have, you 
may be able to use customer segments in one or both of the ways described in 
this section. For more information about the different versions of the 
E-Business Control Center that are packaged with the BEA WebLogic Portal 
and WebLogic Personalization Server, see “What the E-Business Control 
Center Provides” in the “Introduction to the BEA E-Business Control Center” 
or the Strategies for Developing E-Business Web Sites at 
http://edocs.bea.com/wlp/docs40/strategs/index.htm.

Targeting Content to Online Customers

In all versions of the E-Business Control Center, customer segments can be used in 
conjunction with content selectors to personalize a customer’s experience on your 
Web site.

A content selector is a mechanism used to retrieve documents from a content 
management system. A document is a graphic, a segment of HTML or plain text, or a 
file that must be viewed with a Web browser plug-in. Using content selectors, you can 
specify the conditions under which one or more documents are retrieved.

If you use a customer’s membership in a segment as one of these conditions, you can 
specify that a particular piece of content be selected from the content management 
system and displayed to that customer.  So, for example, customers who belong to an 
Office Supply Junkie segment may be shown an article titled: “Reducing Desk Clutter 
With Stackable Organizers.”

Note: To use customer segments with content selectors, you should collaborate with 
your organization’s business engineer or other technical resource. For more 
technical information about content selectors, see “Retrieving Documents 
with Content Selectors.”
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Displaying Personalized Content Within Promotional 
Campaigns

If you have a BEA WebLogic Portal license, you can also use customer segments 
within your promotional campaigns.

As part of a promotional campaign, a customer’s membership in a particular segment 
may be used as a condition to trigger a specific action, such as sending an e-mail, 
offering a discount, or displaying an ad.  For example, if janedoe is a member of the 
Office Supply Junkie customer segment, you might want to display an ad about an 
upcoming sale on office supplies to Jane when she logs in.  Because such actions are 
only triggered under certain conditions, you can use customer segments to target only 
the appropriate audience(s) with your campaign content.

The flowchart shown in Figure 4-2 illustrates how customer segments can be used as 
conditions to trigger specific campaign-related actions.

Figure 4-2   Condition Based on Membership in a Customer Segment  
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Note: For instructions about how to use customer segments within promotional 
campaigns, see “Customer Segments in Scenario Actions” in the “Roadmap 
for Creating Promotional Campaigns” and “Adding Actions to Your Scenarios 
to the Campaign” in “Creating and Managing Promotional Campaigns.”

When and When Not to Use Segments

You do not always have to use customer segments to target specific groups of people 
with campaign scenario actions or content selectors. When creating a scenario action 
or content selector, instead of triggering the action on a customer segment, you can 
trigger the action if the visitor has certain characteristics—the same set of 
characteristics you can use to create a customer segment. So since you can trigger a 
scenario action or content selector on visitor characteristics with or without a customer 
segment, you should put some thought into whether or not you create customer 
segments.

In the following guidelines to determine whether or not you should create a customer 
segment for use in scenario actions, reuse is the key:

n When to use customer segments – Create customer segments to trigger 
scenario actions or content selectors when the customer segment can be reused 
for other actions, in other campaigns, or for content selectors.

n When not to use customer segments – Do not create customer segments to 
trigger scenario actions or content selectors if the customer segment would be 
created to support just that action or content selector—or a potentially small 
number of them.

Creating a Customer Segment

Initially, you will probably want to spend some time creating new customer segments 
for use in the E-Business Control Center. This section provides step-by-step 
instructions you can follow to accomplish this task. If you have already created 
customer segments and need to edit them, see “Modifying a Customer Segment” on 
page 4-10.
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To create a new customer segment:

1. In the E-Business Control Center, open the application you want to work with.

2. In the E-Business Control Center, choose File → New → Business Logic → 
Segment. A new customer segment file opens in the Editor window, as shown in 
Figure 4-3.

Figure 4-3   Customer Segment Editor Window

3. Enter a description of the segment in the Description area.

The description is displayed at the bottom of the Explorer window when you 
select the file. It also appears when you move the mouse pointer over the name 
of the file in the Explorer window.

4. Click Create/Edit. The Customer Segment conditions window appears, as shown 
in Figure 4-4.
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Figure 4-4   Customer Segment Details Window

The conditions window is divided into two panes: Conditions and Actions. After 
you select a condition, you define the characteristics of that condition in the 
Action pane. For example, if you select the condition, The Visitor Has Specific 
Characteristics, you will select those characteristics from the Action pane. 
(Those visitor characteristics are defined in the User Profiles tool in the 
E-Business Control Center.)

5. In the Conditions pane, select the condition(s) that will define the customer 
segment. 

When you select a condition, a corresponding line of text with hyperlinks 
appears in the Action pane.

For a description of the conditions, see “Listing of the Available Conditions” in 
“Building Conditions and Queries in the BEA E-Business Control Center.”

Tip: You can create conditions that are always true. For example, you can select 
the It Is After A Given Date condition and then specify the date as January 
1, 1970.
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6. For each condition you selected, click the hyperlinks in the Action pane to 
specify values.

For example, if you selected The Visitor Has Specific Characteristics condition 
as shown in Figure 4-4, click the Is Equal to [value] hyperlink under the bulleted 
phrase, “the visitor has the following characteristics.”

Depending on the condition and the hyperlink, a window or a dialog box opens. 
Table 4-1 provides a consolidated listing of the conditions and indicates where to 
look if you need detailed instructions for any of the corresponding 
windows/dialog boxes.

7. If you selected more than one condition, decide whether all of the conditions 
must be met for a visitor to belong to the customer segment, or whether a visitor 
can be considered part of the segment when any of the conditions apply. To 
toggle between All and Any, click the All (or Any) hyperlink in the phrase, When 
All of These Conditions Apply.

8. Click OK. The Customer Segment details window closes. The conditions and 
corresponding actions you specified appear in the Customer Segment Editor 
window’s Characteristics list, as shown in Figure 4-5.

Table 4-1  Instructions for Building Conditions

Condition(s)

Relevant Instructions in the “Building 
Conditions and Queries in the BEA 
E-Business Control Center” chapter

A visitor, HTTP session, HTTP 
request, or an event has specific 
characteristic/properties

“Using the Properties and Visitor Characteristics 
Windows”

Dates and times “Important Note About Dates and Times” (The dates 
and times you set are based on universal time 
[UTC].)

“Using the Date/Time Entry Dialog Boxes”
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Figure 4-5   Customer Segment Editor Window: Characteristics List

9. Save and name the customer segment. The new file is displayed in the list of 
segments.

Modifying a Customer Segment

To modify an existing segment, double-click its name in the Explorer window to open 
it in the Editor. You can modify the description, conditions used, and actions. For more 
information, see “Creating a Customer Segment” on page 4-6.

Warning: If the customer segment you modify is in use by content selectors, 
promotional campaigns, or other objects, modifications to the segment 
will affect every object that refers to that segment. Be certain that the 
modifications you make are in line with your organization’s established 
policies and that you entered the modifications correctly in the E-Business 
Control Center.

Deleting a Customer Segment

Before you delete a segment (by selecting it in the Explorer window and clicking the 
Delete button in the Explorer toolbar), read the following warning.

Warning: As with any deletion you make, be absolutely certain that you select the 
correct customer segment and that you are sure you want to delete it. 
Deleted segments cannot be retrieved. If you delete a customer segment, 
anything that refers to it (content selectors, promotional campaigns, or 
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other objects) will effectively be broken until the segment is dereferenced 
or a segment with the same name is created.
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CHAPTER

5 Retrieving Documents 
with Content Selectors

You can enrich a visitor’s experience on your Web site by providing information that 
matches the visitor’s interests or expectations. Using Content Selectors, you can 
specify conditions under which WebLogic Portal or WebLogic Personalization Server 
retrieves one or more documents from your content management system. For example, 
you can use a Content Selector to encapsulate the following conditions: between May 
1 and May 10, if a customer in the SailingEnthusiast customer segment views this 
page, find and retrieve any documents that describe sailing along the Maine coast.

A document is a graphic, a segment of HTML, or a file that must be viewed with a 
browser plug-in. We recommend that you store most of your Web site’s dynamic 
documents in a content management system because it offers an effective way to store 
and manage information.

A business analyst uses the BEA E-Business Control Center to define the conditions 
that activate a Content Selector and to define the query the Content Selector uses to 
find and retrieve documents. Then, a business engineer uses Content Selector JSP tags 
and a set of other JSP tags that retrieve and display the content targeted by the Content 
Selector. 

This topic includes the following sections:

n About Content Selectors

n Describing Documents in Your Content Management System

n Defining Content Selectors

n Previewing Documents
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About Content Selectors

Content selectors consist of the following elements:

n A set of conditions that determine when the Content Selector queries the content 
management system. The conditions can use such things as the profile of the 
customer who is currently viewing a JSP page, an event that occurs on the page 
or has occurred previously on some other page, or the current time. For a 
complete list of conditions, refer to “Listing of the Available Conditions” in 
“Building Conditions and Queries in the BEA E-Business Control Center.”

Business analysts create and modify the set of conditions in the E-Business 
Control Center. 

n A query that searches the content management system for one or more 
documents. 

Business analysts create and modify the query in the E-Business Control Center.

n A JSP tag that triggers the Content Selector to evaluate its conditions.

To display the documents that the query finds, a business engineer must use an 
additional set of tags. For information about using content-selector tags and other tags 
that display the query results, refer to “Working with Content Selectors” in Guide to 
Building Personalized Applications.

Describing Documents in Your Content 
Management System

The queries that you define for Content Selectors search through the descriptions 
(attributes) that you attach to the documents in your content management system. 
WebLogic Portal and WebLogic Personalization Server let you add any attributes to 
your documents, except the following system attributes, which are generated 
automatically: author, comments, creationDate, description, identifier, 
lockedBy, modifiedBy, modifiedDate, mimeType, name, size, and version.
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You can, for example, create attributes that describe a document’s subject, purpose, 
and category. When you define a query, the E-Business Control Center presents all of 
the attributes that your content management system contains.

We recommend that you analyze your overall personalization strategy and create 
attributes that you can use across customer segments. The more your attributes apply 
to multiple customer segments, the less often you need to create new attributes.  

For information on creating attributes, refer to the documentation for your content 
management system. To learn more about using a content management system with 
WebLogic Personalization Server, refer to “Creating and Managing Content” in the 
Guide to Building Personalized Applications.

Defining Content Selectors

To define a Content Selector, you need the following information:

n A unique name for the Content Selector. A Business Engineer uses JSP tags that 
refer to this name. The Explorer window in the E-Business Control Center lists 
the names of all Content Selectors in your data repository.

n The conditions that activate the Content Selector to search for documents. For a 
description of the conditions that you can use, refer to “Listing of the Available 
Conditions” in “Building Conditions and Queries in the BEA E-Business 
Control Center.”

n The attributes that you use to describe the documents in your content 
management system. 

To define a Content Selector:

1. In the E-Business Control Center, open the application you want to work with.

2. In the E-Business Control Center, choose File → New → Presentation → 
Content Selector. A new Content Selector file opens in the Editor window, as 
shown in Figure 5-1.
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Figure 5-1   The Content Selector Editor

3. In the Description box, enter the intended use of this Content Selector.

The description is displayed at the bottom of the Explorer window when you 
select the file. It also appears when you move the mouse pointer over the name 
of the file in the Explorer window.

4. Click Create/Edit. The Selector Rule window appears, as shown in Figure 5-2.
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Figure 5-2   Create a Query to Display Content

The conditions window is divided into two panes: Conditions and Action. After 
you select a condition, you define the characteristics of that condition in the 
Action pane. For example, if you select the condition, The Visitor Has Specific 
Characteristics, you will define those characteristics from the Action pane.

5. In the Conditions pane, select the condition(s) that will determine when the 
Content Selector is used. 

When you select a condition, a corresponding line of text with hyperlinks 
appears in the Action pane.

For a description of the conditions, see “Listing of the Available Conditions” in 
“Building Conditions and Queries in the BEA E-Business Control Center.”

6. For each condition you selected, click the hyperlinks in the Action pane to 
specify values.

For example, if you selected The Visitor Has Specific Characteristics condition 
as shown in Figure 5-2, click the Is Equal to [value] hyperlink under the bulleted 
phrase, “the visitor has the following characteristics.”
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Depending on the condition and the hyperlink, a window or a dialog box opens. 
Table 5-1 provides a consolidated listing of the conditions and indicates where to 
look if you need detailed instructions for any of the corresponding 
windows/dialog boxes.

7. If you selected more than one condition, decide whether all of the conditions 
must be met for a visitor to belong to the customer segment, or whether a visitor 
can be considered part of the segment when any of the conditions apply. To 
toggle between All and Any, click the All (or Any) hyperlink in the phrase, When 
All of These Conditions Apply.

8. Click the [empty content search] hyperlink under Action pane. (See Figure 5-2.)

Since the content you are trying to access is stored on the server, you are 
prompted for a user name and password. You only need to log in once per 
session. If you are also prompted to enter connection settings, see “Connecting 
to a “Server Outside of the Connection Settings Window” in the “Introduction to 
the BEA E-Business Control Center” chapter.

9. In the Content Search window, create the query that will determine the content 
displayed by the Content Selector. For more information, see “Constructing 
Queries” in the “Building Conditions and Queries in the BEA E-Business Control 
Center” chapter.

Table 5-1  Instructions for Building Conditions

Condition(s)

Relevant Instructions in the “Building 
Conditions and Queries in the BEA 
E-Business Control Center” chapter

The visitor is a member of a 
predefined customer segment

“Using the Select Customer Segments Window”

A visitor, HTTP session, HTTP 
request, or an event has specific 
characteristic/properties

“Using the Properties and Visitor Characteristics 
Windows”

Dates and times “Important Note About Dates and Times” (The dates 
and times you set are based on universal time 
[UTC].)

“Using the Date/Time Entry Dialog Boxes”
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10. Click OK. The Customer Segment conditions window closes. The conditions and 
corresponding actions you specified appear in the Customer Segment Editor 
window’s Characteristics list, as shown in Figure 5-3.

Figure 5-3   Content Selector Editor Window: Selection Rule List

11. Save and name the Content Selector. The new file is displayed in the list of 
Content Selectors.

The Content Selector JSP tags that Business Engineers use refer to this name.

Previewing Documents

You can preview the document(s) you have configured your Content Selectors to 
display. To preview documents:

1. Open the Content Selector that is set up to display the document(s) you want to 
preview.

2. In the Content Selector Editor window, click Create/Edit.

3. In the Content Selector conditions window, click the Content Search hyperlink in 
the Action pane.

If you have not yet logged in to access this feature, you will be prompted to 
enter your user name and password.

4. In the Content Search window, click Preview.

A Web browser will open and display a page of links to the document(s) 
matching the query. Click the relevant links to view the documents you want to 
see.
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CHAPTER

6 Displaying Ads

An integral part of most e-commerce Web sites is displaying advertisements and 
tracking your customers’ responses. With WebLogic Portal and WebLogic 
Personalization Server, you can use ad placeholders to display ads and manage and 
evaluate the effectiveness of your advertising strategy.

Placeholders are predefined areas on a Web page that you can put different 
advertisements and messages in.

Ad placeholders decrease the cost of displaying ads on your site by providing a single 
infrastructure that supports multiple advertising projects that change over time. Once 
a business analyst and a business engineer create a placeholder in a Java Server Page 
(JSP)—giving it a name and establishing its size and location, a business analyst can 
use the E-Business Control Center to add or change the content that goes into the 
placeholder. Because a placeholder is just that—a placeholder—a business engineer 
does not need to modify your Web site’s JSPs to modify your advertising strategy.

If you use WebLogic Portal, you can use ad placeholders to dynamically target ads to 
specific customers as a part of a campaign.

This topic includes the following sections:

n About Ad Placeholders

l Types of Queries That Ad Placeholders Run

l Determining Which Ads Are Displayed

l Types of Documents That Ad Placeholders Display

n Describing Ads in Your Content Management System

n Specifying Display and Clickthrough Behavior

n Creating Ad Placeholder Files

n Previewing Documents
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n Alternatives to Ad Placeholders

n Removing Queries from Placeholders

l Removing Default Queries

l Removing Campaign Queries

About Ad Placeholders

Placeholders are defined in JSPs by the business engineer. In the E-Business Control 
Center, the business analyst creates placeholder files that match the names of the 
placeholders established in the JSPs. The business analyst then adds queries to those 
placeholder files in the E-Business Control Center. For example, the business analyst 
can define a query that searches the content management system for ads that advertise 
pets for the Java Pet Store.

When the application is synchronized from the E-Business Control Center to the 
server, the placeholder files put their queries in their respective placeholders in the 
JSPs. The queries are then run from the JSPs, and the ad content is displayed in the 
Web pages.

You can change the queries that a placeholder runs at any time. For example, as part 
of a special promotion during April, you create a placeholder to display ads in the 
upper right corner of your site or in a navigation bar. In May, you remove the queries 
from the placeholder. In July, you decide to use the same placeholder to display ads for 
a different advertising project.

Figure 6-1 illustrates how placeholders use different types of queries to retrieve ads 
from a content management database and display them in a Web page.
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Figure 6-1   Ad Placeholders

In some cases, a single query can apply to multiple advertisements in the database. For 
example, you can put a query in a placeholder that looks in the ad database for all files 
whose names contain “bird.” In that case, a placeholder with a single query can display 
multiple ads. The following sections explain more about how placeholders handle 
multiple queries or ads.

If you use WebLogic Portal, you can set up campaigns to dynamically put ads in 
placeholders. That feature involves a lot of flexibility, which means it is important to 
think through your ad placeholder strategies. For more information see “Removing 
Queries from Placeholders” on page 6-12 and “Ad Actions” in “Creating and 
Managing Promotional Campaigns.”

For information about adding placeholders to JSPs, see “Working with Ad 
Placeholders” in Guide to Building Personalized Applications.

Types of Queries That Ad Placeholders Run

Ad placeholders can run two types of queries: default queries and campaign queries. 
(Campaign queries are only available with WebLogic Portal.)

n Default Placeholder – When you create a placeholder file in the E-Business 
Control Center to match a placeholder established in a JSP, you can also add a 
query to that placeholder file that stays with the placeholder until you change or 
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remove the query in the E-Business Control Center. Creating a default query for 
a placeholder is a best practice, because it ensures that no matter what, an ad 
will always appear in the placeholder. In fact, a placeholder file is considered 
incomplete in the E-Business Control Center if no default queries are defined for 
it.

A placeholder can run a default query each time a customer loads a page that 
includes the placeholder. For example, you define a default query for a top 
banner placeholder and the placeholder runs the query each time a customer 
loads a page with the top banner. You can also set default queries to not run 
when a query placed by a campaign is present in the placeholder.

n Campaign Placeholder – When you create a campaign, one of the things you 
may most often want to do is trigger campaign-specific ads to appear in 
placeholders. You do this by creating ad queries for the campaign and assigning 
them to existing placeholders. Campaign ad queries are dynamically placed by a 
campaign when a certain action occurs, such as a user logging in who belongs to 
a certain segment of the population (see Figure 6-1).

Here is another example. When a customer adds a handsaw to the shopping cart, 
the campaign places an ad query for miter boxes in the ad placeholder on the 
shopping cart page, and the ad is displayed on the shopping cart page.

Determining Which Ads Are Displayed

To display an ad in a placeholder, the server needs to figure out two things: first, which 
query to run (if multiple queries exist in a placeholder), and second, if the query returns 
multiple ads, which ad to display.

The server uses two factors to determine which query to run:

n Suppressing default queries when campaign queries exist (only if you are using 
WebLogic Portal)

n Using “Priority” to Determine Which Query Is Run

The server uses one factor to determine which ad to use if a query returns multiple ads:

n Using “Ad Weight” to Choose An Ad when a Query Returns Multiple Ads

For more technical information, see “How Placeholders Select and Display Ads”in the 
Guide to Building Personalized Applications.
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Determining Which Query Is Run

Because of the interplay between default placeholders and campaign placeholders, you 
can give campaign scenarios precedence by setting up default placeholders to be 
suppressed if any campaign queries are put in the placeholders. To determine which 
query will be run in a placeholder, the server first looks to see if you have set default 
placeholder queries to be suppressed when campaign queries are present in a 
placeholder (WebLogic Portal only); then, the server compares the priorities set on the 
queries.

Suppressing Default Queries when Campaign Queries Exist

When creating a placeholder file in the E-Business Control Center, the Placeholder 
editor window has an option you can set called, “Do not display default ads if ads 
placed by a campaign apply,” as shown in Figure 6-2.

Figure 6-2   Setting Default Query Options in the Placeholder Editor

Using “Priority” to Determine Which Query Is Run

Only one ad can be displayed in an ad placeholder at any given time. Yet an ad 
placeholder can contain many queries, especially if you use WebLogic Portal with 
multiple campaigns active concurrently. The priority gives a query greater or lesser 
chance that a placeholder runs a query.

To establish your preferences for queries that should run more frequently than other 
queries, you attach a priority to a query when you create it. Before it runs a query, an 
ad placeholder evaluates all of the relative priorities of the queries that it contains. 
Then it gives the queries with higher priorities a greater chance of being selected. On 
average, an ad query with a higher priority will run more frequently than a query with 
a lower priority. However, in any single instance, it is possible that a placeholder runs 
a query with a lower priority than other queries.

You set priority for a default ad query in the Placeholder editor, and you set the priority 
for a campaign query when you create an ad action in the campaign editor, as shown 
in Figure 6-3.
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Figure 6-3   Setting Query Priority

Determining Which Ad Is Chosen

After the server determines which query to run in a placeholder, that query could return 
more than one ad. If this happens, the server needs to determine which ad to display in 
the page.

Using “Ad Weight” to Choose An Ad when a Query Returns Multiple Ads

You can establish your preferences for ads that should be displayed more frequently 
than other ads by creating a document attribute called adWeight in your content 
management system. You assign a higher number to the ads that you want to be 
displayed more frequently.
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For more information about the adWeight attribute, refer to “Ad Attributes in the 
Content Management System” under “Working with Ad Placeholders” in Guide to 
Building Personalized Applications.

Types of Documents That Ad Placeholders Display

By default, ad placeholders can display only the following types of documents:

n XHTML (a fragment or an entire document)

n Images

n Shockwave files

A business engineer can set up WebLogic Portal or WebLogic Personalization Server 
to support additional types of documents. For more information, refer to “Supporting 
Additional MIME Types” under “Working with Ad Placeholders” in the Guide to 
Building Personalized Applications.

Describing Ads in Your Content 
Management System

The queries that you define for ad placeholders search through the descriptions 
(attributes) that you attach to the documents in your content management system. 
WebLogic Portal and WebLogic Personalization Server place no restrictions on the set 
of attributes that you use to describe your ads. For example, you can create attributes 
that describe the name of the product that the document advertises, the name of the ad 
sponsor, and a product category that matches the categories in your e-commerce 
product catalog. When you define a query, the E-Business Control Center lets you 
choose from all of the attributes that your content management currently contains.

We recommend that you analyze your overall advertising strategy and create attributes 
that you can use across several advertising projects. The more your attributes apply to 
multiple advertising projects, the less often you need to create new attributes. In 
addition, review the way in which you define customer segments, and consider 
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creating attributes that complement customer segments. For example, if you define 
customer segments for conservative or aggressive investment portfolios, create an ads 
attribute called “portfolio-type,” and use it to describe investment products that you 
advertise.

If you use WebLogic Portal, your site might run multiple campaigns concurrently, and 
each campaign might define several ad queries for a placeholder. The attributes for 
your ads need to be specific enough that each scenario can define reasonably precise 
queries for the placeholders that they use.

For information on creating attributes, refer to the documentation for your content 
management system. To learn more about using a content management system with 
WebLogic Personalization Server, refer to “Creating and Managing Content” in Guide 
to Building Personalized Applications.

Specifying Display and Clickthrough 
Behavior

In addition to the attributes that placeholder queries use to find documents, ad 
placeholders use a standard set of attributes to do the following:

n Create a target URL for clickthrough behavior on images.

n Determine whether the target for a clickthrough of an image ad is displayed in a 
popup window. The ad placeholder generates the necessary JavaScript to display 
the popup window, and it can generate a link that customers click to close the 
popup window.

n Set the quality parameter for a Shockwave file.

A business engineer, or someone familiar with creating hyperlinks in HTML and with 
developing Shockwave movies, can create these attributes. For information about 
these attributes, refer to “Ad Attributes in the Content Management System” under 
“Working with Ad Placeholders” in Guide to Building Personalized Applications.
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Creating Ad Placeholder Files

After you define attributes for the documents in your content management system, you 
use the E-Business Control Center to define ad placeholder files that match the 
placeholders your business engineer has or will define in your site’s JSPs.

This procedure shows you how to create a placeholder file in the E-Business Control 
Center and how to set up default—not campaign—queries in that placeholder. “Ad 
Actions” in “Creating and Managing Promotional Campaigns” shows how to create 
campaign queries for placeholders.

To create an ad placeholder file:

1. In the E-Business Control Center, open the application you want to work with.

2. Choose File → New → Presentation → Placeholder. A new placeholder file 
opens in the Editor window, as shown in Figure 6-4.

Figure 6-4   Selecting a Display Priority

3. Enter a description for the placeholder in the Description area.
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The description is displayed at the bottom of the Explorer window when you 
select the file. It also appears when you move the mouse pointer over the name 
of the file in the Explorer window.

4. Click New to begin defining a default ad query. A placeholder file is considered 
incomplete if it does not have at least one default query (though you can still save 
the placeholder file).

Note: Since the content you are trying to access is stored on the server, the 
Connection Setup window appears. Select an existing connection in the 
Display Name field, and enter your username and password. If you do not 
have existing connections you can select in the, see “Connecting to the 
Server” in the “Introduction to the BEA E-Business Control Center.” You 
only need to log in once per session when working with placeholders.

For information about setting conditions and actions, see “Constructing Queries” 
in “Building Conditions and Queries in the BEA E-Business Control Center.”

You can create multiple default queries by repeating this step.

If you do not create ad queries for default ads, the placeholder will display only 
ads that are generated by campaign queries. If there are no active campaigns, or 
if an active campaign contains no ad actions within scenarios to trigger an ad for 
a specific customer, then the placeholder remains empty to customers.

5. To change the priority of a default ad query, click the Display Priority column for 
the query and select a priority, as shown in Figure 6-4.

The Display Priority determines the likelihood that the query runs relative to the 
priority of any other queries that are in the placeholder. For more information, 
refer to “Determining Which Query Is Run” on page 6-5.

6. (The options in this step are available only with WebLogic Portal.) To prevent an 
ad placeholder from using default ad queries if it also contains campaign ad 
queries, select the option, “Do not display default ads if ads placed by a campaign 
apply.”

If you want the placeholder to choose among default and campaign ad queries, 
select the option, “Keep default ads in rotation with ads placed by a campaign.” 
This selection potentially reduces the chance that the placeholder displays a 
given ad that is part of a campaign.

For more information, refer to “Suppressing Default Queries when Campaign 
Queries Exist” on page 6-5.
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7. Save and name the placeholder. Be sure to use the name of a placeholder that 
already exists or will exist on a JSP. You can get those names from your business 
engineer.

The new file is displayed in the list of placeholders.

Previewing Documents

You can preview the ads you have configured your placeholders to display. To preview 
ads:

1. Open the placeholder that is set up to display the ads you want to preview.

2. In the Placeholder Editor window, select the query that references the ads you 
want to preview, and click Edit.

If you have not yet logged in to access this feature, you will be prompted to 
enter your user name and password.

If you are asked to supply connection settings, see “Connecting to the Server” or 
“Connecting to the Server” in the “Introduction to the BEA E-Business Control 
Center.”

3. In the Ad Search window, select the query in the Descriptors pane that references 
the document(s) you want to preview.

4. Click Preview.

A Web browser will open and display a page of links to the ads matching the 
query. Click the relevant links in the browser to view the ads you want to see.

Alternatives to Ad Placeholders

If it is essential that a customer see a specific ad in a specific location, a business 
engineer can use an <ad:adTarget> tag instead of an ad placeholder. 

Like an ad placeholder, <ad:adTarget> can do the following:
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n Display the types of documents that are described in “Types of Documents That 
Ad Placeholders Display” on page 6-7.

n Use the display and clickthrough attributes that are described in “Specifying 
Display and Clickthrough Behavior” on page 6-8.

n Use ad weights to choose an ad if a query returns multiple documents, as 
described in “Determining Which Ad Is Chosen” on page 6-6.

However, the <ad:adTarget> is unlike ad placeholders in the following ways:

n It contains its own query in the JSP page; it does not refer to the queries that a 
business analyst creates in the E-Business Control Center. If you want to change 
the query, you must modify the tag in the JSP.

n A campaign action cannot specify a query to run in an <ad:adTarget> tag. 
Actions can only use ad placeholders to run queries.

n Because it contains only a single query, it does not need to use the ad query 
priorities, as described in “Determining Which Query Is Run” on page 6-5.

For more information, refer to <ad:adTarget> under “JSP Tag Library Reference” in 
Guide to Building Personalized Applications.

Removing Queries from Placeholders

There are different ways of removing queries from placeholders, depending on 
whether the queries you want to remove are default or campaign queries.

Removing Default Queries

To remove default queries from a placeholder, open the placeholder in the E-Business 
Control Center, select the query you want to delete, and click Delete, as shown in 
Figure 6-5.
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Figure 6-5   Deleting a Default Query from a Placeholder

It is always good practice to leave at least one default query in a placeholder to ensure 
an ad always appears in that placeholder. In fact, the E-Business Control Center 
considers a placeholder file incomplete if it does not contain at least one query.

Removing Campaign Queries

Removing campaign queries from placeholders is a task that requires planning and an 
understanding of the dynamic nature of the task. See “Clearing Campaign Queries 
from Ad Placeholders” in “Creating and Managing Promotional Campaigns.”
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CHAPTER

7 Defining Stand-Alone 
or Campaign Discounts

This topic contains essential information about discounts as they are used in the BEA 
E-Business Control Center. This information includes a conceptual description of a 
discount, an explanation about how you can use discounts, and step-by-step 
instructions for defining a new discount or modifying existing discounts within the 
E-Business Control Center.

This topic includes the following sections:

n What Is a Discount?

n Uses of Discounts

l Using Discounts as Stand-Alone Discounts

l Using Discounts in Promotional Campaigns

n About Discount Definitions

l Discount Duration

l Discount Types

l Discount Limits

l Discount Priorities

n Defining a New Discount With the Discount Terms Wizard

l Discount Types Available in the Discount Terms Wizard

l Using the Discount Terms Wizard

n Catalog Browser
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l Browsing a Catalog

l Searching a Catalog

n Defining a New Discount With the Discount Editor

l Specify General Discount Information

l Specify Discount Terms

l Establish the Discount Duration and Overall Limit

l Saving, Finalizing, and Synchronizing a Discount

n Locating an Existing Discount

n Modifying an Existing Discount

l Deactivating and Reactivating Discounts

n Deleting an Existing Discount

What Is a Discount?

As you might expect, a discount is a reduction in the price charged for a product item, 
an order, or the shipping cost associated with an order. The E-Business Control Center 
allows you to define discounts that you can offer to your online customers.

Uses of Discounts

This section provides an overview of how you can use discounts after you define them. 
There are two ways to use discounts (designated Usage on the E-Business Control 
Center windows). These ways are described in the following subsections:

n Using Discounts as Stand-Alone Discounts

n Using Discounts in Promotional Campaigns
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Note: Discounts are not available if you have only the BEA WebLogic 
Personalization Server product license.

Using Discounts as Stand-Alone Discounts

Stand-alone discounts are discounts that are offered to everyone shopping at your Web 
site. They are not based on a customer’s behavior or controlled by campaigns. An 
example of a discount used as a stand-alone discount is, “give everyone 10% off 
books.”

As you are defining a stand-alone discount, you may want to provide a discount 
explanation and a discount description. A discount explanation identifies the discount 
to your customers while they are checking out, or at some other time during their 
shopping experience. A discount description will help you identify the discount when 
you are trying to distinguish it from others listed in the E-Business Control Center.

Using Discounts in Promotional Campaigns

As their name implies, campaign discounts are discounts that are intended to be used 
within campaigns and awarded to specific customers under certain conditions, such as 
membership in a customer segment or specific customer behavior. An example of a 
discount used in a promotional campaign is, “if a Gold Customer clicks the 
Take-Advantage-of-This-Special-Offer ad banner, give the customer a 20% discount 
off books.” Discounts can be incorporated into your promotional campaigns like ads 
and e-mails (as actions), and used in conjunction with these promotional messages to 
entice customers to buy your products. 

Since one predefined campaign discount can be applied within multiple campaigns, 
campaign discounts can have multiple discount explanations. A discount explanation 
identifies the discount to your customers while they are checking out, or at some other 
time during their shopping experience. Having multiple discount explanations allows 
you to tailor the text to the specific application of the discount. For campaign 
discounts, you supply the discount explanation as you are creating the discount 
scenario action (rather than during the discount definition, as is the case with 
stand-alone discounts). 
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As with stand-alone discounts, a discount description helps you identify the discount 
when you are trying to distinguish it from others listed in the E-Business Control 
Center.

Note: If you have the WebLogic Portal license and want detailed information about 
how to use discounts within promotional campaigns, see the “Adding 
Scenarios to the Campaign” in Creating and Managing Promotional 
Campaigns.

About Discount Definitions

Regardless of how you intend to use discounts, to make them meaningful for your 
marketing efforts, you need to define discounts using the E-Business Control Center. 
In addition to the discount usage (stand-alone or campaign), discount definitions also 
include the following information: 

n Discount Duration

n Discount Types

n Discount Limits

n Discount Priorities

Discount Duration

The discount duration is the period the discount is offered. It has a specified start date 
and time and a specified stop date and time.

Caution: Stop and start dates on discounts and campaigns are completely 
independent. Using a discount within a campaign does not cause the 
discount to inherit the campaign’s scheduled dates, or visa versa. If a 
discount expires before the campaign has ended, the discount may not be 
awarded at checkout time. BEA recommends that you closely monitor the 
schedules of these objects when assembling campaigns.
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Discount Types

The E-Business Control Center offers three discount types. Before using the 
E-Business Control Center’s discount service, you need to decide which discount type 
to use. Furthermore, each type of discount requires that you identify the items that 
cause the discount to be offered, called trigger items; the items to which the discount 
should be applied, called target items; and the discount value, which is the percentage 
or dollar amount of the discount. The three discount types are:

n Per Item Discounts

n Set-Based Discounts

n Order Discounts

Per Item Discounts

Per item discounts are discounts that apply to individual items in your product catalog. 
Per item discounts can be offered to customers (that is, triggered) based on a 
customer’s purchase of the following:

n Any item (regardless of SKU or product category). 

n Specific items in the product catalog (specified by SKU).

n Any items belonging to a particular product category. 

n A combination of items specified by SKU and product category. 

Per item discounts can apply to (that is, target) the following:

n The same items that triggered the discount offer.

n Any items in the product catalog (regardless of SKU or product category).

n Specific items in the product catalog (specified by SKU).

n Any items belonging to a particular product category. 

n A combination of items specified by SKU and product category. 

As their name implies, per item discounts will be applied per item. For example, you 
may specify that for every item purchased from the product category Sports 
Equipment, customers will receive $5 off every baseball cap purchased. When 
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customers purchase a baseball, a glove, and a bat (all items belonging to the category 
Sporting Equipment, they will be eligible for a discount on each baseball cap. For 
instance, if a customer also purchases two baseball caps, the discount will be $10.

Per item discounts can be specified as a percentage off, an amount off, or a fixed price. 
Table 7-1 lists some possible per item discounts.

 

If you would like to examine other, more complex examples about how per item 
discount definitions affect customer orders, see “Discount Examples”.

Caution: When specifying product items by SKU or category, be sure to enter the 
correct SKU number or category from your product catalog. Failure to 
enter the correct product identification could result in discounts that are 
associated with incorrect product items or categories. To help ensure that 
you enter the correct SKU number or category, use the Catalog Browser. 
For more information, see “Catalog Browser” on page 7-19.

Table 7-1  Per Item Discount Examples

Discount Examples

Percentage off any item. Take 10% off the price of any item in the product catalog.

Fixed amount off any item. Take $5 off the price of any item in the product catalog.

Fixed price for any item. All items cost $10.

Percentage off each specified item. Take 10% off the price of each item with SKU 12345.

Fixed amount off each specified item. Take $5 off each item with SKU 12345.

Fixed price for each specified item. Each item with SKU 12345 costs $10.

Percentage off each item belonging to a specified 
product category.

Take 10% off the price of each item in the Books product 
category.

Fixed amount off each item belonging to a 
specified product category.

Take $5 off the price of each item in the Books product 
category.

Fixed price for each item belonging to a specified 
product category.

Each item in the Books product category costs $10.
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Set-Based Discounts

Set-based discounts are useful when you want to offer a single discount based on the 
customer having a specified set of product items in their shopping cart. Set-based 
discounts can be offered to customers (that is, triggered) based on a customer’s 
purchase of the following:

n Sets of any item (regardless of SKU or product category). 

n Sets of specific items in your product catalog (specified by SKU).

n Sets of product items belonging to a particular category. 

n Sets created by a combination of product items specified by SKU and product 
categories. 

Set-based discounts can apply to (that is, target) the following:

n The same items that triggered the discount offer.

n Any items in the product catalog (regardless of SKU or product category).

n Specific items in your product catalog (specified by SKU)

n Any items belonging to a particular category

n Specific items specified by SKU or product category.

As their name implies, set-based discounts will be applied per set. For example, you 
may specify that for every set of three items purchased from the product category 
Sporting Equipment, customers will receive $5 off a baseball cap. When customers 
purchase a baseball, a glove, and a bat (all items belonging to the Sporting Equipment 
category), they can receive $5 off one baseball cap, for a total discount of $5. Unlike 
the per item discount (described previously) where the customer gets a $10 discount 
for also purchasing two caps, the set-based discount would be $5. 

Set-based discounts can be specified as a percentage off, an amount off, or a fixed 
price. 

Note: Under set-based discounts, if you specify a fixed amount off or a fixed price 
discount, then the discount will be applied to each item in the set, rather than 
to the set as a whole.

Table 7-2 lists some possible set-based discounts.
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If you would like to examine other, more complex examples about how set-based 
discount definitions affect customer orders, see “Discount Examples”.

Caution: When specifying product items by SKU or category, be sure to enter the 
correct SKU number or category from your product catalog. Failure to 
enter the correct product identification could result in discounts that are 
associated with incorrect product items or categories. To help ensure that 
you enter the correct SKU number or category, use the Catalog Browser. 
For more information, see “Catalog Browser” on page 7-19.

Order Discounts

Order discounts are discounts that can apply to a customer’s entire order. Order 
discounts can be offered to customers (that is, triggered) based on the following:

n Any order. 

Table 7-2  Set-Based Discount Examples

Discount Examples

Percentage off a specified set of any items. Take 10% off the price of any set of 3 items.

Fixed amount off a specified set of any items. Take $5 off the price of any set of 3 items.

Fixed price for a specified set of any items. Each set of 3 items costs $10.

Percentage off a specified set of specified items. Take 10% off the price of each set of 3 items with SKU 
12345.

Fixed amount off each set of specified items. Take $5 off each set of 3 items with SKU 12345.

Fixed price for a set of specified items. Each set of 3 items with SKU 12345 costs $10.

Percentage off a specified set of items belonging to a 
specified product category.

Take 10% off the price of each set of 3 items in the Books 
product category.

Fixed amount off each set of items belonging to a 
specified product category.

Take $5 off the price of each set of 3 items in the Books 
product category.

Fixed price for each set of items belonging to a 
specified product category.

Each set of 3 items in the Books product category costs 
$10.
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n A specified order subtotal. 

Order discounts can apply to (that is, target) the following:

n The order total.

n The shipping cost of the order.

Note: For order discounts, there can be only one target. In other words, you can apply 
the order discount to either the order total or the shipping cost.

As their name implies, order discounts are applied per order. For example, you may 
specify that a $5 order discount should apply to orders with subtotals greater than $100. 
When customers place orders with subtotals that are greater than $100, customers will 
receive $5 off their order, for a total discount of $5. 

Order discounts can be specified as a percentage off, an amount off, or a fixed price. 
Table 7-3 lists some possible order discounts.

Caution: As these examples show, you should be very careful when specifying fixed 
price discounts.

Table 7-3  Order Discount Examples

Discount Examples

Percentage off any order. Take 10% off any customer’s order total.

Fixed amount off any order. Take $5 off any customer’s order total.

Fixed price for any order. All orders cost $50.

Percentage off orders with subtotals that meet specified 
criteria.

Take 10% off the order total if the subtotal is greater 
than $100.

Fixed amount off orders with subtotals that meet specified 
criteria.

Take $5 off the order totals if the subtotal is greater 
than $100.

Fixed price for orders with subtotals that meet specified 
criteria.

Orders with subtotals that are greater than or equal to 
$100 cost $100.
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Discount Limits

The E-Business Control Center provides you with several ways to limit the application 
of discounts as you define them. This section describes the following discount 
limitations:

n Overall Limit

n Order Limit

n Minimum Purchase Requirement

Overall Limit

An overall limit specifies the number of orders to which a discount can be applied for 
a given customer. The overall limit can be a value equal to or greater than 1.

For example, if your store offers a 10% discount off books with an overall limit of 2. 
This means that customers can receive the 10% discount for no more than 2 orders 
containing books. If there were no overall limit, customers could return to the Web site 
and place separate orders to receive more discounts. 

Order Limit

As their name implies, order limits define how many times the discount can be used 
per order. You can specify order limits either based on the items that triggered the 
discount, or on the target items to which the discount is applied (which may or may not 
be the same items). For example, you may want to give away 2 DVD movies with the 
purchase of every DVD player you sell, with a limit of one giveaway per order. In this 
case, you would impose the order limit of 1 on the trigger item, the single DVD player. 
Any additional DVD players in the order would not trigger additional discounts; the 
customer would receive only 2 DVD movies free.

Limitations on the items that trigger the discount can be specified as follows:

n A value equal to or greater than 1.

n No limit.
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Note: Order limits on items that trigger discounts are specified in different windows 
in the E-Business Control Center, depending on whether you are working with 
a per item discount or a set-based discount. This is because per item order 
limits apply to each individual item that triggered the discount, while set-based 
order limits apply to a set of items that triggered the discount. 

Limitations on the target items to which the discount is applied can be specified as:

n Up to N items (or sets).

n Exactly N items (or sets).

where N is a value equal to or greater than 1.

Note: For more information about discount types, see “Discount Types” on page 7-5.

Minimum Purchase Requirement

For per-item discounts, you can use the E-Business Control Center to specify a 
minimum purchase requirement. The minimum purchase requirement can be a value 
equal to or greater than 1. Once the minimum requirement has been met in a given 
order, the discount will be earned for each additional item. For example, if the 
minimum purchase requirement is 3 items, customers who buy 5 items will receive 5 
discounts.

Note: Minimum purchase requirements do not apply to other discount types. For 
more information about discount types, see “Discount Types” on page 7-5.

Discount Priorities 

A discount priority is a setting within the E-Business Control Center that allows you 
to specify the relative importance of a discount. The discount priority is a value in the 
range of 1-20, with one being the highest priority. In the event that two or more 
discounts are applicable to a given item, the priority associated with each discount 
resolve the conflict by indicating which discount should be applied. Although no more 
than one discount can be applied to a given item, any remaining discounts may still be 
eligible for application to other items. This process also applies to discounts on entire 
orders. Therefore, you should consider the priority with which each discount will be 
assigned during discount definition time.
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Caution: If two or more discounts have the same priority, the order in which the 
discounts are applied is random. Be sure to follow your organization’s 
established policy for assigning discount priorities if you wish to avoid this 
situation.

Defining a New Discount With the Discount 
Terms Wizard

Initially, you will probably want to use the Discount Terms Wizard to help you define 
new discounts. The Discount Terms Wizard does not duplicate the full function of the 
E-Business Control Center Discount Editor, but it is a quick and easy way to help you 
define the most common discounts.

The Discount Terms Wizard specifies simple discount terms. A discount term is the 
portion of the entire discount definition that indicates which items are discounted, the 
value of the discount, and the qualifying criteria. For example, buy at least 3 DVDs and 
get $2 off each one.

The Discount Terms Wizard does not completely define a discount. Other procedures 
necessary for defining discounts include the following:

n Specify general discount information. See “Specify General Discount 
Information” on page 7-23.

n Establish discount duration and overall limit. See “Establish the Discount 
Duration and Overall Limit” on page 7-34.

n Save and deploy the discount. See “Saving, Finalizing, and Synchronizing a 
Discount” on page 7-35.

Discount Types Available in the Discount Terms Wizard

The following types of discounts are available in the Discount Terms Wizard. Discount 
Language means the language used by the Discount service to define a discount. It is 
the phrasing that appears in the Discount Terms list box.
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Simple Discount

A simple discount is a type of per item discount. 

Minimum Purchase Discount

Buy N, Get 1 Free Discount

Description Buy a product at a reduced price.

Type Per Item Discount.

Example Buy an unlimited number of BEA backpacks at 25% off.

Discount Language For each item where SKU=B123 (no limit) apply a 25% 
discount to each trigger item.

Description Buy a minimum quantity of product and get each at a reduced 
price.

Type Per Item Discount.

Example Buy at least 3 CDs and get $1 off each CD.

Discount Language For each item where Product Category=CD (minimum 
purchase=3, no limit), apply a $1 off discount to each trigger 
item.

Note The limit cannot be less than the minimum purchase 
requirement. 

Description Buy a certain quantity of a product and get one free.

Type Set-based Discount.

Example Buy 5 ties, get 1 free.
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Paired Discount

Paired Set Discount

Bundle Discount

Discount Language For the set of the following items, a set of 5 items where 
Product Category=Tie, apply a 100% discount to each of up to 
1 item(s) where Product Category=Tie.

Description Buy one product and get a price reduction on another product.

Type Per Item Discount.

Example Buy a bicycle and get a helmet at 50% off.

Discount Language For each item where Product Category=Bicycle (limit=1), 
apply a 50% discount to each of up to 1 item(s) where Product 
Category=Helmet.

Description Buy a specified quantity of product and get a price reduction on 
another product.

Type Set-based Discount.

Example Buy 6 bottles of wine and get a wine rack at $10 off.

Discount Language For the set of the following items: a set of 6 items where 
Product Category=Wine, apply a $10 off discount to each of up 
to 1 item(s) where Product Category=Wine Rack.

Description Buy a bundle of products at a reduced price.

Type Set-based Discount.

 Example Buy home, Auto, and life insurance and get 20% off.
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Paired Bundle Discount

Order Discount

Discount Language For the set of the following items: a set of 1 items where 
Product Category=Home and a set of 1 items where Product 
Category=Auto and a set of 1 items where Product 
Category=Life, apply a 20% discount to each trigger item.

Description Buy a bundle of products, get a price reduction on another 
product

Type Set-based Discount.

 Example Buy home and auto insurance and get life insurance at 15% off

Discount Language For the set of the following items: a set of 1 items where 
Product Category=Home and a set of 1 items where Product 
Category=Auto, apply a 15% discount to each of up to 1 item(s) 
where Product Category=Life.

Description Buy a certain total amount, get a price reduction on the order 
total (or shipping cost).

Type Order Discount.

 Example Buy at least $500 worth of services, get 20% off.

Discount Language For any order with a subtotal greater than or equal to $500 
apply a 20% discount to the order total (or the shipping cost).
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Using the Discount Terms Wizard

Note: Before you can use the E-Business Control Center, you must start the 
E-Business Control Center and open an application. For more information on 
starting the E-Business Control Center, see “Starting the E-Business Control 
Center” in the Introduction to the BEA E-Business Control Center.

To specify terms for a simple discount, complete the following steps:

1. In the Explorer window, click the Business Logic tab, as shown in Figure 7-1.

Figure 7-1   Explorer Window: Discounts View
. 

2. To see a list of existing discounts, click the Discounts icon.

3. Click the New button, and then select Discount. The Discount Editor window 
opens.

4. Click the Discount Terms bar. The Discount pane opens, as shown in Figure 7-2. 



Defining a New Discount With the Discount Terms Wizard

Guide to Using the BEA E-Business Control Center 7-17

Figure 7-2   Discount Pane—Start

5. Click the Wizard button. The Discount Terms Wizard window appears, as shown 
in Figure 7-3.

Figure 7-3   Discount Terms Wizard Start Window
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6. Select the type of discount you want from the Discount Type drop-down list, and 
then click the Next button. The window that appears depends on the type of 
discount you selected.

7. Follow the on-screen instructions to define the discount terms.

Note: When selecting items or categories for your discount, be sure to use the 
Catalog Browser. Using this feature helps ensure that you have specified the 
correct SKU number or category. For more information, see“Catalog 
Browser” on page 7-19.

8. After the discount term is defined, a the discount terms are displayed in the 
Discount Terms window, as shown in Figure 7-4.

Figure 7-4   Discount Terms—Finish

After you have specified the terms of a discount, you need to define other discount 
specifications using the E-Business Control Center Discount Editor. 

As previously mentioned, the Discount Terms Wizard does not completely define a 
discount. Other procedures necessary for defining discounts include the following:

n Specify general discount information. See “Specify General Discount 
Information” on page 7-23.
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n Establish discount duration and overall limit. See “Establish the Discount 
Duration and Overall Limit” on page 7-34.

n Save and deploy the discount. See “Saving, Finalizing, and Synchronizing a 
Discount” on page 7-35.

Catalog Browser

The Catalog Browser allows you to easily find and select items for your campaign or 
discount definition. The following sections provide step-by-step instructions on how 
to use the Catalog Browser.

Browsing a Catalog

The browsing feature of the Catalog Browser allows you to select either categories or 
specific items from your catalog. Depending on where the Catalog Browser is opened 
and the type of discount, you can select one or more items or categories.

Notes: You must first establish a connection to your catalog server. For more 
information, see “Connecting to the Server” in the Introduction to the BEA 
E-Business Control Center.

If you switch connections, the data in your catalog browser will be completely 
refreshed. 

1. To open the Catalog Browser, click the Catalog Browser button. 

2. In the Logon dialog window, enter your Username and Password, and then click 
the Connect button. The Catalog Browser opens as shown in Figure 7-5.

3. In the left navigation pane, navigate to the category that contains the item or 
product category that you want to add to your discount or campaign definition.

4. In the right pane, select one or more categories or items.

5. Click the OK button. The items or categories are added to your discount or 
campaign definition.
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Figure 7-5   Catalog Browser

Searching a Catalog

The search feature of the Catalog Browser allows you to find a specific item or 
category from your catalog. You can use a wildcard (*) to help you find items when 
you don’t know the exact SKU.

Note: You must first establish a connection to your catalog server. For more 
information, see “Connecting to the Server” in the Introduction to the BEA 
E-Business Control Center.

1. To open the Catalog Browser, click the Catalog Browser button.

2. Click the Search button. The Search window opens as shown in Figure 7-6.

3. Enter the Category or SKU in the corresponding field, and then click the Search 
button. Use an asterisk (*) for wildcard searches.

Note: When searching for a category, only the category field is available.

4. After the search list appears in the left pane, select the desired Category or SKU 
from the left pane.

5. Click OK. The items or categories are added to your discount or campaign 
definition. 
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Figure 7-6   Catalog Browser Search

Defining a New Discount With the Discount 
Editor

This section provides step-by-step instructions for defining discounts. Using the 
discount editor you can define more complex discounts than you can with the Discount 
Terms Wizard. If you have already defined discounts and need to edit them, see 
“Modifying an Existing Discount” on page 7-39.

Note: Before you can use the E-Business Control Center, you must start the 
E-Business Control Center and open an application. For more information on 
starting the E-Business Control Center, see “Starting the E-Business Control 
Center” in the Introduction to the BEA E-Business Control Center.

To define a new discount, follow these steps:

1. In the Explorer window, click the Business Logic tab, as shown in Figure 7-7.
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Figure 7-7   Explorer Window: Discounts View
. 

2. To see a list of existing discounts, click the Discounts icon.

3. Click the New button, and then select Discount. The Discount Editor window 
opens.

4. In the Discount Editor window, follow the steps provided in the following 
sections to:

l Specify General Discount Information

l Establish the Discount Duration and Overall Limit

l Specify Discount Terms

l Saving, Finalizing, and Synchronizing a Discount
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Specify General Discount Information

1. Click the General bar. The General pane opens, as shown in Figure 7-8.

Figure 7-8   General Pane

2. Select a Usage option by clicking either the Stand-Alone or Campaign radio 
button.

3. If you selected the Stand-Alone usage, you may want to enter an explanation of 
the discount for your customers in the corresponding field. If your page design 
(Java Server Pages) shows the information in this field, it will be displayed to 
customers receiving the discount.

4. Specify the priority for the discount by entering a number in the Priority field. 

Note: A priority of 1 is the highest priority you can assign to a discount. For more 
information about how discount priorities are used, see “Discount 
Priorities” on page 7-11.

5. You may want to provide a description of the discount in the Description text 
area. This description can be useful for future identification of the discount in the 
E-Business Control Center.

6. To close the pane, click the General bar. 

Specify Discount Terms

1. Click the Discount Terms bar. The Discount Terms pane opens, as shown in 
Figure 7-9.
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Figure 7-9   Discount Terms Pane

2. Select the corresponding radio button for Per Item, Set-based, or Order discount 
types.

Warning: After you select a discount type, you cannot switch to a different type 
without losing your discount terms. Be sure to select the correct 
discount type. For more information about the available discount types, 
see “Discount Types” on page 7-5.

3. Depending on the discount type you selected in the previous step, follow the 
steps described in:

l Per Item Discounts

l Set-Based Discounts

l Order Discounts

Per Item Discounts

To define the discount terms, complete the following steps:

1. Click the Add a Trigger button. The Specify Trigger Items window appears, as 
shown in Figure 7-10.
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Figure 7-10   Specify Trigger Items Window

2. Select a discount trigger option by clicking either the Any Items or Specific Items 
radio button. 

For example, if you select the Any Items option, customers having any product 
items in their shopping cart (regardless of what these items are) would qualify 
for the discount. If you select the Specific Items option, customers having only 
the items you specify (by SKU number or product category) in their shopping 
cart would qualify for the discount.

3. If you selected Specific Items in the previous step, complete the following steps 
to specify which items trigger the discount:

a. Select either SKU or Category from the drop-down list.

b. Enter the SKU or category from your product catalog into the corresponding 
field. 

Note: When selecting items or categories for your discount, be sure to use the 
Catalog Browser. Using this feature helps ensure that you have specified 
the correct SKU number or category. For more information, see “Catalog 
Browser” on page 7-19.
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c. Click the Add button. The trigger items that you specified appear in the text 
area below. Repeat this process for each item you want to use as a trigger item.

Note: If you specify more than one trigger item (either by SKU or category), any 
of those items present in a customer’s shopping cart will qualify the 
customer for the discount. In other words, multiple trigger items—those 
shown on the same line in the Discount Terms list—are treated as 
alternates.

4. Specify the order limit for the discount by selecting either the Limit or No Limit 
radio button.

Note: The order limit specifies how many times per order the discount can be 
applied.

5. If you specified an order limit, enter the limit value in the corresponding field. 

6. If desired, change the value in the Minimum Purchase Requirement field from 1 
to another numeric value.

Note: The order limit must be greater than or equal to the minimum purchase 
requirement.

7. Click OK. The Specify Trigger Items window closes, and the first phrase shown 
in the Discount Terms list changes to reflect your choices.

Note: To specify additional triggers, repeat steps 1 through 6.

8. Click the Add a Discount button. The Specify Discount Value window opens, as 
shown in Figure 7-11.

Figure 7-11   Specify Discount Value Window

9. Select a discount value, and then enter the percent, amount, or price of the item in 
the corresponding field. You can choose a Percentage off, an Amount off, or a 
Fixed Price discount.

Note: You do not need to type the % or currency symbols into the fields. 
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10. If required, choose the type of currency from the corresponding drop-list. Be sure 
to select the same currency type that you use for the items in your catalog and for 
shipping charges.

11. Click OK. The Specify Discount Value window closes, and the second phrase 
shown in the Discount Terms list changes to reflect your choices.

12. Click Add a Target. The Specify Target Items window opens, as shown in 
Figure 7-12.

Figure 7-12   Specify Target Items Window

13. Select whether you want the discount to target the same items that triggered the 
discount (specified in steps 2 and 3), to any items, or to specific items.

14. If you selected Specific Items in the previous step, complete the following steps 
to specify the items to which the discount will apply. 

a. Select SKU or Category from the drop-down list.

b. Enter the SKU or category from your product catalog into the corresponding 
field.
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Note: When selecting items or categories for your discount, be sure to use the 
Catalog Browser. Using this feature helps ensure that you have specified 
the correct SKU number or category. For more information, see “Catalog 
Browser” on page 7-19.

c. Click the Add button. The target items you specify appear in the text area 
below. Repeat this process for each item you want to use as a target item.

Note: If you specify more than one target item (either by SKU or category), any 
of the items present in a customer’s shopping cart will be discounted. In 
other words, multiple target items—those shown on the same line in the 
Discount Terms list—are treated as alternates.

Tip: If you make a mistake, click the target item shown in the text area to 
highlight it, and then click the Remove button.

15. If you selected Any Items or Specific Items in step 13, select a Limitation. You 
can apply the discount to target items up to a certain limit or to exactly some 
number of target items. For either option, provide a numeric value in the 
appropriate field. 

16. Click the OK button. The Specify Target Items window closes, and the third 
phrase shown in the Discount Terms list changes to reflect your choices.

Note: To specify additional targets, repeat steps 13 through 15.

17. To close the Discount Terms pane, click the Discount Terms bar.

Set-Based Discounts

To define a set-based discount, complete the following steps:

1. Specify the order limit for the discount by selecting either the Limit or No Limit 
radio button.

Note: The order limit specifies how many times per order a set of trigger items 
can be used to qualify for the discount.

2. If you chose an order limit, enter a limit value in the corresponding field.

3. Click the Add a Trigger button. The Specify Trigger Sets window appears, as 
shown in Figure 7-13.
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Figure 7-13   Specify Trigger Sets Window

4. Enter the number of items that will constitute a set into the field. This is the 
number of items that must be purchased to qualify for the discount.

5. Specify how the discount is triggered by clicking the corresponding radio button. 
You can trigger the discount based on sets of any items or sets of specific items.

6. If you selected Specific Items in the previous step, you need to indicate which 
items will trigger the discount, as indicated in the following steps. 

a. Select SKU or Category from the drop-down list.

b. Enter the SKU or category from your product catalog into the corresponding 
field.

Note: When selecting items or categories for your discount, be sure to use the 
Catalog Browser. Using this feature helps ensure that you have specified 
the correct SKU number or category. For more information, see “Catalog 
Browser” on page 7-19.

c. Click the Add button. The trigger items you specify appear in the text area 
below. Repeat this process for each item you want to use as a trigger item.

Note: If you specify more than one trigger item in the Specify Trigger Items 
window (either by SKU or category), any of those items present in a 
customer’s shopping cart will qualify the customer for the discount. In 
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other words, multiple trigger items—those shown on the same line in the 
Discount Terms list—are treated as alternates.

Note: If you make a mistake, select the trigger item shown in the text area to 
highlight it, and then click the Remove button.

7. Click the OK button. The Specify Trigger Sets window closes, and the first 
phrase shown in the Discount Terms list changes to reflect your choices.

Note: To specify additional triggers, repeat steps 2 through 6.

8. Click the Add a Discount button. The Specify Discount Value window opens, as 
shown in Figure 7-14.

Figure 7-14   Specify Discount Value Window

9. Select a discount value. You can choose a Percentage Off, an Amount Off, or a 
Fixed Price discount. Enter the percent, amount, or price of the item in the 
corresponding field.

Note: You do not need to type the % or currency symbols into the fields.

10. If required, choose the type of currency from the corresponding drop-list. Be sure 
to select the same currency type that you use for the items in your catalog and for 
shipping charges.

11. Click OK. The Specify Discount Value window closes, and the second phrase 
shown in the Discount Terms list changes to reflect your choices.

12. Click Add a Target. The Specify Target Items window opens, as shown in 
Figure 7-15.
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Figure 7-15   Specify Target Items Window

13. Select whether you want the discount to target the same items that triggered the 
discount (as specified in steps 4 and 5), to any items, or to specific items.

14. If you selected Specific Items in the previous step, complete the following steps 
to specify the items to which the discount will apply. 

a. Select SKU or Category from the drop-down list.

b. Enter the SKU or category from your product catalog in the corresponding 
field.

Note: When selecting items or categories for your discount, be sure to use the 
Catalog Browser. Using this feature helps ensure that you have specified 
the correct SKU number or category. For more information, see “Catalog 
Browser” on page 7-19.

c. Click Add. The target items you specify appear in the text area below. Repeat 
this process for each item you want to use as a target item.
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Note: If you specify more than one target item (either by SKU or category), any 
of the items present in a customer’s shopping cart will be the discounted. 
In other words, multiple target items—those shown on the same line in the 
Discount Terms list—are treated as alternates.

Tip: If you make a mistake, click the target item shown in the text area to 
highlight it, and then click Remove.

15. If you selected Any Items or Specific Items in step 11, select a Limitation. You 
can apply the discount to target product items up to a certain limit, or to exactly 
some number of target items. For either option, provide a numeric value in the 
appropriate field. 

16. Click OK. The Specify Target Items window closes, and the third phrase shown 
in the Discount Terms list changes to reflect your choices.

Note: To specify additional targets, repeat steps 11 through 15.

17. To close the Discount Terms pane, click the Discount Terms bar.

Order Discounts

If you selected the Order discount type, complete these steps to provide the specifics 
of the discount:

1. Click Add a Trigger. The Specify Trigger Subtotal window appears, as shown in 
Figure 7-16.

Figure 7-16   Specify Trigger Subtotal Window

2. Specify that the discount should triggered when an order subtotal meets a certain 
criteria, or that the discount should apply to any order. If you select Order 
Subtotal, use the drop-down list and corresponding field to specify the 
comparison and subtotal value.
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Note: You do not need to type the $ symbol into the field.

3. Click OK. The Specify Trigger Subtotal window closes, and the first phrase 
shown in the Discount Terms list changes to reflect your choices.

4. Click Add a Discount. The Specify Discount Value window opens, as shown in 
Figure 7-17.

Figure 7-17   Specify Discount Value Window

5. Select a discount value, and then enter the percent, amount, or price of the item in 
the corresponding field. You can choose a Percentage off, an Amount off, or a 
Fixed Price discount.

Note: You do not need to type the % or currency symbols into the fields.

6. If required, choose the type of currency from the corresponding drop list. Be sure 
to select the same currency type that you use for the items in your catalog and for 
shipping charges.

7. Click the OK button. The Specify Discount Value window closes, and the second 
phrase shown in the Discount Terms list changes to reflect your choices.

8. Click the Add a Target button. The Specify Order Discount Target window opens, 
as shown in Figure 7-18.
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Figure 7-18   Specify Order Discount Target Window

9. Select a radio button to apply the discount to either the order total or to the 
shipping cost.

10. Click the OK button. The Specify Order Discount Target window closes, and the 
third phrase shown in the Discount Terms list changes to reflect your choices.

11. To close the Discount Terms pane, click the Discount Terms bar.

Establish the Discount Duration and Overall Limit

1. Click the Start/Stop bar. The Start/Stop pane opens, as shown in Figure 7-19.

Figure 7-19   Start/Stop Pane

2. Enter a start date, start time, stop date, and stop time for your discount in the 
fields provided.

Tip: For the start and stop date, you can either type in the date, or click the 
drop-down list to select the date from a calendar, as shown in Figure 7-20. 
Click a date to select it.
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Figure 7-20   Start/Stop Date Calendar

3. Specify the overall limit for the discount by selecting either the Limit or No Limit 
radio button.

Note: Recall that the overall limit is a limit on the number of orders to which the 
discount can be applied.

4. If you chose an overall limit, enter a limit value in the corresponding field.

Caution: Before selecting the Finalize This Discount check box, read “Saving, 
Finalizing, and Synchronizing a Discount” on page 7-35. For now, skip 
over this option.

5. To close the pane, click the Start/Stop bar.

Saving, Finalizing, and Synchronizing a Discount

This section discusses the differences between saving, finalizing, and synchronizing a 
discount. It also provides guidance and instructions to accomplishing these tasks. 
These features are defined in the following list:

n Saving a discount is like saving a file like in any other software program. Saving 
a discount saves the discount to your local file system. You can save a discount 
whether it is complete or not. The only requirement is that the discount has a 
unique name. 

n Finalizing a discount prevents all parts of the discount definition from being 
changed except for the Discount Priority, the stop dates and time, and the 
Deactivate this discount option. Before a discount can be finalized, the discount 
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must be complete. The E-Business Control Center does not allow incomplete 
discounts to be finalized.

n Synchronizing a discount copies the discount file to the server designated in the 
Synchronization Setup window. Synchronization deploys the discount to your 
enterprise application. If you synchronize a discount that has not been finalized, 
it will not function.

Requirements for Saving and Finalizing a Discount

To save a discount, the only information you need to specify is a unique name. 

To finalize a discount, however, you must be sure to specify each of the following:

n Name

n Discount usage (stand-alone or campaign)

n Discount priority (1-20)

n Overall limit

n Start/stop dates and times

n Discount trigger items

n Discount target items

n Discount value (percent off, amount off, or fixed price)

Saving a Discount

To save a discount, complete the following steps:

1. Click the Save icon on the E-Business Control Center toolbar. 

2. In the Save As window, enter a unique name for the discount. The name of the 
new discount appears in the Discounts list of the Explorer window, as shown in 
Figure 7-21.

Note: If you do not see the discount, click the Discounts icon in the Explorer 
window on the Business Logic tab.
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Figure 7-21   Explorer Window: Discounts View

Tip: Single-clicking the discount name will cause its description to appear at the 
bottom of the Explorer window. 

Tip: Holding the mouse over the discount name will also show you the discount 
description.

Finalizing a Discount 

To finalize a discount, complete the following steps:

1. Open the Start/Stop pane.

2. Select the Finalize this discount check box.

Caution: Do not check the Finalize This Discount box unless you are absolutely 
positive that the discount you are defining is exactly as you want it. 
After discount definitions are finalized, modifications to the discount 
are extremely restrictive. For more information about the items you can 
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change after finalizing and synchronizing the discount, see “Modifying 
an Existing Discount” on page 7-39. Remember, you can always return 
to the Start/Stop pane and finalize the discount at another time.

3. Save the discount.

Synchronizing a Discount

Before synchronizing a discount, make sure that the discount definition is complete, 
that the Finalize This Discount check box in the Start/Stop pane is checked, and the 
discount has been saved. If these requirements are not met, the discount will not work.

To synchronize a discount, use the Tools → Synchronize menu option. Synchronizing 
is an important step that requires well-thought-out planning and processes. The 
following sources provide the necessary information:

n For complete information about deployment, see the Deployment Guide.

n For information about setting up your development environment, see “Milestone 
4: Set Up a Development Site” in the Strategies for Developing E-Business Web 
Sites documentation.

n For information about connecting to the server, see “Connecting to the Server” 
in the Introduction to the BEA E-Business Control Center.

n For the procedures on synchronizing, see “Deploying Application Data” in the 
Deployment Guide.

Warning: If you and other developers concurrently synchronize data to a single 
enterprise application, it is possible to overwrite each others’ work or 
create sets of changes that are incompatible and difficult to debug. To 
prevent this possibility, synchronize to separate instances of your 
application. For more information on how to set up your development 
environment, see “Milestone 4: Set Up a Development Site” in the 
Strategies for Developing E-Business Web Sites documentation.
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Locating an Existing Discount

If you have defined numerous discounts, it can be time consuming to locate a particular 
discount by simply looking in the Discounts list. Therefore, the E-Business Control 
Center provides you with a mechanism to filter existing discounts by name.

To locate an existing discount using the name filter, complete these steps:

1. Click the Discount icon in the Explorer window on the Business tab. This enables 
the Discounts view and a list of discounts appears in the Discounts list.

2. In the Name Filter field (shown in Figure 7-22), type the name of the discount 
you want to locate.

Figure 7-22   Name Filter Field

Note: You can type full or partial names into the Name Filter field. Discount 
names are case sensitive. Therefore, filtering based on the text “Sale” will 
not locate discounts with names that start with “sale.”

3. Click the Filter icon. The discounts that have names beginning with the text you 
entered appear in the Discounts list.

Note: To return to the full list of discounts, click the Show All Objects icon.

Modifying an Existing Discount

The E-Business Control Center also allows you to view and modify existing discounts. 
If a discount has not yet been finalized, you can modify any information about the 
discount. If the discount has been finalized, you can only modify the following:

n Discount Priority
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n Discount Stop Date/Time

n Activation State

Note: For more information about activation state, see “Deactivating and 
Reactivating Discounts” on page 7-41.

Regardless of whether the discount has been finalized, you will need to open the 
discount for modification. To open an existing discount for modification, complete 
these steps:

1. If necessary, switch to the Discounts view by clicking the Discount icon in the 
Explorer window on the Business Logic tab. A list of discounts appears in the 
Discounts list.

2. Click the name of the discount you want to modify. The discount is highlighted.

Tip: If there is a long list of discount names, use the name filter to locate the 
discount that you want to modify. For more information about the name 
filter, see “Locating an Existing Discount” on page 7-39.

3. Click the Open icon on the Explorer toolbar. The Discount Editor opens.

Tip: You can also open the discount by double-clicking on the discount name.

4. If the discount you opened has not yet been finalized, you can modify any part of 
the discount definition, except for the discount name. Follow the same 
instructions for defining a new discount, starting from “Specify General Discount 
Information” on page 7-23.

5. If the discount you opened has already been finalized, follow these steps:

l To change the discount priority, open the General pane, and then enter a new 
priority in the Priority field.

l To change the discount stop date or time, open the Start/Stop pane, and then 
enter a new stop date and/or stop time in the Stop Date/Stop Time fields.

l To deactivate a discount, open the Start/Stop pane, and then click the 
Deactivate This Discount check box.

Tip: For the stop date, you can either type in the date, or click the drop-down 
list to select the date from a calendar. Click a date to select it.

Note: For more information about deactivating discounts, see “Deactivating and 
Reactivating Discounts” on page 7-41.
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6. To save your modifications, click the Save button on the E-Business Control 
Center toolbar.

Caution: If the discount you modify is in use by a promotional campaign, saving 
modifications to the discount will affect every scenario action that refers to 
that discount. Be certain that the modifications you make are in line with 
your organization’s established policies and that you entered the 
modifications correctly in the E-Business Control Center.

Deactivating and Reactivating Discounts

Once discounts are synchronized, they are considered active. In other words, 
synchronized discounts are working on your enterprise application. 

To stop offering a discount, complete these steps:

1. In the Start/Stop pane, check the Deactivate This Discount check box.

2. Save the discount.

3. Synchronize the discount. If a customer order was already associated with the 
discount you just deactivated, the system will still honor the discount. However, 
no new offers of the discount will be made.

If at any time you want to reactivate a discount, complete these steps:

1. In the Start/Stop pane, click the Deactivate This Discount check box to remove the 
check mark. 

2. Save the discount.

3. Synchronize the discount. It is reactivated.

Note: Deactivating a discount will not release the modifications restrictions placed 
on finalized discounts.
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Deleting an Existing Discount

If no pending offers or customer orders are associated with a discount, you can also 
delete existing discounts using the E-Business Control Center. 

Warning: BEA recommends that you do not attempt to delete discounts until the 
discount has expired (that is, the end date associated with the discount is 
reached) and until any orders associated with the discount have cleared. 
And, as with any deletion you make, be absolutely certain that you select 
the correct discount and that you are sure you want to delete it. Deleted 
discounts cannot be retrieved.

To delete an existing discount, complete these steps:

1. If necessary, switch to the Discounts view by clicking the Discount icon in the 
Explorer window) on the Business Logic tab. A list of discounts appears in the 
Discounts list.

Tip: If there is a long list of discount names, use the name filter to locate the 
discount that you want to delete. For more information about the name 
filter, see “Locating an Existing Discount” on page 7-39.

2. Click the name of the discount you want to delete. The discount is highlighted.

3. To delete the discount, click the Delete icon on the Explorer toolbar.

Note: If the discount you are trying to delete is currently associated with a pending 
offer or a customer order, a message is displayed and you will not be able to 
delete the discount. This feature prevents errors in the system if the discount 
is still in use.
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CHAPTER

8 Discount Examples

This topic contains example discounts that are intended to illustrate how different 
discounts function under different circumstances.  The examples cover a range of per 
item and set-based discounts of varying complexity and forms.  They are not meant to 
be exhaustive in terms of covering all the possible discount combinations, but they 
cover a few basics and show cases where the semantics may not be immediately 
obvious.  The further down the example is listed in this document, the more complex 
the example will be.

This topic contains the following sections:

n Per Item Discount Examples

l A Simple Per Item Discount

l A Simple Per Item Discount with a Limit

l A Per Item Discount with a Minimum Purchase Requirement and Limit

l Using Different Triggers and Targets

l Discounting More Than One Target Item

l Discounting an Exact Quantity of Target Items

l Using Alternate Trigger Items

l Requiring More Than One Trigger Item

l Requiring More Than One Trigger (Each with Alternatives), and Having 
Alternate Targets

l Using Multiple Required Targets

n Set-Based Discount Examples

l Buy Two Get One Free

l Percentage Off Discounting of a Set of Items
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l Amount Off Discounting of a Set of Items

l Fixed Price Discounting of a Set of Items

l Using Multiple Trigger Sets

l Using Multiple Trigger Sets, with Quantities of Target Items Greater Than 
One

l Using Multiple Trigger Sets, with an Exact Quantity of Target Items

Per Item Discount Examples

This subsection contains several examples that help illustrate how per item discounts 
work.  In each example, the discount terms (as they would appear in the Discount 
Terms pane of the Discount Editor window) are shown, and then one or more situations 
in which a customer may receive the discount as a result of the discount definition are 
provided.

A Simple Per Item Discount

For each item where SKU=T123 (no limit)
apply a 15% discount to
each trigger item.

n If a customer has 5 items of SKU equal to T123 in their shopping cart, the 
customer will receive 15% off each item.

A Simple Per Item Discount with a Limit

For each item where SKU=T123 (limit 3)
apply a 15% discount to
each trigger item.

n If a customer has 5 items of SKU equal to T123 in their shopping cart, the 
customer will receive 15% off 3 of the items.
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A Per Item Discount with a Minimum Purchase 
Requirement and Limit

For each item where Product Category=DVD (minimum purchase 3, limit 
6)
apply a 15% discount to
each trigger item.

n If a customer has 2 items of Product Category equal to DVD in their shopping 
cart, none of the items will be discounted.

n If a customer has 5 items of Product Category equal to DVD in their shopping 
cart, the customer will receive 15% off each of the items.

n If a customer has 8 items of Product Category equal to DVD in their shopping 
cart, the customer will receive 15% off 6 of the items.

Tip: You could use this format as a range to specify tiered discounts.  If a customer 
purchases between 1 and 10 items, you may want to offer the customer a 5% 
discount.  If the customer purchases between 11 and 20 items, you may want 
to offer the customer a 10% discount, and so on.

Using Different Triggers and Targets

For each item where SKU=T123 (no limit)
apply a 15% discount to
each of up to 1 item(s) where SKU=T444.

n If a customer has 5 items of SKU equal to T123 and 7 items of SKU equal to 
T444 in their shopping cart, the customer will receive a 15% discount on 5 of 
the T444 items.

Discounting More Than One Target Item 

For each item where SKU=T123 (limit 3)
take $5 off
each of up to 2 item(s) where SKU=T444.
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n If a customer has 5 items of SKU equal to T123 and 9 items of SKU equal to 
T444 in their shopping cart, the customer will receive $5 off 6 of the T444 
items.

Note: Since there is a limit of 3 on the trigger items, only 3 discounts are earned; each 
discount earned can apply to 2 of the target items.  This comes out to 6 items  
having their price adjusted.

Discounting an Exact Quantity of Target Items

For each item where SKU=T123 (limit 3)
apply a 5% discount to
each of exactly 2 item(s) where SKU=T444.

n If a customer has 5 items of SKU equal to T123 and 5 items of SKU equal to 
T444 in their shopping cart, the customer will receive 5% off 4 of the T444 
items.

Note: Since there is a limit of 3 on the trigger items, only 3 discounts are earned.  
Each discount earned must be applied to exactly 2 of the target items.  After 
the first two pairs of T444 are discounted, there is only one item left over, 
rather than a complete pair; hence the remaining item is not discounted.

Using Alternate Trigger Items

For each item where SKU=T123 or SKU=T456 (no limit)
set a price of $10 on
each trigger item.

n If a customer has 4 items of SKU equal to T123 in their shopping cart, the 
customer will receive each of the items for $10.

n If a customer has 3 items of SKU equal to T456 in their shopping cart, the 
customer will receive each of the items for $10.

n If a customer has 2 items of SKU equal to T123 and 5 items of SKU equal to 
T456 in their shopping cart, the customer will receive each of the items for $10.
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Tip: You might do this when you have items that you want to treat as 
interchangeable, as far as the discount is concerned.

Requiring More Than One Trigger Item

For each item where Product Category=DVD Player (no limit)
and where SKU=Theater Sound Receiver (no limit)

apply a 50% discount to

each of up to 2 item(s) where Product Category=DVD

n If a customer has 1 DVD player and 5 DVDs in their shopping cart, then the 
customer will receive no discounts.

Note: A customer must have both the DVD Player and the Theater Sound 
Receiver to qualify for the discount.

n If the customer has 1 DVD player, 1 Theater Sound Receiver, and 5 DVDs in 
their shopping cart, they will receive 4 of the DVDs at 50% off.

Note: The customer had both the DVD Player and the Theater Sound Receiver in 
their shopping cart, so the customer qualified for two discounts: one for 
each item.  Since each discount can be applied to up to 2 DVDs, 4 of the 5 
DVDs in the customer’s cart have their prices adjusted to 50% off.

n If the customer has 2 DVD players, 1 Theater Sound Receiver, and 5 DVDs in 
their shopping cart, the customer will receive all 5 DVDs at 50% off.

Note: Since there was no limit placed on the DVD players, this trigger condition 
is met if one or more DVD players is purchased, and a discount is earned 
for each one purchased (with the stipulation that at least one Theater Sound 
Receiver is also purchased).  Therefore, in this example, up to 6 DVDs 
could have been purchased at 50% off.
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Requiring More Than One Trigger (Each with 
Alternatives), and Having Alternate Targets

For each item where Product Category=DVD Player or Product 
Category=VCR (no limit)
and where Product Category=Theater Sound Receiver or Product 
Category=Stereo Receiver or Product Category=Shelf Stereo System 
(no limit)

apply a 50% discount to

each of up to 2 item(s) where Product Category=DVD or Product 
Category=Movie (videocassette)

n If the customer has 1 VCR player, 1 Theater Sound Receiver, and 7 movies (on 
video) in their shopping cart, the customer will receive 4 of the movies at 50% 
off.

Note: The customer had both the DVD Player and the Theater Sound Receiver in 
their shopping cart, so the customer qualified for two discounts: one for 
each item.  Since each discount can be applied to up to 2 movies, 4 of the 
5 videos in your cart have their prices adjusted to 50% off.

n If the customer has 1 VCR player, 1 DVD Player, and 7 movies (on video) in 
their shopping cart, the customer will receive no discounts.

Note: The customer must have either a DVD player or a VCR, as well as either a 
Theater Sound Receiver, Stereo Receiver, or Shelf Stereo System, to 
qualify for the discount.  Since the customer had 2 items from the former 
group, but none from the latter, the customer will not receive any 
discounts.

n If the customer has 2 DVD Players, a Theater Sound Receiver, a Shelf Stereo 
System, and 7 DVDs in their shopping cart, the customer will receive all 7 of the 
DVDs at 50% off.  If the customer had purchased 10 DVDs, 8 of them would 
have been priced at 50% off.
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Using Multiple Required Targets

For each item where Product Category="Bicycle Frame" (limit 1)

apply a 25% discount to

each of exactly 2 item(s) where Product Category="Bicycle Tires"
and each of up to 1 item(s) where Product Category="Bicycle Seat"

n If the customer has 1 Bicycle Frame, 2 Bicycle Tires, and 1 Bicycle Seat in their 
shopping cart, the customer will receive the tires and seat at 25% off.

n If the customer has 1 Bicycle Frame, 1 Bicycle Tires, and 1 Bicycle Seat in their 
shopping cart, the customer will receive no discount, since the discount must 
apply to exactly 2 tires as well as 1 seat.

n If the customer has 2 Bicycle Frames, 4 Bicycle Tires, and 2 Bicycle Seats in 
their shopping cart, the customer will receive 2 tires and 1 seat at 25% off.

Note: Since there is a limit of 1 on the the bicycle frames, the discount on the tires 
and seats can only be earned once per order.

Set-Based Discount Examples

This subsection contains several examples that help illustrate how set-based discounts 
work.  In each example, the discount terms (as they would appear in the Discount 
Terms pane of the Discount Editor window) are shown, and then one or more situations 
in which a customer may receive the discount as a result of the discount definition are 
provided.

Buy Two Get One Free

Note: In this example, assume that the limit is set to 2.
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For the set of the following items: a set of 2 items where SKU=T123
apply a 100% discount to
each of up to 1 item(s) where SKU=T123

n If the customer has 3 items of SKU equal to T123 in their shopping cart, then 
the customer will receive one for free.

Note: The same SKU was repeated in the target phrase rather than indicating that 
the discount be applied to the trigger items.  Had the latter option been 
selected, the set of two trigger items would have been free.

n If the customer has 5 items of SKU equal to T123 in their shopping cart, then 
the customer will receive 1 for free.

Note: After getting the third item for free, the fourth and fifth items qualified for 
another discount but there was no additional item to discount.  Had there 
been a sixth item of SKU equal to T123, it would have been free.

n If the customer has 9 items of SKU equal to T123 in their shopping cart, the 
customer will receive 2 for free.

Note: Since there is a limit of 2, the discount can only be earned twice per order.  
For set-based discounts, the limit is not displayed in the Discount Terms 
pane, but above it, near the Set-Based Discount option.

Percentage Off Discounting of a Set of Items

For the set of the following items: a set of 2 items where SKU=T123
apply a 10% discount to
each trigger item.

n If the customer has 2 items of SKU equal to T123 in their shopping cart, the 
customer will receive each item for 10% off.

Amount Off Discounting of a Set of Items

For the set of the following items: a set of 2 items where SKU=T123
take $10 off
each trigger item.
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n If the customer has 2 items of SKU equal to T123 in their shopping cart, the 
customer will receive each item for $10 off.

Fixed Price Discounting of a Set of Items

For the set of the following items: a set of 2 items where SKU=T123
set a price of $10 on
each trigger item.

n If the customer has 2 items of SKU equal to T123 in their shopping cart, the 
customer will receive each item for $10.

Using Multiple Trigger Sets

For the set of the following item(s): a set of 1 items where Product 
Category=Bicycle Frame
and a set of 2 items where Product Category=Bicycle Tires

take $10 off

each of up to 1 item(s) where Product Category=Bicycle Seat

n If the customer has a bicycle frame, 2 tires, and two seats in their shopping cart, 
the customer will receive $10 off one of the seats.

Note: Since the frame and the 2 tires are treated collectively as one set, only one 
discount has been earned.

Using Multiple Trigger Sets, with Quantities of Target 
Items Greater Than One

For the set of the following item(s): a set of 1 items where Product 
Category=Bicycle Frame
and a set of 2 items where Product Category=Bicycle Tires

set a price of $1.00 on

each of up to 5 item(s) where Product Category=Small Decals
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n If the customer has a bicycle frame, 2 tires, and 4 small decals in their shopping 
cart, the customer will receive all 4 decals for $1.00 each.

Note: Since the frame and the 2 tires are treated collectively as one set, one 
discount is earned.  The discount can be applied to up to 5 small decals.

n If the customer has a bicycle frame, 2 tires, and 7 small decals in their shopping 
cart, the customer will receive 5 decals for $1.00 each (and the remainining 
decals at full price).

Using Multiple Trigger Sets, with an Exact Quantity of 
Target Items

For the set of the following item(s): a set of 1 items where Product 
Category=Bicycle Frame
and a set of 2 items where Product Category=Bicycle Tires

set a price of $1.00 on

each of exactly 5 item(s) where Product Category=Small Decals

n If the customer has a bicycle frame, 2 tires, and 4 small decals in their shopping 
cart, the customer will receive no discount.

Note: Even though one discount has been earned, based on the set of trigger items, 
it must be applied to exactly 5 small decals.
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CHAPTER

9 Roadmap for Creating 
Promotional 
Campaigns

This topic describes the high-level process or roadmap you should follow when 
creating a new promotional campaign in the BEA E-Business Control Center. 
Following this process will help ensure the best possible delivery of targeted 
information to your online customers, and reduce your risk for errors when using the 
application. Where relevant, this topic contains references to other documentation that 
provides step-by-step instructions for executing the tasks described, or to 
documentation that provides more details about a concept. 

This topic contains the following sections:

n Introduction

n Examples of Campaign Types

l Combining Campaigns with Discounts to Sell Products

l Generating Revenue with Ad Clickthroughs

l Notifying Employees of New Benefits

n Creating Customer Segments

n Using Scenario Templates

n Designing Campaign Scenario Actions

l Specifying General Campaign Information
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l Customer Segments in Scenario Actions

l About Probability-Based Branching

n Authoring Campaign Messages

l Authoring Ads

l Placing Ads in Your Web Site

l Authoring E-mails

n Defining Discounts

n Campaign Maintenance

n Extending the Services That Support the E-Business Control Center

n Deciding on Campaign and Scenario Scope

l Approach A

l Approach B

l Approach C

l A Note About These Approaches

Introduction

Most promotional campaigns conceived within your organization will be developed 
within the context of a strategic business objective. For example, you may want to run 
campaigns aimed at increasing your average order size by employing cross-sell or 
up-sell tactics. However, you can also use campaigns on internal Web sites. For 
example, your Human Resources department can set up an employee portal and use 
campaigns to encourage employees to sign up for specific benefits. 

As you define your overall campaign objective, you will need to answer the following 
core marketing questions:

n Which group of customers do I want to include in my campaign?

n How can I most effectively communicate with campaign customers? 
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n What is the offer I need to extend to maximize my response? 

n Where on my Web site should this message be conveyed?

The answers to these questions relate directly to how you will set up your promotional 
campaign using the E-Business Control Center. The remaining sections in this 
roadmap provide guidance for developing your promotional campaigns.

Examples of Campaign Types

This section provides examples of campaigns that are designed to fulfill different types 
of business objectives:

n Combining Campaigns with Discounts to Sell Products

n Generating Revenue with Ad Clickthroughs

n Notifying Employees of New Benefits

Combining Campaigns with Discounts to Sell Products

If you use WebLogic Portal and you want to target discounts for specific segments of 
your customers, you can use a campaign to do the following:

n Display targeted advertisements when a specific type of customer logs in to your 
site. 

n Reduce the price for products that the customer places in the cart. You can also 
reduce or remove shipping charges, or discount the total price of the order.

For example, you want to entice professional carpenters who buy circular saws from 
your e-commerce Web site to buy saw blades as well. When a customer logs in, 
WebLogic Portal determines if the customer is in your ProfessionalCarpenter 
customer segment. If so, and the customer places a circular saw in the shopping cart, 
then the shopping cart displays an ad for a 50% discount on saw blades. The customer 
places the saw blades into the shopping cart and receives the discounted price.
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Generating Revenue with Ad Clickthroughs

If your business generates revenue by advertising products, you can use a campaign to 
do the following: 

n Run a test campaign to determine which customer type (customer segment) is 
most likely to click through a set of advertisements.

n Based on the results of the test, target advertisements to maximize clickthroughs.

For example, Jan’s Roasted Coffee contracts with you to advertise their french roast 
blend during the month of August. They pay 5 cents for each ad display (impression) 
and 1.5 cents for each ad clickthrough up to $2000.

To try to maximize the number of ad clickthroughs, you run a test campaign to 
determine which customers are most likely to respond to the Jan’s Roasted Coffee ad 
and at what times of day the ad clickthroughs are most likely to occur. Your campaign 
analysis shows that adult females respond to advertisements for Jan’s Roasted Coffee 
between the hours of 6 a.m. and 9 a.m. Using this information, you can create a 
campaign to target ads to an AdultFemale customer segment during the specified 
hours. Since your contract with Jan’s Roasted Coffee is during the month of August, 
you can set up the campaign to begin displaying coffee ads on August 1st and stop 
displaying them on September 1st.

Notifying Employees of New Benefits

If you use WebLogic Portal for your internal Web site, you can use a campaign to 
encourage your employees to log in to your human resources portal and sign up for a 
new benefit.

For example, the ACME insurance company creates a new alliance with a health care 
provider network in New England. You can use a campaign to send e-mail to all 
employees who live in New England and use the ACME insurance company. When 
the employee logs in to your internal Web site, you can also display ads for health care 
seminars that are available to your New England employees.
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Creating Customer Segments

When you have answered the question, “Which group of customers do I want to 
include in my campaign?”, you will be ready to create one or more customer segments 
in the E-Business Control Center.

A customer segment is a grouping of customers based on common characteristics from 
their customer profiles, such as age, occupation, product preferences, and the amount 
of purchases they have made; or a grouping of customers you want to communicate 
with or target with your marketing campaigns. A customer segment can also be 
identified in the E-Business Control Center by visitors who log in on specific dates or 
times, or by visitors whose HTTP session or request information matches properties 
you set up in the E-Business Control Center Session and Request tools.

As part of creating your promotional campaigns, one of the first things you will need 
to do is to create customer segments. Once you create a customer segment, the 
customer segment can be reused in any number of campaigns, whenever you feel it is 
relevant to your campaign objective.

For More Information

n To learn more about customer profiles and customer segments, or for 
step-by-step instructions about how to create new customer segments, see 
“Using Customer Segments to Target High-Value Markets.”

n For technical information about how a Web site gathers customer profile 
information, see the Guide to Developing Campaign Infrastructure.

Using Scenario Templates

Out of the box, the E-Business Control Center provides you with four scenario 
templates that you can modify to quickly create scenarios that are meaningful for your 
promotional campaigns. The goal of these scenario templates is to provide useful, 
easily applicable, and time-saving templates for reuse, and to illustrate more advanced 



9 Roadmap for Creating Promotional Campaigns

9-6 Guide to Using the BEA E-Business Control Center

applications of the E-Business Control Center. The following paragraphs provide a 
brief description of each scenario template that comes packaged with the E-Business 
Control Center.

Registration Confirmation E-mail
Demonstrates how a registration confirmation e-mail can be sent to your Web 
site visitors.

Discount and Ad Actions
Displays a discount ad in conjunction with an associated discount action. In 
other words, if a customer sees the discount ad and as a result, purchases the 
item shown in the ad, the customer will receive a discount. This template is 
available only with WebLogic Portal.

Online Content Test
Tests ad effectiveness using probability-based branching. This scenario 
template, by default, targets equal thirds of the visitors in the matching 
customer segments who visit the site while the campaign is running. (See 
“About Probability-Based Branching.”) You can use this template to test the 
effectiveness of a single ad on different types of customers, or test multiple 
ads on a single type of customer.

E-mail Pilot Test
The Pilot Test template tests which of three e-mail messages is most effective. 
Each of the three messages is triggered by an event and is sent to a specific 
customer segment. Each e-mail is sent to a random sample within 5% of the 
visitors matching the segment. (See “About Probability-Based Branching.”.) 
It is expected that the e-mail generating the best response would be rolled out 
to a wider customer population.

Though the values will be predefined as part of the scenario templates, you can change 
them to suit your needs. You will also need to provide specific values for any 
bracketed, undefined, hyperlinked text shown by clicking on them. However, you may 
also choose to uncheck some of the conditions associated with the bracketed text, if 
you choose to remove these hyperlinks instead.
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Designing Campaign Scenario Actions

When you have answered the question, “How can I most effectively communicate my 
offer?”, you will be ready to design one or more scenario actions for inclusion in your 
campaign using the E-Business Control Center. For example, when a visitor logs in 
who is identified as a power tool buyer, sending an automatic e-mail might be an 
effective way of advertising a sale on table saws. In combination with an automatic 
e-mail, you may also decide that power tool buyers are likely to add saw blades to their 
cart if they saw the 50% off ad that was displayed during check out.

The term campaign, as used in the E-Business Control Center, is a named group of 
scenarios that work together to achieve strategic business goals. Scenarios, in turn, 
implement tactics in support of the campaign’s strategic goals. Scenarios are 
comprised of scenario actions, as shown in Figure 9-1.

Figure 9-1   Campaigns, Scenarios, and Scenario Actions

Using the circular saw buyers example, the over-arching strategic goal would be to 
increase the number of saw blades purchased by circular saw buyers. A tactic used to 
achieve this goal might be to display an ad that publicizes the discount to customers in 
the ProfessionalCarpenter segment during check out. Another tactic might be to 
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send regular ProfessionalCarpenter customers an e-mail about the 50% off offer. 
The goal (campaign) remains the same, but there are different tactical means 
(scenarios) by which the goal can be achieved.

The implementation of different tactics (scenarios) is accomplished through each 
scenario’s actions, which control the particular aspects of your e-commerce Web site. 
The E-Business Control Center comes with three types of pre-configured scenario 
actions: ad, discount, and e-mail. You can design your scenario action to display an ad 
or send an e-mail when the right conditions are met. You can also design your scenario 
action to offer a discount. The E-Business Control Center provides a variety of 
conditions that you can use to trigger these scenario actions.

You may choose to include multiple scenario action types within a given scenario, and 
you can create as many scenarios as you like using the E-Business Control Center. 
However, the way you organize your scenarios—and there are many possible ways—
will affect your promotional campaign.

For More Information

n For a brief discussion of other, campaign-related information you will need to 
specify in the E-Business Control Center, see “Specifying General Campaign 
Information” on page 9-9.

n If you want to use a discount as a scenario action, you must have previously 
defined the discount. For more information about defining discounts, see 
“Designing Campaign Scenario Actions” on page 9-7 of this roadmap document 
or “Defining Stand-Alone or Campaign Discounts.”

n For more information on ad and e-mail scenarios, see “Authoring Campaign 
Messages” on page 9-15.

n For guidance on organizing scenario elements and thus your promotional 
campaigns, see “Deciding on Campaign and Scenario Scope” on page 9-23.

n For more frequently used and more complex scenarios, the E-Business Control 
Center also provides predesigned scenario templates, so you that do not have to 
build all your scenarios from scratch. For more information about the scenario 
templates, see “Using Scenario Templates” on page 9-5.
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Specifying General Campaign Information

In addition to scenarios, campaigns also have some general information associated 
with them. You may have already considered this information during your strategic 
planning efforts, and perhaps you are ready to use this information when creating a 
campaign in the E-Business Control Center. Before using the E-Business Control 
Center to implement a campaign, however, be sure you have considered the following:

n Campaign Attributes

n Campaign Duration and End Criteria

Campaign Attributes

Campaign attributes are simply some descriptive information about the campaign that 
can prove helpful to you when dealing with the campaign in the future. The E-Business 
Control Center requires that you specify the name of the campaign sponsor and a 
description of the campaign. Optionally, you can specify a goal description (value 
proposition) for the campaign, such as “to entice circular saw buyers to add saw blades 
to their cart before check out.” All campaign attributes you specify can later be used 
as campaign search criteria.

Campaign sponsors are entities (that is, organizations) that have commissioned a 
campaign and on whose behalf the campaign is run. Often, the campaign sponsor will 
be the same as the organization who owns and operates the e-business Web site, or a 
department within that organization. However, the Web site owner may want to sell 
advertising on the site or enter into manufacturer or distributor sponsored campaigns. 
In such cases, the sponsor is different from the organization that owns the site. In the 
E-Business Control Center, the sponsor can be used as a criterion for campaign 
searches as well as for reporting and analysis purposes.

The name you choose when you save your promotional campaigns also has an effect 
on future campaign reporting. By applying a standardized naming convention across 
specific campaign fields you can further simplify the process of organizing and 
aggregating campaign data for inclusion in reports. For example, if you always begin 
your promotion names with campaign type (upsell, cross-sell, retention, and so on), 
you will be able to roll up or sort based on this standard.
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For More Information

For more information about searching for campaigns, see “Locating Existing 
Campaigns” on page 10-27.

Campaign Duration and End Criteria

A campaign normally has a fixed duration, or period of time during which it is active. 
The E-Business Control Center will record your campaign’s starting and ending date 
and time. For campaigns using scenarios with ad actions, however, the E-Business 
Control Center also provides you with another option: a campaign goal can be used to 
stop the campaign, prior to its scheduled end date. For example, the goal might be for 
a certain number of circular saw buyers to clickthrough an ad to another Web page that 
provides details about a saw blade discount. Or maybe you just want a certain number 
of people to see your ad (called an impression in the E-Business Control Center). In 
the E-Business Control Center, these goals are called campaign end criteria. When 
your goal is satisfied—that is, when the number of ad clickthroughs or impressions 
reaches the number you set—the campaign can end.

Customer Segments in Scenario Actions

The E-Business Control Center allows you to target customers for personalized 
content and messaging by creating dynamic groupings called customer segments. 
Every visitor may be evaluated during their session in your site or application to 
determine if they qualify for targeting as a member of one or more defined customer 
segments. In order to determine if a customer is a member of a given segment, each 
qualifying condition you specify is evaluated. Thus, a segment is a manageable way of 
bundling together two or more characteristics that represent a complex customer type.

When and When Not to Use Segments

You do not always have to use customer segments to target specific groups of people 
with campaign scenario actions. When creating a scenario action, instead of triggering 
the action on a customer segment, you can trigger the action if the visitor has certain 
characteristics—the same set of characteristics you can use to create a customer 
segment. So since you can trigger a scenario action on visitor characteristics with or 
without a customer segment, you should put some thought into whether or not you 
create customer segments.



Designing Campaign Scenario Actions

Guide to Using the BEA E-Business Control Center 9-11

In the following guidelines to determine whether or not you should create a customer 
segment for use in scenario actions, reuse is the key:

n When to use customer segments – Create customer segments to trigger 
scenario actions when the customer segment can be reused for other actions, in 
other campaigns, or for content selectors.

n When not to use customer segments – Do not create customer segments to 
trigger scenario actions if the customer segment would be created to support just 
that action or a potentially small number of actions.

Order and Logic of Evaluation

Both scenarios and scenario actions can be targeted at segments. If segments are used 
in scenarios and its actions, the segments are evaluated as if they are connected with 
AND logic; that is, a customer must qualify as a member of both segments in order for 
the customer to be targeted in that campaign.

Usefulness of Chaining Segments

The logic of AND-ing segments means that you can use them to progressively narrow 
your targeting without having to script new, even more complex segments.

Retail Example
You could target a scenario only at Active Browsers (in other words, the 
visitor’s last visit is less than 10 days ago, with total purchases less than X), 
and then target separate actions within that campaign to Stay-at-Home Moms 
(that is, female visitors with children under 10 and a session time between 
10 a.m. and 4 p.m.), and Internet Pros (visitors with a high-speed connection, 
software/internet employment, and income $100K+).

B2B Example
You could target a scenario only at Tier 1 Customers, and then target separate 
actions within that campaign to Managers and Accounting.

Cautionary Notes

Note that it is possible to target nobody by carelessly chaining the targeting of 
segments in a scenario and its actions.
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Absurd Example
You could target a scenario only at Male Category A (using some set of 
conditions, including male gender), and then target a separate action within 
that campaign to Female Category A (using some set of conditions, including 
female gender). This action would actually target no customer, since it would 
be looking for female customers only within the male users that satisfied the 
topmost scenario segment.

A more likely case of this phenomenon would be one where very few users satisfied 
all the conditions of both the scenario segment and its action segments. Therefore, it is 
important to be familiar with the underlying conditions that make up your established 
segment definitions.

What if You Only Need to Target One Segment?

Where should you input your segment targeting (if any)—at the scenario level, or at 
the action level?

Typically it should be at the scenario level for the following reasons:

n A campaign’s targeting may be easier to manage at the scenario level, even if it 
contains a complex series of ad, e-mail, and discount actions.

n The typical business model for personalized campaigns asks first “whom do you 
want to target?” Putting segment targeting at the top level ensures that other 
business users inspecting your campaigns in the E-Business Control Center can 
locate the targeting quickly, without having to delve into individual scenario 
actions.

However, targeting segments at the action level is useful in some instances; for 
example, when you anticipate needing to add parallel actions within the same scenario 
later, but target those actions at different customer segments.

About Probability-Based Branching

Probability-based branching is a mechanism for dividing campaign scenario actions 
into proportional but random customer segments (subject to other conditions that may 
apply). Each time a scenario is evaluated to determine if any of its actions (ad, e-mail, 
or discount) apply to the customer, a random number between 1 and 100 is 
automatically generated by the system. If any action in the scenario includes a 
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probability-based branching condition, then that number is used in its evaluation. If no 
scenario includes branching, then the number is forgotten, and a new random number 
is assigned for the next scenario in the campaign.

Branching is designed to provide two distinct capabilities:

n Dictate that all the actions in a scenario be executed exclusive of each other 
(branching) and in some specific proportion to each other, as shown in 
Figure 9-2.

Figure 9-2   Branching the Entire Population by Varying Percentages

n Scale down the number of times a scenario executes to some small percentage of 
all visitors, as shown in Figure 9-3. This is useful for conducting test marketing 
against less than all users of the site or application.
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Figure 9-3   Branching a Small Percentage of the Population, as a Test Case

Note: It is important to keep in mind what the base of the branching condition is. 
Consider a branching condition set 50% (from 1 to 50). Will this condition 
filter its action to execute only for half your customers? Not necessarily.

First of all, remember that the 50% branch condition is only being evaluated 
for customers that visit the site. Secondly, active visitors may be further 
filtered by some customer segment targeting at the scenario level, and then 
again at the action level. So the final 50%, in some cases, may be a percent of 
a percent of a percent, and so on. (For more information about defining 
customer segments at the campaign and scenario levels, see “Customer 
Segments in Scenario Actions” on page 9-10.)

This is particularly important to keep in mind when using smaller branches 
(approximately 5%) for test marketing. Depending on customer segmentation, 
a 5% or 3% branch may target so few customers as to be statistically 
meaningless. Think through the targeting and branching so you reach a useful 
number of your user base.
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Setting a Scenario to Run Just Once for a Visitor

Of particular use when branching actions for test marketing is the Once This Action Is 
Performed, Do Not Run The Scenario Again For This Visitor check box option, shown 
in the New Action windows (for ads, discounts, and e-mails). In the ordinary course of 
campaigns, each time a qualifying visitor comes to the site, that visitor can be targeted 
with whatever promotional messages (ads and/or e-mails) and discounts are active. 
However, you usually need mutually exclusive populations for valid market tests. 
Therefore, the E-Business Control Center provides the ability to have a scenario run 
once only per visitor. This feature is also pertinent in the case of e-mail campaigns. In 
many cases, you will want customers to receive only one copy of a given promotion 
via e-mail.

Authoring Campaign Messages

The E-Business Control Center allows you to use both ads and e-mails in scenario 
actions to convey promotional messages. If you choose either of these options, you 
must have previously authored these messages (much like you previously define 
discounts) and consider a few other factors before using them, as described in the 
following subsections:

n Authoring Ads

n Authoring E-mails

Authoring Ads

An ad can be a graphic, a segment of HTML or plain text, or a file that is displayed by 
a Web browser plug-in. Before you can use an ad in your promotional campaign, you 
will first need to create and store it.

Develop a collection of ads.
You might work with your Web site’s graphic artists to do so.
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Load the ads into a content management system.
You might work with your Business Engineer or other technical resource to 
do so. One important attribute to consider as the ads are loaded into the 
content management system is an ad weight. An ad weight indicates the 
importance of the ad, relative to other ads in the system.

Placing Ads in Your Web Site

After you create and store your ads, you must determine which pages display the ads 
and where on those pages the ads are displayed.

Determine location(s) on your Web site for ad display.
Ads used within the E-Business Control Center should appear in predefined 
locations, called placeholders, which are embedded in Web pages by your 
business engineers (or other technical resources). Placeholders answer the 
question, “Where on my Web site should this message be conveyed?” For 
circular saw buyers, you may want to display the ad in a prominent location, 
like at the top of the shopping cart page. Placeholders should have descriptive 
names that allow you to quickly identify them. For more information on 
placeholders, see the chapter on “Displaying Ads.”

Determine default ad queries (searches). 
One or more ads are returned from the content management system for 
possible display on your Web site as the result of ad queries (searches). Ad 
queries are run by placeholders, and can be of two types: default or campaign. 
Default ad queries are queries that retrieve ad content regardless of whether 
or not the conditions for your campaign are met, ensuring that some ad is 
always displayed in the placeholder. Campaign ad queries retrieve ad content 
only when specific circumstances are met. For example, if a customer logs in, 
and that customer is a member of a customer segment called BirdLover, you 
could display an ad on the page that tells about a sale on parrots.

It is also good practice to combine campaign and default queries inside an ad 
placeholder. When you do this, you are guaranteed that an ad of some kind 
will be displayed in the placeholder.

Figure 9-4 illustrates a the placeholder concept. If a “BirdLover” is logged in 
to the site, the campaign query retrieves an ad from the ad database and puts 
it on the page in the placeholder. A default query is also assigned to the 
placeholder for all other customers or visitors.
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Figure 9-4   Placeholder with a Campaign Query and a Default Query

After a graphic artist or ad developer creates and stores ads, a business analyst or 
business engineer creates the placeholders (names them and assigns queries to them) 
in the E-Business Control Center, and a developer puts the placeholders in the 
appropriate JSPs.

Determine relative importance (priority) for your ad queries. 
A display priority controls how likely it is that an ad query will run, relative 
to other ad queries that have the potential to be run in the same placeholder. 
Default ad queries in the E-Business Control Center automatically have a 
lower priority than campaign queries, but you can modify this to meet your 
requirements. (You can also set default ad queries to not run if campaign 
queries exist in a placeholder.) Because more than one ad may be retrieved as 
the result of a query, the ad weight attribute assigned to individual ads in your 
content management system help determine which ad out of the resulting 
group is actually displayed to your Web site visitors.

If two ad queries in a placeholder have the same priority, both have the same 
chances of being run in a placeholder. Be sure to follow your organization’s 
established policy for assigning display priorities if you wish to avoid this 
situation. 
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For More Information

n For more information on creating ad placeholders and queries in the E-Business 
Control Center, see “Displaying Ads.”

n For technical information storing ads in a content management system and 
adding placeholders to JSPs, see “Setting up Ads for Campaigns” and “Setting 
up JSP Tags and Scriptlets for Campaigns” in the Guide to Developing 
Campaign Infrastructure.

Authoring E-mails

As part of a promotional campaign, you may decide to send an e-mail to specific 
customers.  Before you can send e-mails, however, you will first need to:

Create your e-mail messages.
Like ads, e-mail messages may contain different content depending upon the 
purpose of your promotional campaign. You may want to include some 
customer profile information (such as the customer’s name in a salutation) to 
further personalize your message, as shown in Figure 9-5.
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Figure 9-5   Sample Promotional E-mail

Note: To ensure that the appropriate customer profile information is substituted into 
the message, you may need to collaborate with your business engineer or 
another member of your organization’s technical staff to personalize your 
e-mails in this way.

Save your e-mails as files, in a central location.
You might want to create a collection of e-mails for use in scenario actions. 
E-mails can be in TXT, HTML, JSP, or XML (with style sheets) formats. 
Your system administrator or business engineer must set up the e-mail storage 
location so that you can access e-mail when creating campaign e-mail actions. 
If the e-mail files are stored in a specific directory structure, you will be able 
to use the E-Business Control Center’s e-mail browsing window to locate the 
e-mail messages you want. This directory structure is:

PORTAL_HOME\applications\<app_name>\campaigns\emails

where <app_name> is your enterprise application directory.
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For information on setting up a connection from the E-Business Control 
Center to the e-mail messages stored on the server, see “Connecting to the 
Server” in the “Introduction to the BEA E-Business Control Center.”

For More Information

n For more information about the information used to connect to a server, see 
“Connecting to the Server” in the “Introduction to the BEA E-Business Control 
Center.”

Defining Discounts

With WebLogic Portal, you can use discounts to help you realize your strategic 
business objective. For example, if your goal is to entice circular saw buyers in your 
hardware store to add saw blades to their cart, you might offer them a 50% discount on 
the saw blades.

To define discounts that are meaningful for your marketing efforts, you will need to 
consider the following:

Discount Duration
The length of time for which the discount will be offered (start and stop date 
and time).

Discount Usage
Stand-alone or campaign. Stand-alone discounts are offered to everyone who 
buys something from your Web site without regard for customer segments or 
campaign goals. Stand-alone discounts cannot be used in campaigns.

Campaign discounts can be used in discount scenario actions and awarded to 
customers who meet specific criteria, whether they belong to a particular 
customer segment, have certain characteristics, or simply buy something on 
a certain date. You will usually create specific campaign discounts to be used 
in specific campaigns, so be aware of how the start and stop dates of your 
campaign discounts compare to the start and stop dates of your campaigns.
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Discount Types
Per item, set-based, or per order. Per item discounts are discounts that apply 
to individual items in your product catalog, while set-based discounts are 
discounts that apply to sets of items in your product catalog. Order discounts 
are discounts that can apply to a customer’s entire order.

You will also need to identify the items that cause the discount to be offered 
(called trigger items) and the items to which the discount should be applied 
(called target items). For example, if a customer puts a miter saw in the 
shopping cart (trigger), the customer receives a 50% discount on saw blades 
(target). You will also need to consider the discount value (the percentage or 
dollar amount of the discount) that you may be required to supply for that 
discount type. All discount values can be specified as a percentage off, an 
amount off, or a fixed price.

Discount Limits
Overall, order, and/or minimum purchase requirement. An overall limit is a 
limit on the number of orders to which the discount can be applied. Order 
limits restrict how many times the discount can be received per order, and can 
be placed on items that trigger the discount, or on items to which the discount 
is applied. For per-item discounts, you can also specify a minimum purchase 
requirement.

Discount Priority
The relative importance of a discount, specified by a value in the range of 
1-20 (with 1 being the highest). In the event that two similar discounts apply 
to a given item, the priority associated with each discount helps resolve the 
conflict.

The E-Business Control Center does not detect situations in which multiple 
discounts are assigned the same priority. If two discounts have the same 
priority, one of the discounts will be selected at random. Be sure to follow 
your organization’s established policy for assigning discount priorities if you 
wish to avoid this situation. 

For More Information

n To learn more about discounts, or for step-by-step instructions about how to 
define new discounts, see “Defining Stand-Alone or Campaign Discounts.”

n For technical information about how discounts work behind-the-scenes, see the 
Guide to Managing Purchases and Processing Orders.
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Warning: Because customer orders may be linked to discounts once they are 
deployed, you will not be able to modify or delete a discount until its 
associated time frame (duration) has expired or until it can be determined 
that no orders are linked to the discount. Therefore, it is extremely 
important that you define discounts appropriately.

Campaign Maintenance

When saving your campaigns, the E-Business Control Center will ask you to supply a 
campaign filename. You or others in your organization might find that establishing and 
following certain naming conventions for campaigns is useful. For example, campaign 
file naming conventions might help you tie together and therefore quickly locate 
related campaigns, or assist you when it comes time to run analytic reports. Filename 
conventions can also identify ownership among different users designing and working 
with campaigns.

You will also find it beneficial to write good descriptions for your campaigns. You 
might even use descriptions as a way to coordinate with other users of the E-Business 
Control Center. For example, you might want to include an author or contact name in 
the campaign description, so that others who see the campaign know who to contact if 
and when they have questions about that campaign.

Extending the Services That Support the 
E-Business Control Center

Out-of-the-box, the E-Business Control Center provides many elements you can use to 
create your own unique promotional campaigns. However, it is possible that you may 
want to extend the E-Business Control Center to more closely match your e-business 
needs. For example, the E-Business Control Center allows you to select from a number 
of predefined customer behaviors (events) to trigger scenario actions. If you think of 
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an event that is not already available, you may want it to be created and added to the 
system. Customer profile information is another example; the system is extremely 
flexible in the data it can store about visitors to your Web site.

If you believe that extending the E-Business Control Center would be helpful, you will 
initially need to collaborate with a business engineer or other technical resource in your 
organization who can make modifications to the tool. If possible, you should initiate 
this process before proceeding with the E-Business Control Center.

For More Information

To determine what events are initially available for use in the E-Business Control 
Center, see “Creating and Managing Property Sets”. However, keep in mind that if 
your organization extends the services that support the E-Business Control Center, you 
should use the E-Business Control Center itself to view the most up-to-date list.

Deciding on Campaign and Scenario Scope

The E-Business Control Center is so flexible that it may seem that there are always 
multiple ways to accomplish any one goal. And yet, you will learn that there are often 
preferred ways to use the tool, and to structure your campaigns, depending on factors 
such as:

n Your internal organization – do campaign sponsors come from different 
departments or represent a single department?

n Your workflow – will other business analysts be editing and copying your 
campaigns, or is it a one-person show? Will the sponsor be delegating work to 
the person using the E-Business Control Center to create campaigns?

n Your development, staging, and production environments – do you use a 
source-control system and a document or content management system?

n Your own skills inventory – are you technically savvy and able to handle 
situations where your campaigns overlap with custom implementations? Or are 
you more comfortable being insulated from technical tasks, such as 
programming?
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n Your working relationship with IT, programming support, in-house consultants, 
writers, webmasters, graphic artists, and so on – is your desktop environment for 
the E-Business Control Center managed closely for you, or do you maintain it 
yourself, including server connections and access to content, ads, and e-mails?

n Your marketing or merchandising calendar – do you run a monthly special every 
so often, or is your catalog filled with dozens of overlapping specials and 
discounts?

n Your user base – is your audience segmented only vertically, by their value to 
the business (for example, purchase history, tier), or are they also segmented 
horizontally (for example, by class of partnership, business group, role, or 
submarket)?

Consider the following sets of campaigns (strategic), scenarios (tactical), and actions 
(operational), shown in Figure 9-6.

Figure 9-6   Campaign and Scenario Nesting Approaches



Deciding on Campaign and Scenario Scope

Guide to Using the BEA E-Business Control Center 9-25

These three campaign approaches are apparently equivalent. Each approach will result 
in customers being recognized if they are members of one of three target segments, and 
being sent or displayed the appropriate content (that is, each approach satisfies an 
identical customer use case).

However, each has pros and cons, even in this simple generic example.

Approach A

Figure 9-7   A Closer Look at Approach A

Approach A (shown again in Figure 9-7), where all actions are lumped into a single 
scenario in a single campaign, is best when:

n All the interactions are sponsored by one sponsor and run for the same period of 
time.

n The campaign is set to end automatically when a certain number of impressions 
or clickthroughs is reached in Action 2 (the Ad Action), and you want the e-mail 
and discount actions to shut off at the same time.

n The single scenario, with its three actions, can be thought of as a unified 
business case, all supporting each other, for example, a succinct offer or 
incentive, including the presentment of the offer (ad), the discount itself, and a 
positive feedback (e-mail).

Approach A has drawbacks for the following situations:
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n When each action has its own sponsor or administrator.

n Each action has a distinct business purpose, goal, or description. For ease of 
management, these would be best captured in separate campaigns or scenarios, 
which fields for description, and so on.

n If the campaign is set to end automatically when a certain number of 
impressions or clickthroughs is reached in Action 2 (the Ad Action), and you do 
not want the e-mail and discount actions to cease at the same time.

Approach B

Figure 9-8   A Closer Look at Approach B

Consider Approach B (shown again in Figure 9-8), which puts each action into 
separate scenarios—but all within a single campaign—for the following case:

n If you administer campaigns as a larger promotional unit, and within a campaign 
administer several programs. For example:
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l Q2 Loyalty Campaign (channel scenarios):

l E-mail component (multiple e-mail actions)

l Ad component (multiple ad actions)

l And so on.

n ...or:

l Holiday Specials Campaign (departmental scenarios):

l Sporting goods scenario (e-mail/ad/discount)

l Surplus auction scenario (e-mail/ad/discount)

l And so on.
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Approach C

Figure 9-9   A Closer Look at Approach C

Approach C (shown again in Figure 9-9), which breaks every action and scenario out 
into separate campaigns, is best in the following cases:

n Each interaction is sponsored by a different sponsor, and runs for different 
periods of time.

n When each action has its own administrator.

n Each action has a distinct business purpose, goal, or description. For ease of 
management, these would be best captured in separate campaigns, which fields 
for description, and so on.
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n If you have more than a few people administering campaigns with the 
E-Business Control Center. Approach C pushes every interaction up to the level 
of a campaign, where its title is visible and searchable in the Explorer window.

A Note About These Approaches

If you look again at Figure 9-6, you will see that Approaches A and B might represent 
any individual campaign, such as you will first create when you begin to use 
E-Business Control Center.

However, Approach C might resemble your collection of campaigns and scenarios 
after some time, when you have built and launched multiple campaigns. Each of the 
campaigns nested within Approach C can have a structure like that of Approach A or 
Approach B.

This observation suggests that new users of the E-Business Control Center proceed 
conservatively, dividing up campaigns according to their internal business processes 
and marketing programs, and reassess their practices periodically, trying to strike a 
balance that avoids either of these extremes:

n Cramming too much functionality into a single campaign, limiting access to and 
management of its constituent actions.

n Breaking every action into its own campaign, sacrificing the power of the 
scheduling tools and scenario branching, and unnecessarily cluttering the 
Explorer interface with long lists of campaigns.



9 Roadmap for Creating Promotional Campaigns

9-30 Guide to Using the BEA E-Business Control Center



Guide to Using the BEA E-Business Control Center 10-1

CHAPTER

10 Creating and Managing 
Promotional 
Campaigns

This topic contains step-by-step information for defining a new campaign or 
modifying existing campaigns within the BEA E-Business Control Center. For 
conceptual descriptions of a campaign or for discussions of the business applications 
of campaigns, see Chapter 9, “Roadmap for Creating Promotional Campaigns.”

This topic includes the following sections:

n Creating a New Promotional Campaign

l Specifying General Campaign Information

l Adding Scenarios to the Campaign

l Adding Actions to Your Scenarios

l Entering the Campaign Duration and End Criteria

n Locating Existing Campaigns

n Modifying Existing Campaigns

l Deactivating and Reactivating Campaigns

n Deleting Existing Campaigns

n Debugging Campaigns

l Reactivating Campaigns That Have Ended Because of Goals Being Met
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Creating a New Promotional Campaign

To create a new promotional campaign, follow these steps:

1. From the BEA E-Business Control Center, choose File → New → Business Logic 
→ Campaign. The Campaign Editor window opens, as shown in Figure 10-1.

Figure 10-1   Campaign Editor Window

2. You must now follow the steps provided in the following sections to:

l Specifying General Campaign Information

l Adding Scenarios to the Campaign

l Adding Actions to Your Scenarios

l Entering the Campaign Duration and End Criteria

Specifying General Campaign Information

In the General pane (Figure 10-2), enter a description, campaign sponsor, and 
optionally, a goal description.
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Figure 10-2   General Campaign Information Pane

Adding Scenarios to the Campaign

Because campaigns are groups of scenarios that are associated with a business goal, 
scenarios are at the very heart of your campaign. In scenarios, you will specify one or 
more actions to take place on your Web site when certain conditions are met.

To add scenarios to the campaign:

3. In the Scenarios pane, click New Scenario. The New Scenario window opens, 
displaying a list of scenario templates, as shown in Figure 10-3.

Note: For a description of each scenario template, see “Using Scenario 
Templates” on page 9-5.

If you would rather create a scenario by copying an existing scenario, click an 
existing scenario name in the Scenarios list to select it and then click Duplicate. 
A copy of the scenario, along with its actions, appears in the Scenarios list. You 
can then click Edit to modify the scenario as appropriate.
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Figure 10-3   Scenarios Pane

4. Select a scenario template and click OK. The Scenario Properties window opens, 
as shown in Figure 10-4.

To start with a blank scenario, select Default.

Figure 10-4   Scenario Properties Window



Creating a New Promotional Campaign

Guide to Using the BEA E-Business Control Center 10-5

5. Enter a unique name for the scenario in the Scenario Name field, and a 
description of the scenario in the Scenario Description text area.

6. If you want to select customer segments at the scenario level, you may do so now 
by clicking the Select Segments button.

Note: For an explanation of why you might want to select customer segments at 
the scenario level and how this is different from selecting segments at the 
scenario action level, see “Customer Segments in Scenario Actions” on 
page 9-10. To select customer segments, you must have previously created 
them. For information on creating customer segments, see “Using 
Customer Segments to Target High-Value Markets.”

7. Click OK. 

8. A message appears indicating that the new scenario has been created and that you 
may now add actions to the scenario. Click OK. The scenario name you specified 
appears in the Scenarios list.

If you selected customer segments, these appear in addition to the scenario name 
in the Scenarios list.

9. Add actions to the scenario, as described in “Adding Actions to Your Scenarios.”

Adding Actions to Your Scenarios

Now that you have defined your scenario, you must add actions to it.  There are three 
types of actions you can add to a scenario:

n Ad Actions

n E-mail Actions

n Discount Actions (available only with WebLogic Portal)

Duplicating Actions

Here is a tip to use after you have created other actions. Instead of creating a brand new 
action, you can save editing time by duplicating an existing action that has similar 
settings to the action you want to create. To do this, select the action you want to 
duplicate, and click the Duplicate button. A duplicate action is added to the scenario. 
You can double-click the new action to edit it.
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Ad Actions

When you specify an ad action, you are defining criteria that will be used to select an 
appropriate ad for your online customer from a number of ads that are stored in your 
organization’s content management system. Be sure that you have already developed 
these ads and that the ads exist within your content management system. For more 
information, see “Authoring Ads” on page 9-15 or “Describing Ads in Your Content 
Management System” in “Displaying Ads.”

To add ad actions to your scenario, follow these steps:

1. Select the name of the scenario to which you want to add the action.

2. Click the New Action button, and select Ad. The New Ad Action window 
appears, as shown in Figure 10-5.

Figure 10-5   New Ad Action Window
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3. Click the check boxes shown in the Conditions portion of the New Ad Action 
window to select the condition(s) under which the ad will be displayed. Text 
describing the conditions you selected appears in the Action portion of the New 
Ad Action window.

You must add at least one condition, or you will not be able to save the scenario 
action. For an explanation of the possible conditions, see “Listing of the 
Available Conditions” in “Building Conditions and Queries in the BEA 
E-Business Control Center.”

Tip: You can use conditions in ways that always evaluate to true. For example, 
you can select the It Is after a Given Date condition and then specify the 
date as January 1, 1970.

4. For each condition you select, you must specify values for any bracketed 
hyperlinked text that appears in the Action portion of the window.

For example, if you selected the Date Is condition, you must specify a value for 
the hyperlinked [date] text in “the date is [date]” condition statement, shown in 
the Action portion of the New Ad Action window.

To specify values for bracketed hyperlinked text, just click the text. Depending 
upon the condition and the hyperlink, a window or a dialog box opens. 
Table 10-1 provides a consolidated listing of the conditions and indicates where 
to look if you need detailed instructions for any of the corresponding 
windows/dialog boxes.

Note: Table 10-1 shows all the conditions that may be used within the 
E-Business Control Center. Therefore, not all conditions shown here may 
apply to the action you are creating.

Table 10-1  Instructions for Building Conditions

Condition(s)

Relevant Instructions in the “Building 
Conditions and Queries in the BEA 
E-Business Control Center” chapter

The visitor is a member of a 
predefined customer segment

“Using the Select Customer Segments Window”

A visitor, HTTP session, HTTP 
request, or an event has specific 
characteristics

“Using the Properties and Visitor Characteristics 
Windows”
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5. If you selected more than one condition, you may want to click the All hyperlink 
in the When All Of These Conditions Apply phrase to change All to Any.

The Any/All link acts as a toggle.  Clicking on Any will change it to All, and 
visa versa.

6. Click the [empty ad search] hyperlink. The Ad Search window opens. Follow the 
instructions in “Constructing Queries” in “Building Conditions and Queries in the 
BEA E-Business Control Center.” to specify criteria for the ad that should be 
displayed.

If you have not set up connection settings to the server for searching your ad 
database, or if you have not signed in to this area of the server yet, the 
Connection Setup window appears. If you have already set up a server 
connection, select the name of the connection in the Display Name field, and 
enter your user name and password. If you have not set up a connection to the 
server yet, see “Connecting to the Server” in the “Introduction to the BEA 
E-Business Control Center” for information.

An event (such as login or click) has 
occurred

“Using the Select Events Window”

Dates and times “Important Note About Dates and Times” (The dates 
and times you set are based on universal time 
[UTC].)

“Using the Date/Time Entry Dialog Boxes”

There is a specific item in the 
shopping cart, there is an item from a 
given category in the shopping cart, 
the value of items in the cart is a 
certain amount

Note: This condition is available 
only in WebLogic Portal.

“Using Quantity Selector or Currency Selector 
Dialog Boxes”

“Using the Select Operator Dialog Box”

“Using the Select Product Categories/Items 
Windows”

A random number falls within a given 
range

“Using the Enter a Range Dialog Box”

Table 10-1  Instructions for Building Conditions (Continued)

Condition(s)

Relevant Instructions in the “Building 
Conditions and Queries in the BEA 
E-Business Control Center” chapter
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7. Click the [this placeholder] hyperlink. The Select Placeholders window opens, as 
shown in Figure 10-6.

To select placeholders, you must have previously created them. For information 
on creating placeholders, see “Creating Ad Placeholder Files” in “Displaying 
Ads.”

Figure 10-6   Select Placeholders Window

8. In the Select Placeholders window, move the placeholder(s) that will display the 
ads into the Selected Placeholders list.

Verify that you are selecting the appropriate placeholder by viewing the text 
shown in the Placeholder Description text area.

9. Click OK. The Select Placeholders window closes. The name of the 
placeholder(s) appears in place of the generic [Placeholder] hyperlink in the 
Action portion of the New Ad Action window.

You can click the new link to edit the placeholder(s) used.

10. Click the [the campaign ends] hyperlink. The Select Duration window appears, as 
shown in Figure 10-7.
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Figure 10-7   Select Duration Dialog Box

11. In the Select Duration dialog box, set a time at which the ad will be cleared from 
the placeholder, and click OK.

For example, if a promotion within your campaign ends prior to the end of the 
campaign, this feature helps ensure that promotional ads don’t appear after the 
promotion ends.

The date and time you set is in relation to universal time (UTC). For more 
information, see “Important Note About Dates and Times” in “Building 
Conditions and Queries in the BEA E-Business Control Center.”

12. For information on the [Do not remove any other ads] hyperlink, see “Clearing 
Campaign Queries from Ad Placeholders” on page 10-13.

Figure 10-8   Placement Options Dialog Box

13. If you want to change the ad’s display priority, click the [Normal] hyperlink, 
change the priority in the Select Display Priority dialog box, and click OK.

The display priority value appears in place of the Normal hyperlink in the 
Action portion of the New Ad Action window.
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For more information on ad display priorities, see “Authoring Ads” on page 
9-15.

14. If you want the scenario to run only once per visitor, select the Once This Action 
Is Performed, Do Not Run the Scenario Again for This Visitor option at the 
bottom of the New Ad Action window.

15. Click OK.  The New Ad Action window closes.  The conditions and 
corresponding actions you selected appear beneath the scenario name (and if 
applicable, customer segments) in the Scenarios list.

You may add different types of scenario actions to your scenario.  For example, you 
may now want to add a discount or e-mail action to the same scenario where you just 
added the ad action.  You may also choose to add another ad action to the same 
scenario.  (Whether you do so or not depends upon whether you want to target the same 
segments that are specified in this scenario.)

The Flexibility of Campaign Queries in Placeholders

In the E-Business Control Center, a business analyst can create a scenario action that 
places a query in a specific ad placeholder when an event or some other state triggers 
the scenario.

WebLogic Portal uses a table to keep track of which scenario-specific queries in a 
placeholder apply to which customer IDs. For example, if Pat Gomes triggers a 
scenario to place a query in the top-banner placeholder, WebLogic Portal stores the Pat 
Gomes/top-banner-placeholder/scenario-query association in a table in its data 
repository.

Once a scenario places a query in a placeholder for a specific user, WebLogic Portal 
keeps the query in the placeholder until any of the following occurs:

n The campaign achieves its goal for running the scenario query and displaying 
the corresponding ad.

n The campaign ends because it has achieved some other goal, the end date/time 
for the campaign has arrived, or a business analyst ends the campaign in the 
E-Business Control Center.

n An event or system state triggers another action for the scenario (or re-triggers 
the same action) that placed the query in the placeholder.

Scenarios can contain multiple actions that place queries in one or more 
placeholders under different conditions. For example, when Pat Gomes logs in, 
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scenario1 can place queryA in the top-banner placeholder. When Pat Gomes 
adds a drill to the shopping cart, scenario1 can place queryB in the top-banner 
placeholder. However, when a scenario engages a scenario action, it can place 
only one query in a placeholder for a given customer, and the query remains in 
the placeholder until the scenario replaces it. For example, when Pat Gomes 
adds a drill to the shopping cart, scenario1 replaces its queryA with queryB.

n The date/time that you specify in the Select Duration window (by clicking [the 
campaign ends] hyperlink in the Ad Action window) has expired.

n You click the [Do not remove any other ads] hyperlink in an ad action and select 
one of the “Remove” options. When the action is triggered, the relevant queries 
are cleared.

n You use the Tools → Reset Campaigns option in the E-Business Control Center. 
(See “Debugging Campaigns” on page 10-33.)

Because of the dynamic nature of campaign queries, some actions might leave a query 
stranded in a placeholder for a specific user, even across multiple sessions on the Web 
site.

For example:

n After a scenario action places a query in the top-banner placeholder for Pat 
Gomes, a business analyst deletes the scenario action. Deleting the scenario 
action does not clear the query from the placeholder. Only another action from 
the same scenario can replace the query. Instead of deleting the scenario or 
scenario action, we recommend that you modify the scenario action to place 
queries for generic ads in the placeholder. Then, when the scenario action is 
triggered, it replaces the campaign-specific query with a generic, default ad 
query.

n An action in one scenario puts a query in a placeholder, and an action in another 
scenario puts another query in the placeholder. If both queries have an equal 
change of being run, the ads that appear in the placeholder become more 
unpredictable. There is even a possibility that multiple campaigns can put 
queries in one placeholder, adding further unpredictability to the ads that are 
displayed in that placeholder.

n Pat Gomes places a drill in the shopping cart and triggers a scenario action to 
place a query in a shopping-cart placeholder. If Pat Gomes removes the drill 
from the shopping cart, the scenario action does not remove its query from the 
shopping-cart placeholder. Only another action from the same scenario can 
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replace the query. For example, along with the action that places a query in the 
shopping-cart placeholder when a user adds a drill to the shopping cart, you can 
create an action for the same scenario that places queries for generic ads in the 
shopping-cart placeholder when a user removes a drill from the shopping cart.

Clearing Campaign Queries from Ad Placeholders

In general, for clearing ad placeholders, we recommend that for each scenario that 
includes an ad-placeholder action, you include an additional scenario action that 
displays queries for generic ads in the same ad placeholder when a user logs in.

However, there may be cases where you want to clear out all campaign queries from a 
placeholder to make sure the query being put in a placeholder has no competition from 
other campaign queries.

Figure 10-9 shows how an ad placeholder can contain multiple queries that compete 
with each other.

Figure 10-9   Queries in an Ad Placeholder

Assuming all queries have the same priority (see “Determining Which Query is Run 
in “Displaying Ads”), all queries in this placeholder have an equal chance of being run, 
giving you less certainty about which ad will appear.
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Note: If the default queries are set to be suppressed if campaign queries are present, 
they will not be used if a campaign query is put in the placeholder. See 
“Suppressing Default Queries when Campaign Queries Exist” in “Displaying 
Ads.

If your organizational policies allow it, you can set an ad action to remove other 
campaign queries from a placeholder when the action is run, thereby ensuring that the 
query placed by the action is run in the placeholder (assuming the default queries are 
suppressed, as explained in the previous note).

To remove other campaign queries when an action is run:

1. With the campaign open in the E-Business Control Center, open the scenario ad 
action you want to work with.

If you need to create a scenario or ad action, see “Adding Scenarios to the 
Campaign” on page 10-3 and “Adding Actions to Your Scenarios” on page 10-5.

2. In the Ad Action window, click the “Do not remove any other ads” link, as 
shown in Figure 10-10.

Figure 10-10   Removing Other Campaign Queries

The Placement Options dialog box appears, as shown in Figure 10-11.
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Figure 10-11   Placement Options Window

3. Select whether you want to remove queries in the placeholder put there by the 
current campaign, or whether you want to remove queries in the placeholder put 
there by any campaign.

Default queries always remain in the placeholder unless you delete them in the 
placeholder editor in the E-Business Control Center. Even though they remain in 
placeholders, they do not necessarily run. Default queries will not run when a 
campaign query is present, if you have defined the default queries accordingly.

Note: There is an option in the E-Business Control Center that, among other things, 
lets you clear all ads (all campaign queries) put in placeholders by campaign 
actions (Tools → Reset Campaigns). This option is primarily for campaign 
debugging purposes. See “Debugging Campaigns” on page 10-33.

E-mail Actions

As part of specifying an e-mail action—an action that automatically sends an e-mail to 
a visitor when the action is triggered—you will need to reference a previously 
developed e-mail message. Be sure that you have already developed some e-mail 
messages, as explained in “Authoring E-mails” on page 9-18.

When you specify e-mail actions, remember that e-mails will only be sent to those 
customers who visit your Web site, meet the conditions you specify for the action, and 
have not chosen to opt out of receiving e-mails.

To add e-mail actions to your scenario, follow these steps:

1. Select the name of the scenario to which you want to add the action.

2. Click the New Action button, and select E-mail. The New E-mail Action window 
appears, as shown in Figure 10-12.
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Figure 10-12   New E-mail Action Window

3. Click the check boxes shown in the Conditions portion of the New E-mail Action 
window to select the condition(s) under which the e-mail will be sent.  Text 
describing the conditions you selected appear in the Action portion of the New 
E-mail Action window.

You must add at least one condition, or you will not be able to save the scenario 
action. For an explanation of the possible conditions, see “Listing of the 
Available Conditions” in “Building Conditions and Queries in the BEA 
E-Business Control Center.”

Tip: You can use conditions in ways that always evaluate to true. For example, 
you can select the It Is after a Given Date condition and then specify the 
date as January 1, 1970.

4. For each condition you select, you must specify values for any bracketed 
hyperlinked text that appears in the Action portion of the window.
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For example, if you selected The Date Is condition, you must specify a value for 
the hyperlinked [date] text in “the date is [date]” condition statement, shown in 
the Action portion of the New E-mail Action window.

To specify values for bracketed hyperlinked text, just click the text. Depending 
on the condition and the hyperlink, a window or a dialog box opens. Table 10-1 
provides a consolidated listing of the conditions and indicates where to look if 
you need detailed instructions for any of the corresponding windows/dialog 
boxes.

5. If you selected more than one condition, you may want to click the All hyperlink 
in the When All Of These Conditions Apply phrase to change All to Any. The 
Any/All link acts as a toggle. Clicking on Any will change it to All, and visa 
versa.

6. Click the [Server URL], [Subject], or [Sender Address] hyperlink. The Enter 
E-mail Information dialog box opens, as shown in Figure 10-13.

Figure 10-13   Enter E-mail Information Dialog Box

7. In the URL for E-mail Content field, specify the e-mail that will be sent. You can 
type the URL of the e-mail, or you can click the Browse button to select the 
e-mail you want on the server.

A valid server URL is the location of the file relative to your application 
directory. For example, if your file is found at 
PORTAL_HOME\applications\wlcsApp\wlcs\campaigns\emails\

email.jsp on your sever, where wlcsApp is your enterprise application folder, 
the valid URL would be the path below that application directory to the e-mail 
JSP file. For example, /wlcs/campaigns/emails/email.jsp.
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Note: If the e-mail files are stored in a specific directory structure on the server, 
you will be able to use the Browse button to locate the e-mail messages you 
want. This directory structure is:

PORTAL_HOME\applications\<app_name>\campaigns\emails

where <app_name> is your enterprise application directory.

8. If you enter the URL manually, skip to step 11.

9. If you click the Browse button to locate an e-mail, the Select E-mail Content 
window is displayed, as shown in Figure 10-14.

Note: If you have not yet set up connection settings to the server for retrieving or 
previewing e-mail messages stored on the server, the Connection Setup 
window appears. If you have already set up a server connection, select the 
name of the connection in the Display Name field, and enter your user 
name and password. If you have not set up a connection to the server yet, 
see “Connecting to the Server” in the “Introduction to the BEA E-Business 
Control Center” for information.

Figure 10-14   The Select E-mail Content Window

10. Select the e-mail you want, and click OK.

The Select E-Mail Content window closes, and the URL of the e-mail appears in 
the Enter E-Mail Information window.

11. Enter a subject for the e-mail and an optional sender’s e-mail address.

Note: To preview the e-mail, click Preview. (You need a server connection to 
preview e-mail. See the previous Note.) When prompted to enter a user ID, 
the name you enter will be used to show a personalized version of the 
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e-mail, and is inserted where the customer’s real user ID would typically 
appear.) Click OK. A preview of the e-mail will be displayed in your Web 
browser.

12. Click OK. The Enter E-mail Information dialog box closes, and the e-mail URL, 
subject, and sender e-mail address (if applicable) appear in place of the generic 
hyperlinks in the Action portion of the New E-mail Action window.

13. If you want the scenario to run only once per visitor, select the Once This Action 
Is Performed, Do Not Run the Scenario Again for This Visitor option at the 
bottom of the New E-mail Action window.

For example, if you wanted a given customer to receive only one e-mail, 
regardless of how many times that customer entered the site or matched the 
relevant conditions, you would select this option.

14. Click OK. The New E-mail Action window closes. The conditions and 
corresponding actions you selected appear beneath the scenario name (and if 
applicable, customer segments) in the Scenarios list.

You may add different types actions to your scenario. For example, you may now want 
to add an ad or discount action to the same scenario where you just added the e-mail 
action. You may also choose to add another e-mail action to the same scenario. 
(Whether you do so or not depends upon whether you want to target the same segments 
that are specified in this scenario.)

Discount Actions

If you use WebLogic Portal, the E-Business Control Center includes an option for 
specifying discounts as a scenario action.

As part of specifying a discount action, you will need to select from a list of predefined 
discounts. Be sure that you have already defined some discounts, as explained in 
“Defining a New Discount with the Discount Terms Wizard” or “Defining a New 
Discount with the Discount Editor” in “Defining Stand-Alone or Campaign 
Discounts.”

To add discount actions to your scenario:

1. Select the name of the scenario to which you want to add the action.

2. Click the New Action button, and select Discount. The New Discount Action 
window appears, as shown in Figure 10-15.
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Figure 10-15   New Discount Action Window

3. Click the check boxes shown in the Conditions portion of the New Discount 
Action window to select the condition(s) under which the discount will be 
offered. Text describing the conditions you selected appear in the Action portion 
of the window.

You must add at least one condition, or you will not be able to save the scenario 
action. For an explanation of the possible conditions, see “Listing of the 
Available Conditions” in “Building Conditions and Queries in the BEA 
E-Business Control Center.”

Tip: You can use conditions in ways that always evaluate to true. For example, 
you can select the It Is after a Given Date condition and then specify the 
date as January 1, 1970.

4. For each condition you select, you must specify values for any bracketed 
hyperlinked text that appears in the Action portion of the window.
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For example, if you selected The Date Is condition, you must specify a value for 
the hyperlinked [date] text in “the date is [date]” condition statement, shown in 
the Action portion of the New Discount Action window.

To specify values for bracketed hyperlinked text, just click the text. Depending 
on the condition and the hyperlink, a window or a dialog box opens. Table 10-1 
provides a consolidated listing of the conditions and indicates where to look if 
you need detailed instructions for any of the corresponding windows/dialog 
boxes.

5. If you selected more than one condition, you may want to click the All hyperlink 
in the When All Of These Conditions Apply phrase to change All to Any. The 
Any/All link acts as a toggle. Clicking on Any will change it to All, and visa 
versa.

6. Click the [Discount] or [Explanation] hyperlinks. The Select Discount window 
opens, as shown in Figure 10-16.

Figure 10-16   Select Discount Window
 

7. In the Select Discount window, select the discount you want.

Verify that you are selecting the appropriate discount by viewing the text shown 
in the Description text area.

8. Enter an optional explanation for the discount in the Discount Explanation field.

The discount explanation may be displayed to customers receiving the discount, 
if your technical staff chooses to use it. For more information about discount 
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explanations, see “Uses of Discounts” in “Defining Stand-Alone or Campaign 
Discounts.”

9. Click OK. The Select Discount window closes. The discount name appears in 
place of the generic [Discount] hyperlink, and if you specified a discount 
explanation, the discount explanation appears in place of the generic 
[Explanation] hyperlink in the Action portion of the New Discount Action 
window.

10. If you want the scenario to run only once per visitor, select the Once This Action 
Is Performed, Do Not Run the Scenario Again for This Visitor option at the 
bottom of the New E-mail Action window.

For example, if you want your customers to receive the discount only when they 
register, regardless of how many times they have entered the site or matched the 
relevant conditions, you would select this option.

11. Click OK. The New Discount Action window closes. The conditions and 
corresponding actions you selected appear beneath the scenario name (and if 
applicable, customer segments) in the Scenarios list.

You may add different types of scenario actions to your scenario. For example, since 
a customer only sees the results of a discount action in the shopping cart, you may also 
want to create an e-mail or ad action that notifies the customer about the discount in a 
place other than the shopping cart.

Entering the Campaign Duration and End Criteria

In the Start/Stop pane (Figure 10-17), enter a start date, start time, stop date, and stop 
time for your promotional campaign in the fields provided.

The dates and times you set are in relation to universal time (UTC). For more 
information, see “Important Note About Dates and Times” in “Building Conditions 
and Queries in the BEA E-Business Control Center.”
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Figure 10-17   Campaign Duration and End Criteria Pane

If your promotional campaign will contain scenarios with ad actions, you may now 
want to specify end criteria (goals). For more instructions on how to specify campaign 
end criteria, see “Specifying Campaign End Criteria.”

For more information about ad actions, see “Designing Campaign Scenario Actions” 
on page 9-7.

Specifying Campaign End Criteria

If you plan on using ad actions in your scenarios and want to end your campaign when 
certain ad-related goals are reached, you may want to supply some campaign end 
criteria. If the campaign end criteria are met, the campaign will be terminated even if 
the date on which this occurs is prior to the stop date you specified.



10 Creating and Managing Promotional Campaigns

10-24 Guide to Using the BEA E-Business Control Center

Note: To improve performance, your business engineer may create a cache that 
limits the number of times a campaign checks with the database to determine 
whether it has achieved its goal. By default, a campaign updates the cache 
every 5 minutes. If the cache contains stale data, then it may be possible for a 
campaign to exceed its goal. For more technical information about this 
performance-related topic, refer to “Campaign Service Properties” in the 
Deployment Guide documentation.

You can specify campaign end criteria based on the number of impressions (views) 
associated with the ad, the number of ad clickthroughs, or a combination of both.

To specify campaign end criteria:

1. In the End Criteria region of the Start/Stop pane, click New. The Goal Detail 
window opens, as shown in Figure 10-18.

Figure 10-18   Goal Detail Window

2. In the Goal Type field, select whether you want this end criterion to be based on 
Ad Impressions or Ad Clickthroughs.

3. In the Target Number field, enter the number of ad impressions or ad 
clickthroughs required to meet the goal.
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4. In the Specify Ads region, specify the ad(s) that will be used to count impressions 
and clickthroughs. You can enter the path and filename of an ad in the Enter Ad 
IDs field, or you can click the Get Ad IDs button to search your ad database for 
the ad(s) you want.

Note: The ad identifier is usually the relative path to an ad file in your ad 
database. In the Tour Campaign 1 in the wlcsApp sample application, for 
example, the following ad identifier used is: 
Ads/wlcscm_ads/tourBannerFixup.jpg. However, the details of 
exactly what constitutes an ad identifier may vary from one content 
management system to another. Be sure to check with your business 
engineer for details.

5. If you manually enter an ad identifier, click Add. The ad identifier is added to the 
list below. Skip to step 15.

6. If you click the Get Ad IDs button to locate an ad, the Get Ad IDs window is 
displayed, as shown in Figure 10-19.

Figure 10-19   The Get Ad IDs Window

7. In the Scenarios from This Campaign field, select the scenario containing the ad 
query you want.
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You can only perform ad searches in this window based on searches that are 
already defined in the scenario you selected. This ensures that you base your 
campaign end criteria on ads that are sure to be used by the scenario.

8. In the Ad Searches field, select the number of the query in the selected scenario 
that will retrieve the ad(s) you want.

9. Click the Retrieve Ad IDs button. The ads from that search appear in the Ad IDs 
pane. You can click the Preview button to view the selected ads in a browser.

Note: If you have not set up connection settings to the server for searching your 
ad database, the Connection Setup window appears. If you have already set 
up a server connection, select the name of the connection in the Display 
Name field, and enter your user name and password. If you have not set up 
a connection to the server yet, see “Connecting to the Server” in the 
“Introduction to the BEA E-Business Control Center” for information.

10. Select the ad you want as part of your campaign end criteria, and click OK. The 
Get Ad IDs window disappears, and the ad you selected appear in the Ads to Be 
Tracked pane of the Goal Detail window.

11. If necessary, repeat the previous steps until all the ads you want are listed.

Note: If you want to remove an ad identifier from the list, select it and click 
Remove.

12. In the Target Basis region, select whether the number you entered in the Target 
Number field can be reached by a total of All Ads in the Tracking List, or when 
Any Given Ad in the Tracking List reaches that number of clickthroughs or 
impressions.

13. In the Target Scope region, select whether you want to count the ads only within 
this campaign or across multiple campaigns.

Choosing to count the ads across multiple campaigns means that if a visitor in 
another campaign views/clicks the ad, the impression/clickthrough would still be 
counted as an increment in this campaign toward meeting the goal.

14. Click OK. The Goal Detail window closes, and the information you specified 
appears in the Goals list (as shown in Figure 10-20).
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Figure 10-20   Goals List

15. If necessary, repeat the previous steps until you have specified all the end goals 
you want.

Note: To modify a goal, select it and click Edit. To remove a goal from the Goal 
list, select it and click Delete.

16. At the bottom of the window, specify whether you want to end the campaign 
when ANY or All of the goals shown in the Goals list are met. These options are 
available only if you have multiple goals.

17. Save the campaign. For more information, see “Saving Files” in the “Introduction 
to the BEA E-Business Control Center.”

Locating Existing Campaigns

If you have defined many campaigns, you may find the need to locate specific 
campaigns or campaigns containing specific data.
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The E-Business Control Center has a campaign search feature that lets you locate 
campaigns by keyword within campaign, campaign sponsor, activation status (active 
or deactivated campaigns), start and stop date ranges, and customer segments used.

To use the campaign search tool:

1. Click the Campaign Search icon on the Explorer toolbar. The Campaign Search 
window opens, as shown in Figure 10-21.

Figure 10-21   Campaign Search Window

Note: The Search function only works to locate campaigns.  It does not allow you 
to search for other objects, such as customer segments or discounts.

2. Enter your search criteria. The more criteria you add to the search, the narrower 
the search will be.

Use the following guidelines to help you search:

l Keywords and Campaign Sponsor – Enter partial or full words. Separate 
each word with a space. Select the Name, Description, and Goal options to 
search in those fields. Deselect those options to prevent a search in those 
fields.

l Activation Status – Select the Activation Status option if you want to search 
for Active or Deactivated campaigns. (See “Deactivating and Reactivating 
Campaigns” on page 10-31.) If you do not select this option, campaigns will 
be searched regardless of their status.

An active campaign does not necessarily mean the campaign is running. 
Campaigns only run between the start/stop times you specified and when the 
appropriate conditions are met. Therefore, searching for an active campaign 
may not necessarily mean you are searching for a campaign that is running.
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When you click the More Options button, the following regions appear, as 
shown in Figure 10-22:

l Dates – You can search for campaigns on or after a particular start date, on 
or before a particular stop date, or both (within a date range).

l Customer Segments – To search for campaigns containing one or more 
specific customer segments, move the segments you want to search for into 
the Selected Segments list.

If you specify customer segments as part of the search criteria, the search 
function will locate only campaigns that have those segments specified at the 
scenario level. If a campaign has the segments specified at the action level 
instead, the campaign will not be retrieved as a match. For more information 
about the differences between specifying customer segments at the scenario 
and scenario action levels, see “Customer Segments in Scenario Actions” on 
page 9-10.

Figure 10-22   Expanded Campaign Search Window

3. Click Search. If any campaigns matching your criteria are found, they are 
displayed in the bottom portion of the Campaign Search window, as shown in 
Figure 10-23.
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Figure 10-23   Campaign Search Results

In the search results area, you can sort the columns by clicking the column names. You 
can also open a campaign in the search results by selecting it and clicking Open.

Modifying Existing Campaigns

The E-Business Control Center lets you to view and modify existing campaigns. After 
you modify an active campaign, you also have the opportunity to reset aspects of the 
campaign, such as removing previously placed ads, clearing counts of ad impressions 
and clickthroughs, resetting scenarios that are set up to run once per visitor, and 
clearing pending e-mails.

To modify a campaign:
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1. Open an existing campaign in the E-Business Control Center.

For more information, see “Opening Files” in the “Introduction to the BEA 
E-Business Control Center.”

Tip: If there is a long list of campaign names, you might want to use the name 
filter or the search function to locate the campaign you want to modify. For 
more information about these options, see “Locating Existing Campaigns” 
on page 10-27.

2. To modify the campaign, follow the same instructions for creating a new 
campaign, starting from “Specifying General Campaign Information” on page 
10-2. If you are interested in suspending an active campaign or reactivating a 
suspended campaign, see “Deactivating and Reactivating Campaigns” on page 
10-31.

3. Save your modifications by clicking the Save icon in the main toolbar.

After you modify your campaign, you may want to reset certain aspects of the 
campaign, such as ads and pending e-mails. For more information, see “Debugging 
Campaigns” on page 10-33.

Warning: Be certain that the modifications you make are in line with your 
e-business strategy and that you entered the modifications correctly in the 
E-Business Control Center.

Deactivating and Reactivating Campaigns

Once campaigns are saved, they are considered active. (In other words, after the entire 
application is synchronized, the campaign will be ready to run between the start/stop 
times you specified and when the appropriate conditions are met.)

If for some reason you want to disqualify an active campaign from running or stop a 
running campaign prior to the specified stop date (or before end goals are reached, if 
your campaign contains them):

1. Open the campaign.

2. Select the Deactivate This Campaign check box in the Start/Stop pane.

3. In the warning dialog box that appears, click OK.
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4. Save the campaign.

In the Explorer window, the icon next to the deactivated campaign becomes a 
lighter color, indicating that it is deactivated.

Note: The application must be synchronized to the server for the live campaign to 
become deactivated. For the procedures on synchronizing, see “Synchronizing 
Application Data” in the Deployment Guide.

If at any time you want to reactivate a campaign, deselect the Deactivate This 
Campaign option, click OK at the prompt, and save the campaign.

After you synchronize the application to the server, the campaign becomes active. A 
campaign that is reactivated is once again ready to run between the start/stop times you 
specified and when the appropriate conditions are met.

Deleting Existing Campaigns

When you delete a campaign in the E-Business Control Center, the campaign is 
removed from the server when you synchronize your application.

Warning: As with any deletion you make, be absolutely certain that you select the 
correct campaign and that you are sure you want to delete it.  Deleted 
campaigns cannot be retrieved.

To delete an existing campaign, follow these steps:

1. If necessary, switch to the Campaigns view by clicking the Campaigns icon in the 
Explorer window. A list of campaigns appears in the Campaigns list.

2. Click the name of the campaign you want to delete.  The campaign is highlighted.

Tip: If there is a long list of campaign names, you might want to use the name 
filter or the search function to locate the campaign you want to delete. For 
more information about these options, see “Locating Existing Campaigns” 
on page 10-27.

3. To delete the campaign, click the Delete icon on the Explorer toolbar.
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Debugging Campaigns

While testing the campaigns you have created, it is helpful to reset the campaigns so 
they behave as if they have been deployed for the first time.

The E-Business Control Center has an option, designed primarily for debugging, that 
lets you:

n Remove previously placed ads from rotation

n Clear counts of ad impressions and clickthroughs

n Reset “run once per visitor” scenarios

n Clear pending e-mails

To reset campaign states:

1. Choose Tools → Reset Campaigns in the menu. The Reset Campaign States 
window appears, as shown in Figure 10-24.

Figure 10-24   The Reset Campaign States Dialog Box

2. In the Active Campaigns list, select the campaign you want to reset.
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Even Campaigns that have ended can be considered active and appear in the list. 
Only when the Deactivate This Campaign option is selected in the Start/Stop 
pane of a campaign does it not appear in the Active Campaigns list.

3. Select the appropriate reset options for the selected campaign.

4. Repeat the previous steps for all campaigns you want to reset.

5. Click OK.

If you have not set up connection settings to the server, the Synchronization 
Setup window appears. If you have already set up a server connection, select the 
name of the connection in the Display Name field, and enter your user name and 
password. If you have not set up a connection to the server yet, see “Connecting 
to the Server” in the “Introduction to the BEA E-Business Control Center” for 
information. Click Connect.

If you have already set up connections, but you have not yet logged in to the 
server for the current E-Business Control Center session, you must log on in the 
Logon window that appears.

6. The Clearing Campaigns window appears, showing you the progress of the reset.

7. When the reset is complete, as displayed in the Clearing Campaigns window, 
click OK. You can begin debugging your campaign(s).

You can also set the E-Business Control Center to automatically display the Reset 
Campaign States window after you synchronize. To do this, choose Tools → 
Synchronization Settings in the menu. In the Synchronization Settings window, select 
the “Show reset options for active campaigns” option and click OK. Each time you 
synchronize, after clicking the Close button in the Synchronizing status window when 
synchronization is complete, the Reset Campaign States window appears, letting you 
clear campaign states.

Reactivating Campaigns That Have Ended Because of 
Goals Being Met

If a campaign that has ended because its goals were met prior to the end date of the 
campaign (see “Specifying Campaign End Criteria” on page 10-23), you can reactivate 
that campaign by resetting the ad impressions or clickthroughs that caused it to reach 
its goals and end.
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1. Choose Tools → Reset Campaigns in the menu. The Reset Campaign States 
window appears, as shown in Figure 10-24.

2. In the Active Campaigns list, select the campaign you want to reset.

3. Select the “Reset counts of ad impressions and clickthroughs” option.

4. Select any additional reset options you want.

5. Click OK.

For more information, see “Debugging Campaigns” on page 10-33.

6. After the campaign states are reset, you must re-synchronize the application for 
the campaign to be reinstated.

a. Choose Tools → Synchronization Settings in the menu.

b. In the Synchronization Settings window, select the “Update all files in the 
application” option.

If you have made changes to the campaign, you can select the “Update only 
modified files in the application” option instead.

c. Click OK.

d. Synchronize the application. See “Synchronizing Application Data” in the 
“Introduction to the BEA E-Business Control Center.”
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CHAPTER

11 Webflow Components 
and Concepts

As described in “Overview of Webflow,” the Webflow mechanism controls the 
presentation of Web pages as visitors interact with your Web applications.  To 
accomplish this, Webflow makes use of various components, some of which are 
designed to handle complex tasks like form validation or execution of back-end 
business processes.  This topic first introduces you to all the components that may 
comprise a Webflow, and includes:

n Introduction to Webflow Components

n Presentation and Processor Nodes

n Input Processors and Pipelines

n The Pipeline Session

n Events

n Namespaces

n Special Webflow Components

l The Begin Node

l The Root Component Node

l The Wildcard Nodes

l The Configuration Error Page

Next, this topic discusses some additional concepts with respect to using the Webflow 
mechanism, including:

n Chaining and Branching with Processor Nodes
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n Using Webflow Components in Your Web Pages

n Using Webflow Components with Portals

n Webflow Execution Order

l Presentation Nodes

l Processor Nodes

Notes: For information about using the Webflow and Pipeline Editors to work with 
the components described in this topic, see “Using the Webflow and Pipeline 
Editors.”  For information about customizing and extending the Webflow 
mechanism, see “Customizing and Extending Webflow.”
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Introduction to Webflow Components

Figure 11-1 illustrates the typical relationships among Webflow components. You can 
refer back to this illustration as you read more about each component.

Figure 11-1   Typical Relationship Among Webflow Components

Note: Webflow used in portal applications may respond to more events than are 
shown in Figure 11-1.  For more information about portal applications and use 
of the Webflow mechanism, see “Customizing Portlets and Portals” in the 
Getting Started with Portals and Portlets documentation.

A Webflow can first be subdivided into nodes and events.  A node represents a state 
in the Webflow.  Depending on the node type, there are a number of predefined events 
that may occur (such as a visitor clicking a link on a Web page).  When a particular 
event happens, the Webflow decides which subsequent node to invoke to continue the 
flow.  This process is referred to as a transition, and is illustrated in Figure 11-2.
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Figure 11-2   Generic Webflow Transition

As is also shown in Figure 11-2, nodes may be referred to as  origin or destination 
nodes, depending on their location in a transition.

For more information about node types, see the next section, “Presentation and 
Processor Nodes.”  For more information about the events associated with each node, 
see “Events” on page 11-7.

Presentation and Processor Nodes

There are two main types of nodes: presentation nodes and processor nodes.  Each of 
the presentation and processor nodes can be used as origin or destination nodes within 
the Webflow.  

As their name implies, presentation nodes represent states in which the Webflow 
presents or displays something to a person interacting with the Web application.  A 
Webflow must always start and end with a presentation node.  The form of the 
presentation can be:

n HTML

n JavaServer Page (JSP)

n Java servlets

You can also create extension (custom) presentation nodes for use in the Webflow.  For 
more information about extension presentation nodes, see “How to Create an 
Extension Presentation Node.”

In contrast to presentation nodes, processor nodes represent states in which the 
Webflow invokes more specialized components to handle activities like form 
validation, or back-end business logic that drives the site’s presentation.  The processor 
nodes available for use are:

n Input Processors
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n Pipelines

“Input Processors and Pipelines” on page 11-5 discusses these processor nodes in more 
detail.

You can also create extension (custom) processor nodes for use in the Webflow.  For 
more information about extension processor nodes, see “How to Create an Extension 
Processor Node.”

Note: For more information about creating a presentation or processor node in the 
Webflow Editor, see “How to Add Webflow Components.”

Input Processors and Pipelines

Input Processors and Pipelines are the two different types of processor nodes that come 
packaged with the Webflow implementation.

Input Processors are predefined, specialized Java classes that carry out more complex 
tasks when invoked by the Webflow mechanism.  Input Processors are typically used 
to validate HTML form data, or to provide conditional branching within a Web page.  
For example, an Input Processor may contain code that verifies whether a date has been 
entered in the correct format, as opposed to embedding that code within the same JSP 
that displays the form fields.  Input Processors contain logic that is specific to the Web 
application, and are therefore loaded by the Web application’s container.  

Input Processors are embedded in Web pages using specialized  JSP tags, which are 
discussed in “Webflow JSP Tag Library Reference.”  Java/EJB developers report the 
status of processed form fields back to HTML/JSP developers via the 
ValidatedValues class, which is discussed in “Webflow Validators and Input 
Processors.”

A Pipeline is also a type of processor node that may be invoked by the Webflow.  
Pipelines initiate the execution of specific tasks related to your business process, and 
can be transactional or nontransactional.  For example, if a visitor attempts to move to 
another page on your Web site but you want to persist the visitor’s information to a 
database first, you could use a Pipeline.  Pipelines contain business logic that may 
apply to multiple Web applications within a larger enterprise application, and are 
therefore loaded by the Enterprise JavaBean (EJB) container.  
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Note: For more information about transactional versus nontransactional Pipelines, 
see “Transactional Versus Nontransactional Pipelines.”

All Pipelines are collections of individual Pipeline Components, which can be 
implemented as Java objects or stateless session Enterprise JavaBeans (EJBs).  
Pipeline Components are the parts of a Pipeline that actually perform the tasks 
associated with the underlying business logic.  When these tasks are complex, Pipeline 
Components may also make calls to external services (other business objects).  

Notes: For an explanation of the different Pipeline Component implementations, see 
“Implementation of Pipeline Components as Stateless Session EJBs or Java 
Objects.”

For more information about creating an Input Processor or Pipeline in the 
Webflow Editor, see “How to Add Webflow Components.”

The Pipeline Session

It is often necessary to keep track of information gathered from your Web site visitors, 
or to share the data modified by Pipeline Components and Input Processors as a visitor 
moves through the site.  You may also want to access data that is part of a larger 
enterprise application, or make a process transactional.  To accomplish these tasks, the 
Webflow mechanism makes use of a Pipeline Session. 

A Pipeline Session is an object that is created and stored within the HTTPRequest 
object.  The Pipeline Session provides a single point of communication for all Pipeline 
Components in a given Pipeline.  Input Processors also read data from the 
HTTPRequest and then use that data to create or update Java objects in the Pipeline 
Session.  The Pipeline Session also provides central access and storage for external 
classes and also has transactional capabilities.  For more information about including 
the Pipeline Session in transactions, see “Including Pipeline Sessions in Transactions.”

Note: If you have used a prior implementation of Webflow, you may recall that the 
Pipeline Session used to be stored in the HTTPSession rather than in the 
HTTPRequest.  This has been changed to enhance performance and facilitate 
clustering.
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The Pipeline Session is comprised of many name/value pairs called attributes or 
properties.  Pipeline Components, Input Processors, and external classes act on 
particular properties that exist within the Pipeline Session, and may also add new 
properties as necessary.  All objects set in and retrieved from the Pipeline Session 
should be serializable.  For more information about serializing objects in the Pipeline 
Session, see “Serializing Pipeline Session Properties.”

To get or set a Pipeline Session property within a Web page, you will use the Pipeline 
Session JSP tags, described in “Webflow JSP Tag Library Reference.”  To work with 
the Pipeline Session from within Input Processor or Pipeline classes, you will use the 
provided support methods to access the Pipeline Session directly.  For more detailed 
information about accessing the Pipeline Session using the support methods, see 
“Pipeline Session Internals.”

Events

Each node in a Webflow responds to events, which cause transitions (that is, 
movement from an origin node to a destination node).  However, the types of events a 
node responds to depends on whether the node is a presentation node or a processor 
node.

As shown in Figure 11-1, presentation nodes respond to the following events:

n Links

n Buttons

In other words, when a visitor to the Web site clicks a link or a button, the Webflow 
responds to that event.  A response might be to transition to another presentation node 
(such as a JSP) or to a processor node (such as an Input Processor to validate 
visitor-provided form data).

In contrast, processor nodes respond to the following events:

n Exceptions

n Return objects
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Exceptions occur when an Input Processor or Pipeline does not execute properly, and 
indicates an error state.  (More information about working with exceptions can be 
found in “Error Handling.”)  Otherwise, these processor nodes return an object that the 
Webflow can use to continue.  

Notes: Webflow used in portal applications may respond to more events than those 
described above.  For more information about portal applications and use of 
the Webflow mechanism, see “Customizing Portlets and Portals” in the 
Getting Started with Portals and Portlets documentation.

For more information about connecting presentation and processor nodes with 
event and/or exception transitions in the Webflow Editor, see “How to 
Connect Nodes with Event or Exception Transitions.”

Namespaces

Although you will generally have only one Webflow per Web application, 
namespaces allow you to divide your Webflow into a number of smaller, more 
manageable modules.  This modularity may make your development team more 
productive by allowing individual developers to simultaneously work with various 
portions of a Web application, without having to worry about naming collisions.  For 
example, a Pipeline Component defined in one namespace can access a variable 
defined in another namespace, then redirect to a JSP defined in yet a third namespace.

You can have any number of namespaces within a Webflow, but namespaces can only 
be one level deep.  In other words, you can not nest namespaces.  

Tip: Namespaces are best defined along functional lines, such as order 
management, user management, browsing, and so on.  This arrangement 
enables developers to more easily collaborate, once separate portions of the 
site require integration.  You would not typically define namespaces along 
horizontal lines (that is, Input Processors, JSPs, Pipeline Components, and so 
on) because this would make development roles/processes too restrictive.

When a Web application’s Webflow is divided into namespaces, the Pipeline Session 
is also subdivided accordingly.  Therefore, a Pipeline Session property set in one 
namespace can be obtained from another namespace, and vice versa.  For more 
detailed information about the Pipeline Session, see “Pipeline Session Internals.”
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Note: You must specify namespaces in a specific way when using Webflow in portal 
application.  For more information about portal applications and use of the 
Webflow mechanism, see “Customizing Portlets and Portals” in the Getting 
Started with Portals and Portlets documentation.

Special Webflow Components

In addition to the Webflow components previously described, there are four Webflow 
components that perform special functions in a Webflow.  These components are 
described in detail in this section.

The Begin Node

Typically, a begin node is a node designated as the initial entry point or state of the 
Webflow, which automatically transitions to a presentation or processor node.  The 
begin node is generally a presentation node in the form of a JavaServer Page (JSP).

If a URL does not specify an origin, namespace, or event, the Webflow mechanism 
looks for a begin node in the default namespace.  If one is located, the begin node is 
used as the starting point for the visitor’s interaction with the application.  Therefore, 
although the begin node is optional, we recommend that you have at least one defined 
in your default namespace.

Note: You specify a default namespace in the  P13N_DEFAULT_NAMESPACE  context 
parameter of your Web application’s WEB-INF/web.xml file.  For more 
information about this context parameter, see “Setting Up Your Web 
Application’s web.xml File.”  For more information about how an 
application’s Webflow gets invoked from a URL, see “Understanding How 
Webflow Is Invoked from a URL.”

You can have more than one begin node in a Webflow (one for each namespace).  If a 
namespace specified in the URL has its own begin node, the Webflow will use that 
begin node before looking for a begin node in the default namespace.  You can also 
use a begin node as a destination node in a Webflow transition.
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Note: For more information about designating an existing node as a begin node in 
the Webflow Editor, see “How to Designate or Remove a  Begin (Root) 
Node.”

The Root Component Node

A root component node is analogous to the begin node for a Webflow, only it is the 
entry point into or initial state of a Pipeline.  You must have one (and only one) root 
component node per Pipeline.

Note: For more information about designating an existing node as a root component 
node in the Webflow Editor, see “How to Designate or Remove a  Begin 
(Root) Node.”

The Wildcard Nodes

If the Webflow cannot locate a specific presentation or processor node to complete a 
transition, the Webflow will search for a wildcard presentation or processor node to 
use as the origin node.  Therefore, wildcard presentation nodes and wildcard processor 
nodes implement default behavior for your Web application.  Put another way, 
wildcard nodes allow you to abstract common functionality and to locate that 
functionality in a single place in your Webflow.  Wildcard nodes are used only when 
destination nodes are not explicitly defined in the Webflow.  You may have one 
wildcard presentation node and one wildcard processor node per namespace.

Note: If the Webflow must search for a wildcard node, there may be a slight impact 
on performance, as more processing is involved.

As an example, perhaps you want a link called Help (that is present on every page) to 
always direct to a JSP containing help information.  To do so, you might use a wildcard 
presentation origin.  Further, you might always want exceptions returned from 
processor nodes to transition to JSP containing detailed information about the error.  
This could be handled with a wildcard processor node.

Note: For more information about creating a wildcard node in the Webflow Editor 
(which is done the same way you create regular presentation and processor 
nodes), see “How to Add Webflow Components.”



Special Webflow Components

Guide to Using the BEA E-Business Control Center 11-11

The Configuration Error Page

The configuration error page is essentially a presentation node whose primary purpose 
is to display debugging information when there is a configuration error in the 
Webflow.  If the Webflow mechanism cannot locate the destination for a transition 
after exhausting a list of possible choices, the Webflow will instead display the 
configuration error page you defined.  The configuration error page is useful during 
development, but should never be displayed to visitors of your Web site.  That is, 
testing should ensure that the Webflow configuration is working before your Web 
application is put into production.

Note: For more information about how the Webflow searches for possible 
destination nodes, see “Webflow Execution Order” on page 11-13.  

You can have more than one configuration error page in a Webflow (one per each 
namespace), but are not required to have any configuration error pages if you do not 
want to.  If a namespace specified in the URL has its own configuration error page, the 
Webflow will use that configuration error page before looking for a configuration error 
page in the default namespace.  Therefore, although the configuration error page is 
optional, we recommend that you have at least one defined in your default namespace. 

Notes: You specify a default namespace in the P13N_DEFAULT_NAMESPACE  context 
parameter of your Web application’s WEB-INF/web.xml file.  For more 
information about this context parameter, see “Setting Up Your Web 
Application’s web.xml File.”

For more information about specifying a configuration error page name for 
your Webflow in the Webflow Editor, see “How to Set the Configuration Error 
Page Name.”
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Chaining and Branching with Processor 
Nodes

Much like you can move from one presentation node (such as a JSP) to another, you 
can also move from one processor node (such as an Input Processor) to another 
processor node.  In other words, you do not necessarily need to use processor nodes in 
between presentation nodes.  For processor nodes, this movement is called chaining.  
In a chaining arrangement, the result state of one successfully executed processor node 
is another processor node.

Another useful technique regarding processor nodes is branching.  You can branch on 
Input Processor nodes based on the value of the object the Input Processor returns.  For 
example, you can code an Input Processor such that one response from a Web site 
visitor returns one value, and a different response returns a different value.  Based on 
the value of the object returned from successful execution of the Input Processor, you 
can cause the Webflow to direct to different destination nodes.  Similarly, you can 
branch on Pipelines based on the exceptions it returns.  Based on the type of exception 
thrown, you can cause the Webflow to direct to different destination nodes.  (You 
cannot branch on return values of objects in Pipelines because the Pipeline 
Components within them return Pipeline Session properties instead.) 

Using Webflow Components in Your Web 
Pages

When you use the Webflow mechanism in your Web application, each of the URLs 
within that application should be dynamically generated.  This is accomplished by 
using the Webflow JSP tags, described in “Webflow JSP Tag Library Reference.”

Note: If you used the prior implementation of Webflow, you may recall that dynamic 
URL generation was formerly accomplished using the createWebflowURL() 
method of the WebflowJSPHelper class.  This method is still available, but it 
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is strongly suggested that you use the JSP tags instead.  The only reason you 
may want to use the WebflowJSPHelper class instead of a JSP tag is in a 
servlet or wrapper class.

Using Webflow Components with Portals

With a few exceptions, Webflow works the same way in portal Web applications as it 
does within the rest of the platform.  That is, you can use Webflow to coordinate 
different parts of your portal Web application, enabling code reuse and 
maintainability. 

The Webflow associated with portals are generally not to be edited because it is 
fundamental to the application logic that makes up the portal platform.  Individual 
portlets, however, can have individual Webflow files assigned to them, allowing 
practically all Webflow functionality to be applied to a portlet.

For more information, see “Customizing Portlets and Portals” in the Getting Started 
with Portals and Portlets documentation.

Webflow Execution Order

As described in “Understanding Webflow as a State Machine,” Webflow can be 
thought of as a state machine and as such, can only be in one state at a time.  Webflow 
transitions from one state to another by interpreting URLs, return values, and 
exceptions.  Therefore, to effectively work with Webflow, you need to understand the 
order in which Webflow searches for a transition.  When searching for a transition, 
Webflow always attempts to resolve transitions with the exact criteria supplied, but if 
no matches are found, Webflow broadens its search using wildcards and inheritance 
hierarchies.  The way Webflow searches for a valid transition differs slightly for 
Presentation Nodes and Processor Nodes. 

Note: An important, related concept is that Webflow knows nothing of Pipelines; 
Pipelines are just Extension (Custom) Processors that BEA has created for 
you.  Consequently, Webflow only governs the flow in and out of Pipelines but 



11 Webflow Components and Concepts

11-14 Guide to Using the BEA E-Business Control Center

not within the Pipeline itself.  (The transitions that take place inside a Pipeline 
are governed by the Pipeline engine.)   Therefore, the explanation provided in 
this section only applies to transitions to and from Presentation Nodes (JSP, 
HTML, servlets, Extension (Custom) Nodes) and Processor Nodes (Input 
Processors, Pipelines, Extension (Custom) Nodes) in a given Webflow.  

Presentation Nodes

For Presentation Nodes, Webflow’s search for valid transitions is done in the following 
manner:

1. Webflow searches to find the exact Presentation Node as supplied in the URL.  
Given the URL: 

http://localhost:7501/myapp?namespace=order&origin=shoppingcart
.jsp&event=link.help

Webflow tries to resolve to the shoppingcart.jsp Presentation Node, defined 
in the underlying order.wf Webflow namespace configuration file as:

<presentation-origin node-name=”shoppingcart” node-type=”jsp”>

2. If the shoppingcart.jsp Presentation Node is not present, Webflow searches 
for the Wildcard Node of the same node type.  (As previously shown in the URL, 
origins are in the form <node-name>.<node-type>.)  Given the same URL, 
Webflow tries to resolve to a Wildcard Presentation Node, defined in the 
underlying order.wf Webflow namespace configuration file as:

<wildcard-presentation-origin node-type="jsp">

Note: For more information about the Wildcard Presentation and Wildcard 
Processor Nodes, see “The Wildcard Nodes” on page 11-10.

3. If the Webflow fails to locate the exact Presentation Node or a Wildcard 
Presentation Node, then a configuration error has occurred, and Webflow 
searches for the configuration error page. 

Note: For more information about the configuration error page, see “The 
Configuration Error Page” on page 11-11.

Alternatively, if the Webflow does locate the exact Presentation Node or a 
Wildcard Presentation Node, then Webflow searches for the supplied event under 
the respective node.  Therefore, given the same URL, Webflow searches for the 
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link.help event in the event list, defined in the underlying order.wf Webflow 
namespace configuration file as:

<event event-name="link.help">
  <destination namespace="main" node-name="help" 
node-type="jsp"/>
</event>

4. If Webflow finds the Presentation Node but not the event, then Webflow searches 
under the Wildcard Presentation Node for that event.  If no event is found, then a 
configuration error has occurred, and Webflow searches for the configuration 
error page.

Note: For more information about the configuration error page, see “The 
Configuration Error Page” on page 11-11.

Using the Webflow and Pipeline Editors to create Webflows can help identify potential 
problems with your Webflow and greatly reduce the likelihood of errors.  This is 
because of the Webflow and Pipeline Editors’ built-in validation features.  For more 
information, see “About the Webflow and Pipeline Editors’ Validation Features.”

Processor Nodes

Processor Nodes can transition in one of two ways: they can return a Java object or 
throw a Java exception.

n If the Processor Node returns a Java object, Webflow calls toString() on that 
object and searches for an event with a matching name in the event list.  The 
same search patterns described in “Presentation Nodes” on page 11-14 apply 
here.  Webflow first tries to look for the event under the exact Processor Node 
that returned the object, but if that Processor Node is not found, Webflow 
searches for the event under a Wildcard Processor Node.

Note: For more information about the Wildcard Presentation and Wildcard 
Processor Nodes, see “The Wildcard Nodes” on page 11-10.

n If the Processor Node throws an exception, Webflow searches the exception list 
associated with the current Processor Node.  Webflow first searches for the exact 
exception thrown.  If this exception is not found, Webflow walks up the 
exception’s inheritance hierarchy in an attempt to find a match.  Webflow will 
walk all the way up the inheritance tree until it encounters the class Exception.  
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If still no match is found, Webflow searches the Wildcard Processor Node and 
performs the same exception walking activity.  

n If all previous attempts fail, the Webflow will simply load the configuration 
error page defined for the current namespace.  If the current namespace does not 
define a configuration error page, the Webflow will display the configuration 
error page defined for the default namespace.  

Note: For more information about the configuration error page, see “The 
Configuration Error Page” on page 11-11.

n If for some reason the file for the configuration error page is missing, a standard 
500 internal server error, which is outside the scope of the Webflow mechanism, 
would be displayed.

Using the Webflow and Pipeline Editors to create Webflows can help identify potential 
problems with your Webflow and greatly reduce the likelihood of errors.  This is 
because of the Webflow and Pipeline Editors’ built-in validation features.  For more 
information, see “About the Webflow and Pipeline Editors’ Validation Features.”
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CHAPTER

12 Using the Webflow and 
Pipeline Editors

The E-Business Control Center (EBCC) includes a Webflow Editor and a Pipeline 
Editor designed to help you create, modify, and validate Webflow and Pipeline XML 
configuration files.  This topic provides an introduction to the Webflow and Pipeline 
Editors, describes their graphical interfaces, and provides some step-by-step 
instructions for their use.  This topic also includes some best practices for creating, 
modifying, and migrating Webflow and Pipeline XML configuration files, and 
describes the Webflow Editor’s validation feature.  Lastly, this topic provides some 
information about synchronizing Webflow and Pipeline data for your applications.

This topic includes the following sections:

n Introduction

l Starting the Webflow and Pipeline Editors

l Important Notes About Using the Webflow and Pipeline Editors

l Next Steps

n Learning to Use the Webflow and Pipeline Editors

l Webflow and Pipeline Editor Essentials

l Webflow Component Representations

l Understanding the Webflow and Pipeline Editor Palettes

l Understanding the Webflow and Pipeline Editor Toolbars

n Organizing Webflow Components in an Editor Canvas

l How to Select Webflow Components
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l How to Add Webflow Components

l How to Edit a Webflow Component’s Name (Label)

l How to Designate or Remove a Begin (Root) Node

l How to Move a Webflow Component

l How to Connect Nodes with Event or Exception Transitions

l How to Reposition Connection Ports on a Node

l How to Work with Elbows in Transitions

n Using the Webflow and Pipeline Editor Toolbars

l How to Print a Webflow Namespace or Pipeline

l How to Delete Webflow Components

l How to Use the Zoomed Overview

l How to Show/Hide the Grid

l How to Snap Objects to the Grid

l How to Enable and Disable Link Optimization

l How to Show and Hide Exception Transitions

l How to Validate the Selected Node

l How to Validate All Nodes

l How to Set the Configuration Error Page Name

l How to Use the Pipeline Component Editor

l How to Make the Pipeline Transactional

l How to Include the Pipeline Session in a Transaction

n Using the Properties Editors

l Viewing Component Properties

l Description of Webflow Component Properties

l Modifying Component Property Values

n Migrating An Existing Webflow

n Creating or Modifying a Webflow: Breadth-First Versus Depth-First
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n About the Webflow and Pipeline Editors’ Validation Features

l Validation Error Messages in a Properties Editor

l What Do the Editors Validate?

l Saving Invalid Webflows

n Synchronizing Webflow Data for Your Application

Note: This topic assumes that you are already familiar with basic Webflow concepts.  
If you are not, refer to “Webflow Components and Concepts.”

Introduction

This introductory section provides instructions on how to start the Webflow and 
Pipeline Editors, and lists some important notes about the Editors that you should take 
into account before using them to create or modify your Webflow and Pipeline XML 
configuration files.

Starting the Webflow and Pipeline Editors

To begin using the Editors, follow these steps:

1. Start the E-Business Control Center (EBCC).  For detailed instructions on starting 
the EBCC, see “Starting the E-Business Control Center” in the Guide to Using the 
E-Business Control Center documentation.

2. Create a new Web application or open an existing Web application for which you 
will be working on a Webflow or Pipeline.  For detailed instructions on 
performing these tasks, see “Creating an Application Structure for E-Business 
Control Center Data” or “Opening Application Data” in the Guide to Using the 
E-Business Control Center documentation.  

3. Select the Site Infrastructure tab in the EBCC’s Explorer window, then click the 
Webflows/Pipelines icon.

Note: You may have to use the scroll bar to locate the Webflows/Pipelines icon.
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4. If the Webflows/Pipelines structure shown in the Explorer window is not 
expanded, click Webapps and then the Web application name to view the 
Webflow namespaces for that application, or click Pipeline Namespaces and then 
the namespace to view the Pipelines available within that namespace.  

Figure 12-1 shows the Webflow namespaces and Pipelines in expanded form for 
the sample petflow Web application.

Figure 12-1   EBCC Explorer Window With Expanded Webflows/Pipelines List

5. If you want to modify an existing Webflow, double click any of the Web 
application’s namespace files shown below the Web application name in the 
Webflows/Pipelines list.  (Figure 12-1 shows the main namespace for the 
petflow Web application being selected.)  This opens the Webflow Editor.
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Note: Listing 12-1 also indicates that the main Webflow namespace is currently 
invalid, by the red and white square icon located to its left.  For more 
information about Webflow  validity, see “About the Webflow and 
Pipeline Editors’ Validation Features.”  For more information about the 
status icons in the E-Business Control Center (EBCC), see “About the 
E-Business Control Center Interface” in the Guide to Using the E-Business 
Control Center documentation.

6. If you want to modify an existing Pipeline, double-click any of the Pipeline 
names (such as viewShoppingCart in Figure 12-1) shown in the 
Webflows/Pipelines list.  This opens the Pipeline Editor.

Note: You can also open the Pipeline Editor by double clicking on the icon 
portion of a Pipeline Node that is currently displayed in the Webflow 
Editor canvas, as shown in Figure 12-2.  For more information about 
Pipeline Nodes, see “Input Processors and Pipelines.”

Figure 12-2   Results of Double-Clicking Portions of Pipeline Node

7. If you would rather create a new Webflow or Pipeline for the Web application, 
see “Creating Webflow/Pipeline Files” in the Guide to Using the E-Business 
Control Center documentation.

Note: For general information about managing EBCC files, see “About the 
E-Business Control Center Interface” in the Guide to Using the E-Business 
Control Center documentation.
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Important Notes About Using the Webflow and Pipeline 
Editors

The following list includes useful information for developers who are about to use the 
Webflow and Pipeline Editors:

n An application’s Webflow is comprised of one or more Webflow namespace  
(<namespace>.wf) files, as well as zero or more Pipeline (<namespace>.pln) 
files that exist within a namespace.  Webflow files specify the flow of control 
between presentation nodes (JSPs, HTML, and so on) and processor nodes 
(Input Processors and Pipelines) that exist in a Webflow namespace.  Pipeline 
files contain information about the Pipeline Components that comprise a given 
Pipeline.  Therefore, when you use the Webflow Editor, you are creating or 
editing a Webflow namespace; when you use the Pipeline Editor, you are 
creating or editing the Pipeline Component nodes for a Pipeline that exists 
within a given namespace.  For more information, see “Webflow and Pipeline 
Editor Essentials” on page 12-9.

n The Webflow and Pipeline Editors are designed to help you create, modify, and 
validate <namespace>.wf and <namespace>.pln XML configuration files that 
are associated with a particular Web or enterprise application, respectively.  The 
Editors do not support the editing of arbitrary files or other files in the WebLogic 
Portal product suite.

n The recommended editing method for the Webflow and Pipeline XML 
configuration files is via the Webflow and Pipeline Editors.  If while 
hand-editing the XML configuration files in a text editor you create invalid 
entries, or if you fail to provide a namespace called main when using a begin 
node as the destination of an event in a new Webflow (as in <destination 
node-name=”begin”/>), the behavior of the Editors may be unpredictable.

n It is expected that if Webflow and Pipeline XML configuration files for an 
application are stored in a Content Management System, they will be checked 
out by developers prior to modification in the Webflow and Pipeline Editors.  If 
the appropriate files are not checked out, the Editors will open the files in 
read-only mode and the Editor palettes and toolbars that typically allow you to 
make modifications will not be shown.  For more information, see “Webflow 
and Pipeline Files in Your Content Management System” on page 12-12.
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n The Webflow and Pipeline Editors’ use of namespace files allows different 
developers to work on portions of a single application’s Webflow at the same 
time.  Keep in mind, however, that references to nodes in other namespaces 
(called proxy nodes) are simply a snapshot of information that was available in 
your Content Management System at the time your files were checked out.  
Other developers with write permission for the application may be 
simultaneously modifying namespace modules within the application, causing 
the Webflow to enter an invalid state.  It is important that developers on the team 
work together to ensure that changes are propagated to all affected namespaces 
and result in a valid Webflow for the entire application.  The Webflow and 
Pipeline Editors do allow you to save a Webflow or Pipeline that is invalid, but 
you must ensure that an application’s Webflow (as a whole) is valid prior to data 
synchronization.  See “Synchronizing Application Data” in the Deployment 
Guide for more information.

n The E-Business Control Center (EBCC) does not support role-based security.  
Any user with access to the EBCC can also access the Webflow and Pipeline 
Editors.

n By default, changes made to Webflow and Pipeline XML configuration files do 
not require you to restart the server or perform any special deployment activities.  
Instead, the Webflow and Pipeline data for a particular application is 
synchronized along with other application data.  See “Synchronizing Application 
Data” in the Deployment Guide for more information.  If errors in a Webflow (or 
other data) are detected during the data synchronization process, an appropriate 
error message will be sent to the client.  While such errors will not prevent 
application deployment, they may result in failures during execution.

n If you are using a cluster, the data synchronization service will update your 
application’s Webflow and Pipeline information to all servers in the domain.

Next Steps

If you are new to this release of the Webflow and Pipeline Editors, it is strongly 
suggested that you proceed to the next section, “Learning to Use the Webflow and 
Pipeline Editors” on page 12-8.  For step-by-step instructions on using the Webflow 
and Pipeline Editors to create Webflows, proceed to any of the following:

n Organizing Webflow Components in an Editor Canvas
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n Using the Webflow and Pipeline Editor Toolbars

n Using the Properties Editors 

Once you understand the behaviors and capabilities of the Webflow and Pipeline 
Editors, you may want to read some of the following sections, depending on your 
current goals:

n Migrating An Existing Webflow

n Creating or Modifying a Webflow: Breadth-First Versus Depth-First

n About the Webflow and Pipeline Editors’ Validation Features

If you have already finished work on your application’s Webflow, you may want to 
read “Synchronizing Webflow Data for Your Application” on page 12-48.

Learning to Use the Webflow and Pipeline 
Editors

This section provides you with general information about the Webflow and Pipeline 
Editor user interfaces, and includes a mapping of Webflow components to their 
graphical representations.  This section also includes descriptions of tools in the 
Webflow and Pipeline Editor palettes and buttons in the Editors’ toolbars.  As such, 
this section includes the following:

n Webflow and Pipeline Editor Essentials

n Webflow Component Representations

n Understanding the Webflow and Pipeline Editor Palettes

n Understanding the Webflow and Pipeline Editor Toolbars
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Webflow and Pipeline Editor Essentials

This section provides you with some basic information about the Webflow and 
Pipeline Editors.  It includes an explanation of what the Webflow Editor displays and 
allows you to work with, introduces the Pipeline Editor, and describes some status 
indicators you should notice as you use the Webflow and Pipeline Editors.  It also 
includes a brief discussion about using a Content Management System with your 
Webflow and Pipeline XML configuration files.

Webflow Namespaces

Although there is only one Webflow per Web application, BEA recognizes that 
different developers may be assigned to work in different functional areas of the same 
application.  Therefore, a Webflow for a single Web application is comprised of 
numerous modules called namespaces.  (See “Namespaces” for more information.)

The Webflow Editor displays and requires that you work with Webflow components 
within individual namespaces.  In addition to allowing different developers to work in 
different areas of the same Webflow, displaying a Webflow by namespace in the 
Webflow Editor provides a much cleaner visualization, and thus may reduce the 
likelihood of error.

As such, the activities you perform in the Webflow Editor are really just operations on 
one or more editable namespace files.  You can create, open, save, save as, or delete 
Webflow namespace files the same way you perform these tasks with other types of 
EBCC files.  For detailed instructions on these general EBCC functions, see “Working 
with Files” in the Guide to Using the E-Business Control Center documentation.

The Webflow Editor does allow you to open more than one namespace file at a time.  
When you open more than one namespace, the tabs at the bottom of the Editor window 
will allow you to move between the namespace files that are currently available.

Note: For more information about the behavior of multiple files in an EBCC editor, 
see “About the E-Business Control Center Interface” in the Guide to Using the 
E-Business Control Center documentation.
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Pipelines Versus Pipeline Namespaces

The Pipeline Editor displays and requires that you work with Webflow components 
within individual Pipelines, rather than within entire Pipeline namespaces.  In other 
words, since you can define multiple Pipelines within one Pipeline namespace, the 
editable unit in the Pipeline Editor is a Pipeline.  You can create, open, save, save as, 
or delete Pipelines the same way you perform these tasks with other types of EBCC 
files.  For detailed instructions on these general EBCC functions, see “Working with 
Files” in the Guide to Using the E-Business Control Center documentation.

Because Pipelines are scoped to an enterprise application (instead of a Web application 
like Webflows), Pipelines to not appear within the Webapp folder in the E-Business 
Control Center Explorer window’s Webflows/Pipelines list.  Rather, Pipelines appear 
under the Pipeline Namespaces folder.  Thus, while a Pipeline is the editable unit 
within the Pipeline Editor, it is a Pipeline namespace (rather than the Pipeline itself) 
that corresponds to a generated <namespace>.pln file.  You will need to check out 
the appropriate Pipeline namespace file from your Content Management System in 
order to work with a Pipeline in the Pipeline Editor.  This is the only case where an 
object shown in the E-Business Control Center Explorer window does not have a 
one-to-one correspondence with a file.

The Pipeline Editor opens when you double click a Pipeline shown in the E-Business 
Control Center (EBCC) Explorer window, or when you double click on the icon 
portion of a Pipeline node that is currently displayed in the Webflow Editor canvas, as 
shown in Figure 12-3. The Pipeline Editor behaves exactly like the Webflow Editor, 
but operates with a different palette and toolbar, and on different node types (namely, 
Pipeline Components).

Figure 12-3   Results of Double-Clicking Portions of Pipeline Node
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Notes: For more information about the differences between the Webflow and Pipeline 
Editors, see “Understanding the Webflow and Pipeline Editor Palettes” on 
page 12-17 and “Understanding the Webflow and Pipeline Editor Toolbars” 
on page 12-20.  For more information about Pipelines and Pipeline 
Components, see “Input Processors and Pipelines.”

The Pipeline Editor allows you to open more than one Pipeline at a time.  When you 
open more than one Pipeline, the tabs at the bottom of the Editor window will allow 
you to move between the Pipelines that are currently available.  When you open 
multiple Pipelines, remember that these Pipelines may or may not be part of the same 
Pipeline namespace.

Note: For more information about the behavior of multiple files in an EBCC editor, 
see “About the E-Business Control Center Interface” in the Guide to Using the 
E-Business Control Center documentation.

Information Displayed in the Editors’ Title Bars

In the Webflow Editor, the title bar displays the name of the Editor and the namespace 
for the Webflow you are currently creating or modifying, in brackets [].  For example, 
the Webflow Editor’s title bar may read: Editor [Webflow: main], which means 
you are currently using the Webflow Editor to work with Webflow components in the 
namespace called main.

In the Pipeline Editor, the title bar displays the name of the Editor and the Pipeline you 
are currently creating or modifying, in brackets [].  For example, the Pipeline Editor’s 
title bar may read:  Editor [Pipeline: viewShoppingCart], which means you are 
currently using the Pipeline Editor to define Pipeline Components in the Pipeline 
called viewShoppingCart.

In both Editors, the title bar may also show the text “Read Only” in parentheses.  If 
present, this text indicates that the opened file(s) are in read-only mode and must be 
checked out of your Content Management System prior to editing or saving.  See 
“Webflow and Pipeline Files in Your Content Management System” on page 12-12 for 
more information.
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Webflow and Pipeline Files in Your Content Management System

When you want to edit or save Webflow components within a Webflow namespace or 
a Pipeline using the Webflow and Pipeline Editors, you should verify that you have 
checked out all the necessary files from your Content Management System.  
Depending on the Webflow components you want to edit, you may or may not need all 
of the following files:

n <namespace>.wf

The Webflow configuration files contain XML elements that represent the 
Webflow components used in the Webflow namespace, as well as the 
relationships among them.  The <namespace>.wf files are scoped to the Web 
application.

n <namespace>.pln

The Pipeline configuration files contain XML elements that represent the 
Pipeline Components within a Pipeline being used in the namespace, as well as 
the relationships among them.  The <namespace>.pln files are scoped to the 
enterprise application.

n <namespace>.wf.ui and <namespace>.pln.<pipeline_name>.ui

These XML files contain information that is used by the Webflow and Pipeline 
Editors to display the Webflow components in the way you last organized them.  
They are generated when you save a Webflow or Pipeline, and are located in the 
appropriate directories under the BEA_HOME\EBCC_HOME\applications\
<enterprise_app>\project-info\webapps\<web_app> directory.

n webflow-extensions.wfx

This XML file describes the Webflow components currently available for use in 
the Webflow Editor.  Any extension (custom) presentation or processor nodes 
your development team creates must be registered in this file if you want them 
to appear in the Webflow Editor.  The webflow-extensions.wfx file is scoped 
to a Web application, and should remain in read-only mode unless extensions 
need to be added.  More information about the webflow-extensions.wfx file 
is located in “Making Your Extension Presentation and Processor Nodes 
Available in the Webflow Editor.”

Note: If you just want to view a Webflow namespace or Pipeline using the Editors, 
you do not need to check out files.  The Webflow and Pipeline Editors will 
display the Webflow components in read-only mode.  In read-only mode, the 
Webflow and Pipeline Editors’ palettes and toolbars are not displayed.  For 
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more information about the Webflow and Pipeline Editors’ palettes and 
toolbars, see “Understanding the Webflow and Pipeline Editor Palettes” on 
page 12-17 and “Understanding the Webflow and Pipeline Editor Toolbars” 
on page 12-20, respectively.

Webflow Component Representations

Since the Webflow and Pipeline Editors are graphical tools for creating and modifying 
Webflows and Pipelines, each Webflow component has a graphical representation for 
display in an Editor.  This section provides you with information that will help you 
associate each Webflow component with its graphical representation.

Note: In addition to associating Webflow components with their graphical 
representations, Table 12-1 and Table 12-2 also provide brief descriptions of 
each component.  If you do not remember the details of a particular Webflow 
component, refer to “Webflow Components and Concepts” for more 
information.

Table 12-1 provides information about Webflow component representations in the 
Webflow Editor.

Table 12-1  Webflow Components in the Webflow Editor

Representation Webflow Component Description

Presentation Node A page displayed to visitors interacting with your Web 
application.  The type of these pages can be HTML, 
JSP, Java servlet, or an Extension (Custom) 
Presentation Node.

(This representation also 
shows an automatically 
created connection port.)

Wildcard 
Presentation Node

A single, global event contained on one or more 
Presentation Nodes, typically used to implement 
general functions.  There may be several Wildcard 
Presentation Nodes within a Webflow namespace.  The 
type property reflects the context in which the event 
occurs.
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(Same as a Presentation 
Node.)

Extension (Custom) 
Presentation Node

A node created by an experienced Java/EJB developer 
for use in a Webflow.  To appear in the Webflow 
Editor, this node must have an equivalent server-side 
Java class representation and be registered in the 
webflow-extensions.wfx file.  

Input Processor Node A processor Webflow component that handles data 
input, whether from Web site visitors or other processor 
nodes.  Validation of data input is the typical use of an 
Input Processor.

(This representation also 
shows an automatically 
created connection port.)

Pipeline Node A processor Webflow component that encapsulates 
business logic for a Web application.  Pipelines Nodes 
contain a series of Pipeline Component Nodes, the 
latter of which are editable in the Pipeline Editor. 

(This representation also 
shows an automatically 
created connection port.)

Wildcard 
Processor Node

A single, global event contained on one or more 
Processor Nodes, typically used to implement general 
functions.  There may be several Wildcard Processor 
Nodes within a Webflow namespace.  The type 
property reflects the context in which the event occurs.

Extension (Custom) 
Processor Node

A node created by an experienced Java/EJB developer 
for use in a Webflow.  To appear in the Webflow 
Editor, this node must have an equivalent server-side 
Java class representation and be registered in the 
webflow-extensions.wfx file.  

(This image represents a 
Presentation Begin 
Node.)

Begin Node A node designated as the initial state of or entry point 
into the Webflow.  There can be one Begin Node for 
each namespace in a Webflow.  The Begin Node can 
also be used as a destination.

Table 12-1  Webflow Components in the Webflow Editor (Continued)

Representation Webflow Component Description
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Table 12-2 provides information about Webflow component representations in the 
Pipeline Editor.

(This image represents a 
Pipeline Proxy Node.)

Proxy Node A special node that represents a node whose definition 
resides in a different namespace file.  Nodes in the 
namespace being edited can refer to the Proxy Node as 
a destination, but the Proxy Node itself cannot be 
edited.  Proxy Nodes can be Presentation Nodes, 
Processor Nodes, or Extension (Custom) Nodes. 

(The second 
representation is of a 
self-referring event.)

Event 

(may be a link, button, or 
return object)

An occurrence triggered by the interaction of a Web site 
visitor that results in some change in the state of the 
Webflow.  In other words, events cause Webflow 
transitions (movement from an origin node to a 
destination node).   There are different events for 
different node types: link and button are events for 
Presentation Nodes; return object is an event for a 
Processor Node that has executed successfully.

(The second 
representation is of a 
self-referring exception.)

Exception Representation of an exception, which occurs when 
Processor Nodes do not execute successfully.

Table 12-1  Webflow Components in the Webflow Editor (Continued)

Representation Webflow Component Description

Table 12-2  Webflow Components in the Pipeline Editor

Representation Webflow Component Description

(This representation also 
shows an automatically 
created connection port.)

Pipeline Component Node A specialized Webflow component that performs tasks 
related to the application’s underlying business logic.  
Pipeline Components exist within Pipelines, and may 
be implemented as Java objects or stateless session 
EJBs.
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Root Node A Pipeline Component that represents the initial entry 
point into the Pipeline.  There can be one Root Node for 
each Pipeline.  The Root Node can also be used as a 
destination.

Abort Exception Node A special node that represents the place where a 
Pipeline’s exceptions connect to, because their 
destinations actually exist outside the Pipeline Editor 
(in the Webflow Editor).

Note: For more information, see “Configuring 
Pipeline Component Exception Fatality.”

(Self-referring event 
transitions are not 
allowed in the Pipeline 
Editor.)

Event 
(return object)

An occurrence triggered by the successful execution of 
a Pipeline Component that results in some change in the 
state of the Webflow.  In other words, events cause 
Webflow transitions (movement from an origin node to 
a destination node).  There are different events for 
different node types: return object is an event for a 
Pipeline Component Node that has executed 
successfully.

(The second 
representation is of a 
self-referring exception.)

Exception Special event type triggered by a Pipeline Component 
Node when it does not execute successfully.

Table 12-2  Webflow Components in the Pipeline Editor (Continued)

Representation Webflow Component Description
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Understanding the Webflow and Pipeline Editor Palettes

When you first open a Webflow namespace in the Webflow Editor or a Pipeline in the 
Pipeline Editor, you will notice a palette on the left-hand side of the Editor window.  
This section describes each of the tools provided in the Webflow and Pipeline Editor 
palettes.

Notes: If you do not see a palette on the left-hand side of either the Webflow or 
Pipeline Editors when you open a Webflow namespace or a Pipeline, this 
means that the files you are opening are in read-only mode.  To view the 
palettes, you will need to make sure the appropriate .wf and .pln files are 
writable.  For more information about these files, see “Webflow and Pipeline 
Files in Your Content Management System” on page 12-12.

The Pipeline Editor opens when you double click a Pipeline shown in the 
E-Business Control Center (EBCC) Explorer window, or when you double 
click on the icon portion of a Pipeline node that is currently displayed in the 
Webflow Editor canvas, as shown in Figure 12-4.  For more information about 
Pipelines, see “Input Processors and Pipelines.”

Figure 12-4   Results of Double-Clicking Portions of Pipeline Node



12 Using the Webflow and Pipeline Editors

12-18 Guide to Using the BEA E-Business Control Center

Tools in the Webflow Editor Palette

Table 12-3 describes each of the tools in the Webflow Editor palette.

Table 12-3  Description of the Webflow Editor Palette Tools

Tool Function Description

Selection Tool Allows you to select and move nodes, event transitions, 
and exception transitions.  Also allows you to add 
elbows to transitions.  This is the default tool for the 
Webflow Editor.

Event Tool Allows you to add an event transition between two 
nodes, or a self-referring event transition. 

Exception Tool Allows you to add an exception transition between two 
nodes, or a self-referring exception transition. 

Begin Node Allows you to designate one of the Presentation or 
Processor Nodes already on the Editor canvas as the 
Begin Node for the current Webflow namespace.

Presentation Node Allows you to add a new Presentation Node to the 
Editor canvas. 

Wildcard Presentation 
Node

Allows you to add a new Wildcard Presentation Node 
to the Editor canvas.

Input Processor Node Allows you to add a new Input Processor Node to the 
Editor canvas.

Pipeline Node Allows you to add a new Pipeline Node to the Editor 
canvas. 

Wildcard Processor 
Node

Allows you to add a new Wildcard Processor Node to 
the Editor canvas. 
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Tools in the Pipeline Editor Palette

Table 12-4 describes each of the tools in the Pipeline Editor palette.

Extension (Custom) 
Processor Node

Allows you to add a new Extension (Custom) Processor 
Node to the Editor canvas.  

Note: The Extension (Custom) Processor Node tool 
is disabled until the Webflow Editor detects a 
new node in the 
webflow-extensions.wfx file.

Proxy Node Allows you to add a Proxy Node to the Editor canvas.  
You should create a Proxy Node any time you want to 
refer to a node that is defined in another namespace.

Table 12-3  Description of the Webflow Editor Palette Tools (Continued)

Tool Function Description

Table 12-4  Description of the Pipeline Editor Palette Tools

Tool Function Description

Selection Tool Allows you to select and move Pipeline Components, event 
transitions and exception transitions.  This is the default tool 
for the Pipeline Editor.

Event Tool Allows you to add an event transition between two nodes. 

Exception Tool Allows you to add an exception transition between two 
nodes, or a self-referring exception transition. 

Root Node Allows you to designate one of the Pipeline Components 
already on the Editor canvas as the Root Node for the current 
Pipeline.

Pipeline 
Component

Allows you to add new Pipeline Components to the Editor 
canvas. 
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Understanding the Webflow and Pipeline Editor 
Toolbars

You will find the Webflow and Pipeline Editor toolbars at the top of both the Webflow 
and the Pipeline Editors, respectively, but the buttons available from each Editor’s 
toolbar may differ.  This section describes which buttons are available from which 
Editor’s toolbar, and describes their functions. 

Display and Behavior Buttons

The toolbar buttons described in this section modify the display or behavior of 
Webflow components, and may not be available from both the Webflow and Pipeline 
Editors.  These buttons act as toggles, meaning that you click the button once to select 
the tool, then again to deselect the tool.

Table 12-5 briefly describes the Display and Behavior buttons, and where appropriate, 
indicates which Editor they belong to.

Table 12-5  Description of the Display and Behavior Buttons

Tool Function Description

Show/Hide Grid button Allows you to show or hide a grid background 
in the Editor canvas.

Snap to Grid button Allows you to control whether or not Webflow 
components are automatically placed to the 
nearest grid point on the Editor canvas when 
you release the mouse button.

Link Optimization button Allows you to control whether or not the 
connectors on each node will be automatically 
moved around the perimeter of the node as the 
node is moved on the Editor canvas.

Show/Hide Exceptions button Allows you to show or hide exception 
transitions in the Editor canvas.
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Command Buttons

The toolbar buttons described in this section execute commands related to Webflow 
components, and may not be available from both the Webflow and Pipeline Editors.  
Many of these buttons also have keyboard shortcuts you may find helpful.

Table 12-6 briefly describes the Command buttons and where appropriate, indicates 
which Editor they belong to.

Make This Pipeline 
Transactional button

Allows you to specify whether the Pipeline 
should be transactional.

Note: Only available in the Pipeline Editor.

Include Pipeline Session in 
Transaction button

Allows you to specify whether the Pipeline 
Session should be included in the transaction.  
Enabled only  if the Pipeline Transaction button 
is on.

Note: Only available in the Pipeline Editor.

Table 12-5  Description of the Display and Behavior Buttons (Continued)

Tool Function Description

Table 12-6  Description of the Command Buttons

Tool Function Description Keyboard 
Shortcut

Print button Allows you to print the entire Webflow 
namespace or Pipeline to a printer.

Ctrl+P

Delete button Deletes the selected Webflow 
component.  The Delete button is 
disabled until a Webflow component is 
selected.  

Delete

Zoomed Overview 
button

Allows you to view the entire Webflow 
namespace or Pipeline at a glance.

Ctrl+Z
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Validate the Selected 
Node button

Allows you to run the Webflow 
validation feature on the selected node.  
The Validate the Selected Node button 
is disabled until a Webflow component 
is selected.

Ctrl + V

Validate All button Allows you to run the Webflow Editor’s 
validation feature on the entire Webflow 
namespace, or the Pipeline Editor’s 
validation feature on the entire Pipeline.

Alt + V

Set Up Configuration 
Error Page Name button

Allows you to specify the name and path 
to the configuration error page.

Note: Only available in the Webflow 
Editor.

--

Pipeline Component 
Editor button

Opens the Pipeline Component Editor, 
which allows you to manage Pipeline 
Components.

Note: Only available in the Pipeline 
Editor.

--

Table 12-6  Description of the Command Buttons (Continued)

Tool Function Description Keyboard 
Shortcut
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Organizing Webflow Components in an 
Editor Canvas

This section provides you with detailed instructions about how to perform common 
tasks using the Webflow and Pipeline Editors.  This section includes information 
about:

n How to Select Webflow Components

n How to Add Webflow Components

n How to Edit a Webflow Component’s Name (Label)

n How to Designate or Remove a Begin (Root) Node

n How to Move a Webflow Component

n How to Connect Nodes with Event or Exception Transitions

n How to Reposition Connection Ports on a Node

n How to Work with Elbows in Transitions

How to Select Webflow Components

To select a Webflow component in either the Webflow or Pipeline Editor, click the 
Webflow component.  For events and exceptions, this means clicking the transition 
itself or an associated connection port.  

Note: When you select a Webflow component, detailed information about the 
component is displayed in the Properties Editor.  For more information about 
the Properties Editor, see “Using the Properties Editors” on page 12-38.
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How to Add Webflow Components

To add a new Webflow component (that is, a new Presentation Node, Wildcard 
Presentation Node, Input Processor Node, Pipeline Node, Wildcard Processor Node, 
Extension (Custom) Processor Node, Proxy Node, or Pipeline Component Node) in 
either the Webflow or Pipeline Editor, follow these steps:

1. Click the appropriate tool from the Editor’s palette (see Table 12-3 or Table 12-4).

2. Position the cross-hairs on the Editor canvas.  

3. Click the mouse to add the Webflow component to the Editor canvas in that 
location.

Notes: A default name (label) is provided for the added component.  For information 
about editing component names, see “How to Edit a Webflow Component’s 
Name (Label)” on page 12-24.  In addition to the component’s name, there are 
several other properties for a new component that you must provide.  For more 
information, see “Using the Properties Editors” on page 12-38.

If you add a Proxy Node to the canvas, be sure to connect it to another node 
with an event or exception transition before saving your Webflow namespace.  
If you do not, the Proxy Node will not appear on the canvas following a reload.  
This is because the purpose of the Proxy Node is solely as a destination for 
transitions.  If there are no transitions, there is no use for the Proxy Node.  For 
more information about Proxy Nodes, see Table 12-1 and Table 12-3.

How to Edit a Webflow Component’s Name (Label)

The Webflow and Pipeline Editors will typically give each component you add to the 
canvas a name (label).  To edit the component’s name, follow these steps:

1. Double-click the Webflow component’s name to select it.  

2. Type a new name for the component, and press Enter.
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Note: You can also edit a Webflow component’s name (label) using the Properties 
Editor.  For Pipeline Component Nodes displayed in the Pipeline Editor, you 
can only edit the Pipeline Component’s name by selecting a new one from the 
Properties Editor.  For more information, see “Using the Properties Editors” 
on page 12-38.

How to Designate or Remove a Begin (Root) Node

To designate a Presentation or Processor Node as the Begin Node for the current 
Webflow namespace in the Webflow Editor, or a Pipeline Component Node as the 
Root Node for the current Pipeline in the Pipeline Editor, follow these steps:

1. Click the Begin Node or Root Node Tool (see Table 12-3 and Table 12-4).

2. Click a Presentation, Processor, or Pipeline Component Node that is already on 
the Editor canvas to designate it as the Begin (Root) Node.  The node is marked 
by a green stripe to the right of the node name

Since the Begin and Root Node Tools work as toggles, you can also remove the Begin 
or Root designation from a node by following the same procedure.  When you remove 
the begin (root) designation from a node, the green stripe is also removed.

Notes: Wildcard, Proxy, and Abort Exception nodes cannot be designated as begin or 
root nodes. For more information about the Begin Node, see “The Begin 
Node.”  For more information about the Root Node, see “The Root Component 
Node.”

How to Move a Webflow Component

To move a Webflow component (that is, a Presentation Node, Wildcard Presentation 
Node, Input Processor Node, Pipeline Node, Wildcard Processor Node, Extension 
(Custom) Processor Node, Proxy Node, or Pipeline Component Node) to another 
location on the Webflow or Pipeline Editors’ canvas, follow these steps:

1. Click and hold the mouse button down on the component while dragging it to the 
desired location.  

Note: The node’s corresponding event and exception components (that is, the 
associated transitions) will move with the node.  
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2. Release the mouse button to place the component in the new position.

Caution: It is possible to drag a node far to the right or bottom of an Editor canvas, 
so that you cannot see the entire flow of the Webflow namespace or 
Pipeline at one glance.  Verify that you have edited all the nodes you 
wanted to by using the scroll bars to the right and at the bottom of the 
Editor’s canvas.  The Zoomed Overview tool, described in “How to Use 
the Zoomed Overview” on page 12-31, may be helpful here.

How to Connect Nodes with Event or Exception 
Transitions

Transitions from an origin node to a destination node result from events or exceptions 
thrown by the origin node.  Therefore, you connect two different nodes with event and 
exception transitions, or you can create a self-referring transition (a transition that has 
the same origin and destination node).

Note: For more information about origin and destination nodes, see “Introduction to 
Webflow Components.”

To connect nodes with event or exception transitions, follow these steps:

1. Click the Event Tool or the Exception Tool (see Table 12-3 or Table 12-4).

2. Position the transition by moving the mouse to an edge of the origin node.  A 
solid orange square indicates an acceptable connection location, and the cursor 
changes to indicate a transition addition.

Note: If the origin node already has a connection port (as shown in Figure 12-5), 
position the transition by moving the mouse over the existing connection 
port.

Figure 12-5   Pipeline Node with Automatically Created Connection Port

3. If you want to connect two different nodes with the transition, click, hold, and 
drag the mouse to the destination node.  Release the mouse to connect the 
transition to the destination node.



Organizing Webflow Components in an Editor Canvas

Guide to Using the BEA E-Business Control Center 12-27

Note: An outlined red square with an X in it indicates that you cannot place the 
transition at the current location.

If you want to create a self-referring transition, just single-click the mouse on the 
node to connect the transition to that same node.

How to Reposition Connection Ports on a Node

A connection port is a small graphical device on a node edge that represents where an 
event or exception is connected to that node.  Connection ports accepting transitions 
are called input connection ports; connection ports where transitions originate are 
called output connection ports.  In some cases, it may be helpful to move the node’s 
connection port.  To reposition the connection port on a node, follow these steps:

1. Click and hold the mouse button on the connection port, then drag the connection 
port to the desired location on the node.

Note: A solid orange square indicates an acceptable connection location; an 
outlined red square with an X in it indicates that you cannot place the 
transition at the current location.

2. Release the mouse button to place the connection port in the new location.

Notes: The connection port associated with a self-referring transition can only be 
moved along the same node edge. 

When repositioning connection ports, you may find the Link Optimization 
feature helpful.  For more information see “How to Enable and Disable Link 
Optimization” on page 12-32.

How to Work with Elbows in Transitions

In addition to the repositioning connection ports, you can also reposition transition 
lines on an Editor’s canvas by moving, creating or deleting elbows.  Elbows allow you 
to bend portions of the transition line.
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How to Move an Existing Elbow

To move an existing elbow, follow these steps:

1. Single-click a transition to view the existing elbows, which appear as black 
squares.

2. Click and hold the mouse button on the elbow as you drag it to the desired 
position.  The selected elbow appears as an orange square.

3. Release the mouse button to place the elbow in the new location.

How to Create a New Elbow 

To create a new elbow, follow these steps:

1. Single-click a transition to view the existing elbows, which appear as black 
squares.

2. Click and hold the mouse button anywhere on the transition line (except on an 
existing elbow) and drag the mouse to add the new elbow.  The selected elbow 
appears as an orange square.

3. Release the mouse button to create the elbow in that location.

How to Delete a Elbow

To delete an existing elbow, follow these steps:

1. Single-click a transition to view the existing elbows, which appear as black 
squares.

2. Click the elbow you want to delete to select it.  The selected elbow appears as an 
orange square.

3. Click the Delete button on the Editor’s toolbar, or press the Delete key.
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Using the Webflow and Pipeline Editor 
Toolbars

This section provides you with detailed instructions about how to perform common 
tasks using the buttons in the Webflow and Pipeline Editor toolbars.  This section 
includes information about:

n How to Print a Webflow Namespace or Pipeline

n How to Delete Webflow Components

n How to Use the Zoomed Overview

n How to Show/Hide the Grid

n How to Snap Objects to the Grid

n How to Enable and Disable Link Optimization

n How to Show and Hide Exception Transitions

n How to Validate the Selected Node

n How to Validate All Nodes

n How to Set the Configuration Error Page Name

n How to Use the Pipeline Component Editor

n How to Make the Pipeline Transactional

n How to Include the Pipeline Session in a Transaction

How to Print a Webflow Namespace or Pipeline

To print the contents  of the Webflow Editor canvas or the Pipeline Editor canvas, click 
the Print button (see Table 12-6), or press Ctrl+P.  A platform-specific Print dialog 
opens, which allows you to print as you would from any other application.
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How to Delete Webflow Components

Caution: No confirmation dialog is presented before a Webflow component is 
deleted, and no undo feature is provided.  If you delete a Webflow 
component by mistake, the only remedy is to close the Editor without 
saving.  Be sure you want to delete a Webflow component before 
proceeding. 

You may delete a Webflow component because you do not require it for 
your namespace, but keep in mind that other namespaces within the 
application’s Webflow may still use the component.  If this is the case, the 
other namespaces will become invalid.  Be sure to communicate your 
changes to others on the development team who may be affected by the 
deletion.

To delete a Webflow component from an Editor’s canvas, follow these steps:

1. Click the Webflow component you want to delete to select it.

2. Click the Delete button on the Editor’s toolbar (see Table 12-6), or press the 
Delete key.

Notes: Deleting a transition or an input connection port associated with a node deletes 
the entire transition (that is, the input/output connection ports on the node, as 
well as the line between them).  However, deleting an input connection port 
deletes only the input connection port and the line (that is, the output 
connection port is retained). 

Deleting a transition line or a connection port on a Wildcard Node and saving 
the Webflow namespace or Pipeline file causes that Wildcard Node to 
disappear on reload, and no validation alert is produced.  This is because the 
Wildcard Node has no meaning without an event or exception transition.
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How to Use the Zoomed Overview

To use the zoomed overview feature, follow these steps:

1. Click the Zoomed Overview Tool (see Table 12-6) to see all the Webflow 
components in a Webflow namespace or a Pipeline at one glance.

2. Click and hold the mouse button on the green rectangle that appears at the top, 
left-hand corner of the Editor canvas.  

3. Drag the mouse to the desired location.  To return to the normal view, release the 
mouse button.

How to Show/Hide the Grid

When the Show/Hide Grid toggle button in an Editor’s toolbar is selected, a 
rectangular grid appears in the background, behind your Webflow components.  This 
grid may make manipulating components easier on your eyes and help you align 
components.  When the Show/Hide Grid toggle button is deselected, the background 
is just a plain canvas.  By default, the Editors open with the Show/Hide Grid toggle 
button in the deselected position (that is, no grid is shown).

How to Snap Objects to the Grid

When selected, the Snap To Grid toggle button an Editor’s toolbar can help you align 
Webflow components by placing them to the grid point closest to where you release 
the mouse button.  When the Snap To Grid toggle button is deselected, you have 
complete control over placement of the other Webflow components.  The Snap To 
Grid feature does not require the grid to be visible.  By default, the Editors open with 
the Snap To Grid toggle button in the selected position (that is, Webflow components 
are snapped to the grid).
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How to Enable and Disable Link Optimization

When the Link Optimization toggle button in an Editor’s toolbar is selected, link 
optimization is turned on.  In other words, the connectors on each node will be 
automatically relocated as the node is moved on the Editor canvas, minimizing link 
length and enabling the best possible display.  By default, the Editors open with the 
Link Optimization toggle button deselected (that is, connectors are not optimized).

How to Show and Hide Exception Transitions

When the Show/Hide Exceptions toggle button in an Editor’s toolbar is selected, 
exception transitions are not shown on the Editor canvas.  This provides you with a 
cleaner picture of the other Webflow components.  Alternatively, when the Show/Hide 
Exceptions toggle button is deselected, the exception transitions are shown in the 
Editor canvas.  By default, the Editors open with the Show/Hide Exceptions toggle 
button in the deselected position (that is, exceptions are shown).

How to Validate the Selected Node

To validate a single node in the Webflow or Pipeline Editor, follow these steps:

1. Click the node you want to validate to select it.

2. Click the Validate the Selected Node button (see Table 12-6).

Note: The Validate the Selected Node button is disabled until you select a node 
as described in steps 1 and 2.

3. Click the Alerts tab of the Properties Editor to view any alerts for the selected 
node.  If an alert exists, the severity of that alert is indicated by the traffic light 
icon.

Note: For more information about the validation feature, see “About the Webflow 
and Pipeline Editors’ Validation Features” on page 12-45.
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How to Validate All Nodes

To validate all the nodes in the namespace using the Webflow Editor or all the nodes 
in the Pipeline using the Pipeline Editor, follow these steps:  

1. Click the Validate All button (see Table 12-6).

2. Click the Alerts tab of the Properties Editor to view any alerts for the namespace 
or Pipeline.  If an alert exists, the severity of that alert is indicated by the traffic 
light icon.

Note: As described in “About the Webflow and Pipeline Editors’ Validation 
Features” on page 12-45, the Alerts tab contains a running log of error 
messages as you work in the namespace or Pipeline.  Therefore, using the 
Validate All button is useful when you have already cleared the Alerts and 
want a new, complete validation of your work.

How to Set the Configuration Error Page Name

You can set a configuration error page name using the Webflow Editor.  To set the 
configuration error page name, follow these steps:

1. Click the Set Up Configuration Error Page Name button (see Table 12-6).  The 
Configuration Error Page Dialog, shown in Figure 12-6, appears.

Note: The default configuration error page name that is used in the WebLogic 
Portal’s sample applications is error/configurationerror.jsp.

Figure 12-6   Configuration Error Page Dialog

2. Either type in the path and the file name for the configuration error page in the 
Page Name input field, or click the Browse button at the left of the input field to 
locate the Page Name with the Open window.  
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3. Click OK.

Note: For more information about the configuration error page, see “The 
Configuration Error Page.”

How to Use the Pipeline Component Editor

The Pipeline Component Editor is available from the Pipeline Editor.  It allows you to 
view, add, edit, or delete the Pipeline Components that are available for selection in 
the Properties Editor (specifically, in the Component attribute).  Figure 12-7 is a 
sample illustration of the Pipeline Component Editor.

Figure 12-7   Pipeline Component Editor

How To View Pipeline Component Details

To view the details of a Pipeline Component that is shown in the list, click the Pipeline 
Component’s name to select it.  The details for that Pipeline Component are shown in 
the Details region of the Pipeline Component Editor.
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How to Add Pipeline Components

To add a new Pipeline Component to the list, follow these steps:

1. Click New... The Pipeline Component Creator dialog opens, an example of which 
is shown in Figure 12-8.

Note: When you add a new Pipeline Component, a default name for the Pipeline 
Component is automatically shown in the Name input field.

Figure 12-8   Pipeline Component Creator Dialog

2. Type the name of the Pipeline Component in the Name input field.

3. Select the Type for the Pipeline Component (JNDI or Class) using the radio 
buttons.  The default value for the Type is Class.  

Note: If you change the Type to JNDI, the Class Name label will change to JNDI 
Name.

4. Type the class name or JNDI name for the Pipeline Component in the Class 
Name or JNDI Name input field.

5. Click OK.  The Pipeline Component Creator Dialog closes, and the Pipeline 
Component you added appears in the Pipeline Components list.  

6. Click Close.  The Pipeline Component Editor closes, and the new Pipeline 
Component will now be available for selection as a Component attribute in the 
Properties Editor.
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How to Edit Pipeline Components

To edit a Pipeline Component that is shown in the list, follow these steps:

1. Click the Pipeline Component’s name shown in the list to select it.

2. Click Edit... The Pipeline Component Creator dialog opens, an example of which 
is shown in Figure 12-8.

Note: The existing values for the Pipeline Component are shown in the Pipeline 
Component Creator dialog.

3. If desired, type a new name for the Pipeline Component in the Name input field.

4. If desired, modify the Type for the Pipeline Component (JNDI or Class) using the 
radio buttons.  The default value for the Type is Class.  

Note: If you change the Type to JNDI, the Class Name label will change to JNDI 
Name.

5. If desired, type the new class name or JNDI name for the Pipeline Component in 
the Class Name or JNDI Name input field.

6. Click OK.  The Pipeline Component Creator Dialog closes, and the new details 
for the Pipeline Component you edited appear in the Details region.  

7. Click Close.  The Pipeline Component Editor closes, and the modified Pipeline 
Component will now be available for selection as a Component attribute in the 
Properties Editor.

How to Delete Pipeline Components

Caution: No confirmation dialog is presented before a Pipeline Component is 
deleted, and no undo feature is provided.  If you delete a Pipeline 
Component by mistake, the only remedy is to close the Editor without 
saving.  Be sure you want to delete a Pipeline Component before 
proceeding. 

To delete a Pipeline Component that is shown in the list, follow these steps:

1. Click the Pipeline Component’s name shown in the list to select it.

2. Click Delete.  The Pipeline Component is no longer shown in the Pipeline 
Components list.
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3. Click Close.  The Pipeline Component Editor closes, and the deleted Pipeline 
Component will no longer be available for selection as a Component attribute in 
the Properties Editor.

How to Make the Pipeline Transactional

When the Make This Pipeline Transactional toggle button in the Pipeline Editor’s 
toolbar is selected, the Pipeline will be made transactional.  Alternatively, when the 
Make This Pipeline Transactional toggle button is deselected, the Pipeline will not be 
transactional.  By default, the Pipeline Editor opens with the Make This Pipeline 
Transactional toggle button in the deselected position (that is, the Pipeline will not be 
transactional).

Note: For more information about transactional Pipelines, see “Transactional Versus 
Nontransactional Pipelines.”

How to Include the Pipeline Session in a Transaction

When the Include Pipeline Session in Transaction toggle button in the Pipeline 
Editor’s toolbar is selected, the Pipeline Session will be included in the transaction.  
Alternatively, when the Include Pipeline Session in Transaction toggle button is 
deselected, the Pipeline Session will not be included in the transaction.  The Include 
Pipeline Session in Transaction toggle button is not enabled unless the Make Pipeline 
Transactional toggle button is in the selected position.

Note: For more information about including Pipeline Sessions in transactions, see 
“Including Pipeline Sessions in Transactions.”
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Using the Properties Editors

As shown in Figure 12-9, a Properties Editor is the portion of the Webflow or Pipeline 
Editor that is located directly below the canvas.  

Figure 12-9   Example of a Properties Editor

The Properties tab in a Properties Editor contains information about the Webflow 
component currently selected.  Properties for a component are displayed in two 
columns: one for the name and one for the value.  To create a valid Webflow, you must 
fill in the required properties for each node in each namespace that comprises the 
Webflow. (Required properties are marked with an asterisk.)  To help you accomplish 
this, this section includes information on the following:

n Viewing Component Properties

n Description of Webflow Component Properties

n Modifying Component Property Values

The third column in the Properties tab displays messages about the selected Webflow 
component if it is invalid, which should help you troubleshoot problems as you work.  
However, this column displays messages for the listed properties only.  That is, the 
node may be invalid not because a property value is defined incorrectly, but because 
the node is missing a necessary transition.  Adding that transition would cause another 
property to be displayed in the Properties Editor for the node.  Therefore, to find a 
complete list of validation messages for the node, use the Validate the Selected Node 
button.  For more information, see “How to Validate the Selected Node” on page 
12-32.

Note: For more information about the Webflow and Pipeline Editors’ validation 
features, see “About the Webflow and Pipeline Editors’ Validation Features” 
on page 12-45.
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Viewing Component Properties

To view the properties for a particular Webflow component, click the Selection Tool 
(see Table 12-3 and Table 12-4), then click the component.  The properties for the 
selected Webflow component are displayed in the Properties Editor.

Description of Webflow Component Properties

The properties displayed in the Properties Editor depend on which Webflow 
component is selected.  Table 12-7 lists the properties that should typically be 
specified for each Webflow component, and provides examples of property values.

Note: Required properties are marked with an asterisk (*).

Table 12-7  Webflow Component Properties

Component Description of Properties Example

Presentation 
Node 

and 

Extension 
(Custom) 
Presentation 
Node

Name*: The name (label) of the Presentation Node that 
is displayed in the Editor canvas.  Initially defaults to 
the Page-name value.

Type*: The type of page, which can be HTML, JSP, 
Java servlet, or an Extension (Custom) Presentation 
Node.

Page-relative-path: The path to the Page-name, 
relative to the top of the Web application.   The 
Page-relative-path property is only available when the 
type is JSP or HTML.  For a servlet, this property is 
called Request-uri-path.

Page-name*:  The filename for the Presentation Node.  
Page-name is only a required property when the Type is 
JSP or HTML.

Notes: There will be an Event property for each 
transition originating from the node.  
Depending on how the Extension (Custom) 
Presentation Node is defined, there may be 
different properties.

Name: item

Type: jsp

Page-relative-path: /browse

Page-name: item.jsp
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Wildcard 
Presentation 
Node

Name*: The name (label) of the Wildcard Presentation 
Node that is displayed in the Editor canvas.  Initially 
defaults to the Event value.  

Type*: The type of event, which can be HTML, JSP, a 
Java servlet, or an Extension (Custom) Presentation 
Node.

Event*:  The global event for the Wildcard 
Presentation Node.  Initially defaults to the Name 
value.  

Name: HelpWildcardLink

Type: jsp

Event:  link.help

Input 
Processor 
Node

Name*: The name (label) of the Input Processor to be 
invoked by the Webflow.  

Class-name*: The package name for the Input 
Processor class, relative to the Web application’s 
directory.

Note: There will be Event or Exception properties 
from each transition originating from the 
node.

Name: itemIP

Class-name:  examples.
petflow.ip.ItemIP

Exception: com.bea.
p13n.appflow.exception.
ProcessingException

Event: success

Pipeline Node Name*: The name (label) of the Pipeline to be invoked 
by the Webflow.  

Pipeline-name*: The name of the Pipeline within the 
specified namespace.

Pipeline-namespace: The name of the Pipeline 
namespace in which the Pipeline with Pipeline-name 
resides.

Notes: If dictated by the selected Pipeline-name, the 
Editor will automatically add connection ports 
to the node for events and exceptions.  You 
must specify a Pipeline-namespace first, then 
the Pipeline-name.

Name: updateCart

Pipeline-name: updateCart

Pipeline-namespace: main

Event: success

Exception: com.bea.p13n.
appflow.exception.
PipelineException

Table 12-7  Webflow Component Properties (Continued)

Component Description of Properties Example
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Wildcard 
Processor Node

Name*: The name (label) of the Wildcard Processor 
Node that is displayed in the Editor canvas.  Initially 
defaults to the Exception value.  

Type*: The type of processor, which can be an Input 
Processor Node, a Pipeline Node, or an Extension 
(Custom) Processor Node.

Exception*:  The global exception for the Wildcard 
Processor Node.  Initially defaults to the Name value.  

Name:  MyWildException

Type:  inputprocessor

Exception:  com.bea.p13n.
appflow.exception.
ProcessingException

Extension 
(Custom) 
Processor Node

Name*:  The name (label) of the Extension (Custom) 
Processor Node that is displayed in the Editor canvas.

Type*:  The type associated with the Extension 
(Custom) Processor Node.

Note: There will be additional properties for the 
Extension (Custom) Processor Node, 
depending on how it is defined.

Name:  customLayout

Type: layoutmanager

Proxy Node Referent-namespace*:   The name of the namespace in 
which the node actually exists.

Entity Name*:  The name (label) of the node entity to 
which the Proxy Node refers.

Referent-namespace: order

Entity Name: 
checkoutShoppingCart

Event Name*: The name of an event transition on a node.  For 
Presentation Nodes, this can be link or button, and 
the name of the link or button, separated by dot 
notation.  For Processor Nodes, the name is simply the 
return object. 

Note: The number of event properties you  must 
specify depends on how many event 
transitions you add to a node.

Name: link.logout 
(Presentation Node);  success 
(Processor Node)

Exception Name*: The package name to the exception class, 
relative to the Web application’s directory.

Name: com.bea.p13n.
appflow.exception.
ProcessingException

Pipeline 
Component

Component*:  The name of the Pipeline Component.

Event*:  The  event transition on the node.  For Pipeline 
Component Nodes, the event is simply the return object

Component:  GetProductPC

Event:  success

Table 12-7  Webflow Component Properties (Continued)

Component Description of Properties Example
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Modifying Component Property Values

To modify the value of a Webflow component’s property in the Properties Editor, you 
must first be able to view the properties.  To view a component’s properties, follow 
these steps:

1. Click the Selection Tool (see Table 12-3 and Table 12-4).

2. Click the component.  

3. Click the Properties tab.  The properties for the selected Webflow component will 
be displayed in the Properties Editor.

The way you modify the value of a Webflow component’s property depends on the 
property itself.  A single-click of the mouse button in an property value field may:

n Allow you to type in a new value.  If this is the case, type the new value and 
then press Enter.

n Allow you to select a predefined value from a drop-down list.  If this is the case, 
just click the new value to select it.

Note: Be sure to save the changes to your Webflow or Pipeline using the E-Business 
Control Center (EBCC).  For more information about saving files in the 
EBCC, see “Saving Files” under “Working with Files” in the Guide to Using 
the E-Business Control Center documentation.

Abort Exception 
Node

Exception behavior:  The behavior that is to be 
executed when there is a fatal exception in the Pipeline. 

Note: The value for this property cannot be modified 
if the Abort Exception Node is the destination 
of transitions.  If no transitions are specified, 
the Pipeline’s default behavior can be 
specified by setting this property to Abort or 
Continue.  Pipeline processing will either stop 
or continue if an exception is thrown by a 
Pipeline Component.

Exception behavior:  abort

Table 12-7  Webflow Component Properties (Continued)

Component Description of Properties Example
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Migrating An Existing Webflow

If you used a previous release of Webflow, you will notice that the format of the 
Webflow and Pipeline configuration files has changed.  That is, the 
webflow.properties and pipeline.properties files have been converted to 
XML files.  The new Webflow and Pipeline XML configuration files can be created 
and modified using the E-Business Control Center (EBCC)’s graphical Webflow and 
Pipeline Editors.  

To use the Webflow and Pipeline Editors, you will first need to migrate your existing 
Webflow and Pipeline properties files to the new XML format.  To do this, use the Data 
Migrator Tool as described in the Migration Guide.

The migration of your webflow.properties and pipeline.properties files will 
result in two XML files:  main.wf and main.pln, where main is the default 
namespace name assigned by the Migrator Tool.  You will find these files in the root 
of the destination directory, which is defined by the data_dst_dir variable in the 
migration_install.properties file.  (See the Migration Guide for details.)

Once you copy these files to the appropriate place (as explained in the Migration 
Guide), you can use the Webflow and Pipeline Editors to divide your Webflow or 
Pipelines into multiple namespaces.  (See “Opening Files” in the Guide to Using the 
E-Business Control Center documentation for detailed instructions.)

Note: Because there is no prior graphical layout for the Webflow components, the 
Webflow and Pipeline Editors automatically display the components in a way 
that preserves their relationships.  You may also want to clean up the layout.  

Creating or Modifying a Webflow: 
Breadth-First Versus Depth-First

There are two different approaches you can take to create or modify a Webflow.  These 
approaches may depend on how you prefer to work, or the amount of information you 
currently have about your Web application.  These approaches are:
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n Breadth-first:  Create and lay out all Presentation and Processor Nodes on the 
Webflow Editor canvas, using the default names (labels).  Once all Presentation 
and Processor Nodes are on the canvas, go back and fill in the properties for 
each node (except for Pipeline Nodes), using the Properties Editor.  Then 
connect the nodes with event and/or exception transitions.  

Create and lay out Pipeline Component Nodes on the Pipeline Editor canvas, 
using the default names (labels).  Once all Pipeline Components are on the 
canvas, go back and fill in the properties for each node, using the Properties 
Editor.  (You may want to launch the Pipeline Component Editor to create or 
modify individual Pipeline Components.)  Then connect the nodes with event 
and/or exception transitions.

Return to the Webflow Editor to specify which Pipeline your Pipeline Nodes 
reference, using the Properties Editor.

n Depth-first:  Create a Presentation or Processor Node and fill in all the 
properties for that node, using the appropriate combination of Editors (that is, 
Properties Editor, Pipeline Editor, and/or Pipeline Component Editor).  Then, do 
the same for another node.  Once you have two complete nodes, connect them 
with event and/or exception transitions.  Continue to create complete nodes (that 
is, nodes for which all properties are filled in), and connect the completed nodes 
to the existing Webflow with transitions.  

A breadth-first approach will temporarily cause individual Webflow components in 
your namespace be marked as invalid.  Invalid nodes are marked with a red and white 
square status icon, which serves as a reminder that you must fill in the properties of 
each node in the namespace or Pipeline for your Webflow to be valid, regardless of 
when you decide to do it.  All nodes placed on an Editor canvas are initially invalid.
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Notes: Although your Webflow namespaces and Pipelines may be invalid, you may 
still save them and continue working on them later.  For more information, see 
“Saving Invalid Webflows” on page 12-47.  For more information about 
troubleshooting invalid Webflows, see “About the Webflow and Pipeline 
Editors’ Validation Features” on page 12-45.  

About the Webflow and Pipeline Editors’ 
Validation Features

In addition to making an application’s Webflow easier to visualize, the Webflow and 
Pipeline Editors are also beneficial because of their built-in validation features.  When 
you first start the Webflow and Pipeline Editors, the Webflow namespace or Pipeline 
is automatically validated and any messages are shown in the Properties Editor.  
Additionally, the validators continually work behind the scenes as you create or 
modify Webflow namespaces and Pipelines.  This section explains more about the 
Editors’ validation features, and includes:

n Validation Error Messages in a Properties Editor

n What Do the Editors Validate?

n Saving Invalid Webflows

Caution: If the underlying XML in your Webflow or Pipeline configuration files has 
been corrupted (perhaps as the result of hand-editing), the Webflow and 
Pipeline Editors may not be able to complete the validation process.
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Validation Error Messages in a Properties Editor

The Alerts section of a Properties Editor (shown in Figure 12-10) is the primary 
location of validation error messages for your Webflow namespace or Pipeline.  Since 
validation is automatically run on a Webflow namespace or Pipeline when you open 
an Editor, you can get a sense of any problems before you start working.  If there are 
validation error messages, the traffic light icon on the Alerts tab will appear red.  If 
there are validation warnings, the traffic light icon will appear yellow.  (Warnings 
typically occur when you redefine an event or exception on a wildcard node.)  Click 
the Alerts tab to see the detailed messages.

Figure 12-10   Alerts in a Properties Editor

As you are working, the validation feature will continue to run, causing the Alerts 
section to collect a running log of validation error messages.  To clear the alerts that 
have collected, click Clear.

After you clear alerts, you may choose to validate a particular node or the entire 
Webflow namespace or Pipeline again.  For instructions on how to accomplish these 
tasks, see “How to Validate the Selected Node” on page 12-32 or “How to Validate All 
Nodes” on page 12-33.

Notes: In addition to the validation error messages shown in the Alerts section, 
messages for individual Webflow component properties may also appear in 
the third column of a Properties Editor’s Properties section, as explained in 
“Using the Properties Editors” on page 12-38. 

When there is a validation error, the Webflow namespace or Pipeline will also 
be marked as invalid in the E-Business Control Center (EBCC) Explorer 
window.  Validation warnings, however, will not be marked as invalid.  For 
more information about the EBCC Explorer’s status icons, see “About the 
E-Business Control Center Interface” in the Guide to Using the E-Business 
Control Center documentation
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What Do the Editors Validate?

The Webflow and Pipeline Editor’s validation features check:

n The properties of components within the Webflow.  All required properties must 
be filled in using the Properties Editor and must contain valid values.  In other 
words, the validation feature verifies that the grammar in the Editor-generated 
XML files is in accordance with the provided XML Schema Definition (XSD).  

n That the entities (for example, JSPs or Java classes) represented by the 
Presentation and Processor Nodes in a Webflow actually exist within the Web or 
enterprise application and are deployed on the server. 

n That all event and exception transitions have valid destination nodes.

n That a Pipeline used in a Web application’s Webflow exists in the associated 
enterprise application (that is, outside of the Web application).

The Webflow and Pipeline Editor’s validation features do not verify:

n That the entities (for example, JSPs or Java classes) represented by the 
Presentation and Processor Nodes can actually handle the particular events or 
can throw the exceptions specified in the Webflow.

n That all the events or exceptions that can be generated by the entities (for 
example, JSPs or Java classes) are specified in the Webflow.

Saving Invalid Webflows

You can save the files associated with a Webflow namespace or a Pipeline using the 
E-Business Control Center (EBCC), even if they are not yet in a valid state.  (See 
“Working with Files” in the Guide to Using the E-Business Control Center 
documentation for more information.)  However, in order for your application’s 
Webflow data to be synchronized, the entire Webflow (that is, all the Webflow 
namespaces and Pipelines that comprise the Webflow) should be valid.  
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Notes: The EBCC’s Explorer window indicates when a Webflow namespace or 
Pipeline is complete by removing the red and white square icon associated 
with the object.  For more information about the EBCC Explorer’s status 
icons, see “About the E-Business Control Center Interface” in the Guide to 
Using the E-Business Control Center documentation.

For more information about Webflow data and synchronization, see 
“Synchronizing Webflow Data for Your Application” on page 12-48 or the 
Deployment Guide.  

Synchronizing Webflow Data for Your 
Application

The Webflow and Pipeline XML configuration files you create using the Webflow and 
Pipeline Editors represent just one piece of application data that must eventually be 
synchronized.  You synchronize all application data at once, using the E-Business 
Control Center (EBCC).  Thus, new or modified Webflow and Pipeline XML 
configuration files will be synchronized along with other application data.  For 
instructions on how to synchronize application data using the EBCC, see 
“Synchronizing Application Data” in the Deployment Guide.  

Warning: If you and other developers concurrently synchronize data to a single 
enterprise application, it is possible to overwrite each others work or to 
create sets of changes that are incompatible and difficult to debug.  To 
prevent this possibility, synchronize to separate instances of your 
application.  For more information on how to set up your development 
environment, see “Milestone 4: Set Up a Development Site” in the 
“Workflow for Developing an E-Business Web Site” topic of the 
Strategies for Developing E-Business Web Sites documentation.
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13 Using the E-Business 
Control Center Portal 
Tool

The E-Business Control Center enables you to define the design, functionality and 
visitor attributes of portals and portlets with limited coding knowledge of Java, 
JavaServer Pages (JSPs) or HTML. Once you have defined the components of a portal 
or portlet, the definitions are communicated to a server and the new portal is available 
to visitors or to an administrator who may define its runtime components using the 
WebLogic Portal Administration Tools. 

Components that can be defined via the E-Business Control Center include:

n Design components

Includes assigning skins and layouts to portals.

n Functionality

Includes assigning Web applications, Webflow mechanisms, and portlets.

n Visitor information and Guidelines

Includes defining entitlement definitions and user profiles.

Note: To use the portal design functionality in the E-Business Control Center, 
you must purchase the full WebLogic Portal License. 
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This topic includes the following sections:

n Using the E-Business Control Center

What you should know in order to make the best use of this application.

l E-Business Control Center Portal Concepts

Basic concepts you should be familiar with when using the E-Business 
Control Center portal functionality.

l Getting Started

How to get started using the E-Business Control Center.

l Portal Web Applications

How to open a newly created portal Web application in the E-Business 
Control Center.

l Portals

How to associate available Web components, such as skins, layouts, and the 
portlets and entitlements you have created in earlier sections, for the creation 
of a new portal.

l Portlets

Step by step procedure for creating a new portlet.

l Entitlement Segments

How to access the entitlement segment definition tool.

Using the E-Business Control Center

To effectively utilize the portal definition tools in the E-Business Control Center, you 
should have some knowledge of the fundamentals of building a Web portal, including 
a high-level understanding of JavaServer Pages (JSPs), page flows, servlets, and 
portlets. It is also helpful, but not necessary, to be familiar with the Portal framework, 
Webflow, and the WebLogic Portal Administration Tools. 
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E-Business Control Center Portal Concepts

The following terms are concepts often used in this document and in the E-Business 
Control Center.

n Portal Web Applications

A portal Web application is a group of server-side Web resources that make up 
an interactive online portal application. The Web resources include Java servlets, 
JSPs, static documents (such as HTML documents), and applets that can be 
deployed in a client Web browser. 

n Portals

A Portal is the framework for the Web portal or application. Using the 
E-Business Control Center, you define what possible layouts, skins, pages, and 
portlets that will be available for the portals. Once these definitions are 
synchronized with the server, the new portal can be accessed by a visitor or can 
be edited by a designated user of the WebLogic Portal Administration Tools.

n Portlets

A portlet is a Web component, often a small software application, that resides 
within a portal. It can be something as simple as a JSP include statement 
containing text, or as robust as a Web application, such as e-mail or a stock 
ticker. A well-designed portlet can be reused in different portals.

n Defaults

When you define portal attributes, you set defaults to determine which of your 
selections will be seen initially at the front end. These defaults can also be set, or 
the EBCC defaults can be reset, using the WebLogic Portal Administration Tools 
portal at runtime.

n Entitlement Segments

An entitlement segment is a visitor group based on common characteristics that 
allow a member of the group to view certain aspects of a portal. For example, if 
you create a portal that provides information about upcoming city council 
elections in Los Angeles, you might want to define an entitlement group for that 
portlet that consists of visitors who live in Los Angeles county and are of voting 
age. 
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Meeting an entitlement segment’s criteria may also give the user certain 
privileges in a portal. In the above example, any visitor that lives in Los Angeles 
county and is of voting age might be given the ability to edit the presentation or 
color scheme of their portal.

You use the E-Business Control Center to create entitlement segment definitions. 
These segments are associated with pages and portals in the WebLogic Portal 
Administration Tools.

n Synchronization

Once you have defined the portal attributes and defaults, you use the 
synchronization functionality to post this information to a server. Once you 
synchronize, the portal is generated or updated and becomes available to visitors 
and designated users of the WebLogic Portal Administration Tools. While other 
tools in the E-Business Control Center require a server connection, you can use 
the Portal tool offline until you are ready to synchronize to the server. See 
“Synchronizing Application Data” in the Deployment Guide for more 
information.

n Webflow and Pipeline

Webflow allows the user to create a flow of actions and pages for a Web 
application. You use the E-Business Control Center to assign Webflow 
mechanisms to portals and portlets. For general information about Webflow and 
Pipeline, see the Guide to Managing Presentation and Business Logic: Using 
Webflow and Pipeline documentation. For information specific to portal 
Webflow, see the Webflow topics in “Customizing Portals and Portlets.”

n WebLogic Portal Administration Tools

Once you have determined the desired Web components for the portal, the actual 
instance of the portal can be configured using the WebLogic Portal 
Administration Tools. For more information, see the Getting Started with Portals 
and Portlets documentation.

Note: You cannot edit or delete the default Administrator and everyone 
groups in the WebLogic Portal Administration Tools.
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Getting Started

To start the E-Business Control Center:

Windows: Selecting Start → Programs → BEA WebLogic E-Business Platform → 
BEA E-Business Control Center 4.0 → E-Business Control Center.

UNIX/Linux: Run $ EBCC_HOME/bin/ebcc.sh

If you don’t see the Explorer window along the left side of the E-Business Control 
Center, click the Open Explorer button in the main toolbar, as shown in Figure 13-1.

Figure 13-1   Explorer Window

n For information about managing E-Business Control Center files, see “Working 
With Files” in the Guide to Using the E-Business Control Center documentation.

Portal Web Applications

A portal Web application is a group of Web resources or components that are used in 
a portal application. The Web resources include Java servlets, JSPs, static documents 
(such as HTML documents), and applets that can be deployed in a client Web browser. 
Before you create a new portal, make sure resources exist on the WebLogic Portal 
server.

For information about creating a new Web application, see the Getting Started with 
Portals and Portlets documentation.

Importing Data for a New Portal Web Application

Use the following procedure to create a new portal Web application that exists on a 
server.

1. In the E-Business Control Center toolbar, select File → New → Portal Web 
Application.

The New Portal Web Application window appears (Figure 13-2).
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Figure 13-2   New Portal Web Application Window

1. In the Web Application Name field, type the name of the portal Web application. 
You must type this exactly as it exists on the server.

2. Click OK. The portal Web application is now available for use and editing in the 
E-Business Control Center.

Portals

When you create a new portal definition, you associate metadata for elements such as 
skins, portlets, pages, layouts, and Webflow mechanisms. This section covers the 
following information:

n Designating a New Portal

l Defining General Portal Elements

l Creating Portal Pages

l Setting Portal Defaults

n Editing a Portal

n Deleting a Portal

Designating a New Portal

The first step in creating a new portal is selecting the design elements, including 
banners, skins, headers, content, layout, as well as user profile information. 
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Defining General Portal Elements

To define general portal elements, use the following procedure:

1. In the main toolbar, select File → New → Presentation → Portal.

The Select Web Application window appears.

2. Select the desired Web application from the available list and click OK. For 
information about adding making new portal Web applications available for use 
via the E-Business Control Center, see “Portal Web Applications” on page 13-5.

 The Portal Editor appears (Figure 13-3).

Figure 13-3   Portal Editor

3. Click on the General bar to display the General portal pane (Figure 13-4).
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Figure 13-4   General Portal Pane

4. Provide the following information:

a. Description (optional): Provide a description for the portal you are creating.

b. Content URL: Provide a URL for the content that will appear in the portal.

Note: The URLs should be the file system directory path to the JSPs that are 
located on the WebLogic Portal server. When you synchronize this data, 
the appropriate JSP is inserted as an include to the portlet. The location 
of these directories are determined by your organization.

c. Header URL (optional): Provide a URL to the JSP that will be used as the 
portlet’s header content.

d. Footer URL (optional): Provide a URL to the JSP that will be used as the 
portlet’s footer content.

e. Vertical Navigation Bar URL: Provide a URL if you wish to display a vertical 
navigation bar for your portal.
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f. Horizontal Navigation Bar URL: Provide a URL if you wish to display a 
horizontal navigation bar for your portal.

g. Portal Webflow: When you create a Portal, you must associate the new Portal 
with a predefined Webflow; in most cases, the portal Webflow. For more 
information about the Webflow mechanism as it relates to portals and portlets, 
see “Customizing Portals and Portlets.”

5. Click on the Skins tab at the bottom of the panel to select the possible skins for 
the portal (Figure 13-5).

Note: When you select skins and layouts for your portal, you select from a library 
of metadata representing selected portal components. The E-Business 
Control Center ships with an existing library which can be modified or 
supplemented. For information about editing or adding skins and layouts, 
see “Developing Portals and Portlets” in the Getting Started with Portals 
and Portlets documentation.

Figure 13-5   Selecting Skins

Use the Add and Remove buttons to select the desired skins. A thumbnail image 
will appear when you select a skin. You can select one to many skins.

6. Click on the Layouts tab to select the possible layouts for the portal.

Use the Add/Remove buttons to select the desired layout(s); The preview 
thumbnail allows you to view the selected layout. You can select one to many 
layouts.

7. Click on the Portlets tab to select the portlets that will be included in the new 
portal.

Use the Add/Remove buttons to select the desired portlets. If you select multiple 
portlets for your portal, visitors can select from these layouts when personalizing 
their portal.
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8. Click the User Profiles tab to select the user profile set that will be enabled to 
view or use the portal.

Use the Add/Remove buttons to select the desired user profiles.

A user profile is a collection of information that is gathered, saved, and updated 
as customers visit your Web site, or is collected from other offline sources. 
When you select a user profile, you determine which information can be used or 
collected. These user profiles are defined in the Entitlement section of the 
E-Business Control Center. For more information, see “Using Customer 
Segments to Target High Value” in the Guide to Using the E-Business Control 
Center.

9. Click Save to save your changes. These changes will be available to the visitor or 
for modification via the WebLogic Portal Administration Tools once you have 
synchronized your changes to the appropriate server. See “Synchronizing 
Application Data” in the Deployment Guide for more information.
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Creating Portal Pages

When you create portal pages, you create or associate each page that can or will be 
used in the portal flow.

1. Click the Pages bar of the Portal Editor panel to expand the Pages pane 
(Figure 13-6).

Figure 13-6   Creating Portal Pages

2. Click Add.

The Page Definition editor displays (Figure 13-7).



13 Using the E-Business Control Center Portal Tool

13-12 Guide to Using the BEA E-Business Control Center

Figure 13-7   Page Definition Editor

3. Provide a portal page name.

4. Supply the path to the graphics files that will be used as the default and selected 
images. A path to the rollover image is optional.

5. Select at least one page layout: use the Add/Remove buttons to select the desired 
layout. The page can have one to many associated layouts.

Pages draw from the portal’s layout and portlet lists to get their available lists. 
This means that the layouts in this window are limited to layouts that have been 
added to the portal. To make more layouts available for your pages, see 
“Designating a New Portal” on page 13-6.

6. Select at least one portlet: Use the Add/Remove buttons to select the desired 
portlet(s). The Portal page can have one to many portlets.

7. When you are finished, click OK. 

The new page appears in the Portal Pages window.
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8. Click Save to save your changes. These changes will be available to the visitor or 
for modification via the WebLogic Portal Administration Tools once you have 
synchronized your changes to the appropriate server. See “Synchronizing 
Application Data” in the Deployment Guide for more information.

Setting Portal Defaults 

Before synchronizing your new portal definition to the server, you must set defaults. 
Setting defaults for your portal ensures that appropriate pages are displayed until an 
administrator has enabled the applications.

1. Click the Default Bar in the Portal Editor to expand the Defaults pane 
(Figure 13-8).

Figure 13-8   Setting Portal Defaults

2. Set a default display name for your portal.

3. Set a default skin: Use the pull-down menu to select one default from a list of 
your previously selected skins.

4. Set default pages: Use the pull-down menu to select the desired pages from a list 
of your previously selected pages. 

5. Use the Up/Down buttons to set the order that the selected page tabs will appear 
in the portal.



13 Using the E-Business Control Center Portal Tool

13-14 Guide to Using the BEA E-Business Control Center

6. Select either vertical or horizontal orientation for the Navigation bar.
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7. Set portal page defaults (Figure 13-9).

Figure 13-9   Setting Portal Page Defaults

a. Check the appropriate boxes if you wish the page to be Available, Mandatory, 
and/or Visible.

b. Select a default layout.

c. Click the Place Portlets button, the Page Layout window appears.

To add a portlet to the layout template, highlight the desired portlet, click the 
radio button in the desired section, then click the Add button. The portlet will 
be added to the desired section of the layout.

To remove a portlet from the layout template, click on the desired portlet in 
the template, then click the Remove button. The portlet will be removed 
from the template and added back to the portlet list.

To move a portlet, click on the desired portlet in the template, then click the 
Up or Down buttons.

When you have finished arranging your portlets in the template, click OK.

d. You can also edit a portlet’s default settings from the Portal Page Defaults 
section. Select the desired portlet in the Portlets window, then click the “Edit” 
button to launch a Portlet Defaults editor. For a detailed description of each 
default setting, see “Editing a Portlet” on page 13-20.
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8. Click Save to save your changes. These changes will be available to the visitor or 
for modification via the WebLogic Portal Administration Tools once you have 
synchronized your changes to the appropriate server. See “Synchronizing 
Application Data” in the Deployment Guide for more information.

Editing a Portal

1. In the E-Business Control Center Explorer window, click the Presentation tab, then 
the Portal icon.

A list of existing portals will appear.

2. Click on the portal you wish to edit.

The Portal Editor will display the information for that portlet.

3. You may edit any of the fields in Portal Editor. For more information about portal 
attributes that can be modified in the editor, see the previous section of this topic.

4. Click Save to save your changes. These changes will be available to the visitor or 
for modification via the WebLogic Portal Administration Tools once you have 
synchronized your changes to the appropriate server. See “Synchronizing 
Application Data” in the Deployment Guide for more information.

Deleting a Portal

1. In the E-Business Control Center Explorer window, click the Presentation tab, then 
the Portal icon.

A list of existing portals appears.

2. Click on the portal you wish to delete and click the Delete button. 

The portal is removed from the explorer window.

3. When you synchronize to the server, the portal will be deleted from the server. 
See “Synchronizing Application Data” in the Deployment Guide for more 
information.
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Portlets

Portlets reside within a portal application and can be anything from a robust Web 
application (such as e-mail) to a simple data view (for example, a link to a weather 
page). You can define portlets and add them to a portal at any time during or after the 
portal development process. 

When you create a new portlet definition, you associate metadata for elements such as 
title bars, headers, helpfiles, and Webflow mechanisms. This section covers the 
following information:

n Defining a New Portlet

n Editing a Portlet

n Deleting a Portlet

Defining a New Portlet

Use the following procedure to create a new portlet definition.

1. In the E-Business Control Center toolbar, select File → New → Presentation → 
Portlet.

The Portlet Editor appears (Figure 13-10).
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Figure 13-10   Portlet Editor

2. In the Portlet Editor, provide the following information:

a. Description (optional): Provide a description for the portlet you are creating.

b. Content URL: Provide a URL for the main body of content that will appear in 
the portlet.

Note: The URLs should be the file system directory path to the JSPs that are 
located on the WebLogic Portal server. When you synchronize this data, 
the appropriate JSP is inserted as an include to the portlet. The location 
of these directories are determined by your organization.

c. Header URL/Alternate Header URL (optional): Provide a URL for the JSP that 
will serve as an include for the portlet header; You can also provide an 
alternative header in the event that the primary header is missing or corrupt at 
runtime.

d. Footer URL/Alternate Footer URL (optional): Provide a URL for the footer. If 
desired, provide an alternate footer.

e. Titlebar URL: Provide a URL for the titlebar.
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f. Banner URL (optional): Provide a URL for a banner, if you wish one to appear 
in your portlet.

g. Icon URL (optional): Provide a path to an icon that will represent the portlet.

h. Portlet Webflow (optional): Select a defined Webflow if your portlet requires 
Webflow functionality. Although portlets do not require a Webflow association, 
it is highly recommended. For more information, see “Customizing Portals and 
Portlets.”

i. Editable checkbox/Edit URL (optional): If your portlet enables editing by 
visitors, check the Editable box and provide the URL for the JSP page they will 
use to personalize the portlet.

j. Helpable checkbox/Help URL (optional): If the portlet is accompanied by 
Online Help, check the box and provide a path to the Help files.

k. Login Required (optional): Check this box if the visitor must login with a 
password to access the portlet.

l. Maximize URL (optional): If the portlet is maximizable, provide the URL for 
the maximized JSP page.

3. Determine the portlet defaults. Default selections determine how the portlet will 
appear in a browser if it has not been configured using the WebLogic Portal 
Administration Tools. 

a. Mandatory: Mandates that the visitor will always see this portlet; That is, they 
cannot delete it from their personalized portal. 

b. Floatable: If this box is checked, the portlet will appear in a popup window.

c. Minimizable: Allows the visitor to minimize the portlet. If this box is not 
checked, the portlet cannot be minimized within the portal.

Note: Portlet defaults can be set differently via the portal editor and override the 
original defaults for that instance of the portlet. For more information, see 
“Setting Portal Defaults” on page 13-13.

4. Click Save to save your changes. These changes will be available to the visitor or 
for modification via the WebLogic Portal Administration Tools once you have 
synchronized your changes to the appropriate server. See “Synchronizing 
Application Data” in the Deployment Guide for more information.
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Editing a Portlet

To edit a portlet:

1. In the E-Business Control Center Explorer window, click the Presentation tab, then 
click the Portlet icon.

A list of existing portlets appears in the E-Business Control Center Explorer 
window.

2. Click the portlet you wish to edit.

The Portlet Editor displays the information for that portlet.

3. You may edit any of the fields in the Portlet Editor.

4. Click Save to save your changes. These changes will be available for use by the 
WebLogic Portal Administration Tools when you have synchronized your 
changes to the appropriate server. See “Synchronizing Application Data” in the 
Deployment Guide for more information.

Deleting a Portlet

1. In the E-Business Control Center Explorer window, click the Presentation tab, then 
click the Portlet icon.

A list of existing portlets appears.

2. Select the portlet you wish to delete and click the Delete button.

The portal is removed from the Explorer window.

3. When you synchronize to the server, the deletion will be updated in the server. 
See “Synchronizing Application Data” in the Deployment Guide for more 
information.

Entitlement Segments

The E-Business Control Center Portal Tools allow you to create multiple entitlement 
segment definitions with multiple conditions and values. You use the E-Business 
Control Center to create entitlement segment definitions. These segments are 
associated with pages and portals in the WebLogic Portal Administration Tools.



Using the E-Business Control Center

Guide to Using the BEA E-Business Control Center 13-21

Accessing the Entitlement Segment Definition Tool

In the main toolbar, select File → New → Presentation → Entitlement Segment.

The Entitlement Editor appears (Figure 13-11). Defining entitlement rules involves 
setting up conditions and queries. See “Building Conditions and Queries in the BEA 
E-Business Control Center” in the Guide to Using the E-Business Control Center.

Figure 13-11   Entitlement Editor
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in Explorer window
Campaigns 10-32

view, in Explorer window
Discounts 7-37

visitor characteristics
as conditions 2-3
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W
webflow extensions, customizing 1-17
weight, ad 9-16
window

Ad Search 10-8
Campaign Editor

Campaign Duration and End 
Criteria pane 10-23

General Campaign Information 
pane 10-3

opening 10-2
Scenarios pane 10-4

Campaign Search 10-28
expanded 10-29

Connection Details 1-22
Connection Settings 1-22
Connection Setup 1-20
Customer Segment Editor 4-7
Discount Editor 7-22

Discount Terms pane 7-24
General pane 7-23
Start/Stop pane 7-34

End Criteria Detail 10-24
Explorer

Discounts view 7-37
New Ad Action 10-6
New Discount Action 10-20
New E-mail Action 10-16
Placement Options 10-15
Properties and Property Values 2-7
Scenario Properties 10-4
Select Customer Segments 2-6
Select Discount 10-21
Select E-mail Content 10-18
Select Events 2-11
Select Placeholders 10-9
Select Product Categories 2-14
Select Product Items 2-14
Specify Discount Value 7-26, 7-30, 7-33
Specify Order Discount Target 7-34

Specify Target Items 7-27, 7-31
Specify Trigger Items 7-24, 7-25
Specify Trigger Sets 7-28, 7-29
Specify Trigger Subtotal 7-32
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